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Section 5 – Configurator

Following hardware installation, all connections to the Jupiter system including those for control, video, audio, data, and tally
must be identified and described in a “Configuration Set” consisting of a collection of user–defined tables. The configuration
editor (“Configurator”), a new version of the editing program used to create and edit these tables, is designed to eliminate
manual entry of repetitive information and operate in a familiar, “Windows–like” environment. Editing features include
search, error detection and on–screen help, column/row copy/paste, and column/row auto–fill with incremental numbers.

Note: For a comparison of the Configurator and the previous configuration editor, see Field Engineering Bulletin
04-047604-107.

Installation of the Configurator is described in the Field Engineering Bulletin provided with the software.

Quick Start tip: If your Jupiter equipment was purchased from Thomson as a “turnkey”
system, you may wish to refer to the Jupiter Getting Started Guide, part no. 04–045707–003.
This booklet provides an abbreviated version of the information in this section.

Starting the Configurator 

Caution: You must be logged in as the administrator (or have administrator privileges) in order to load Jupiter
software, launch Jupiter applications, and configure the system. This same login must be used for all tasks per-
formed on the Jupiter file server, including uninstalling software.

1. Start Windows.

2. Go to “Start > Programs > Jupiter Network Suite.”

3. Use the JNS Console to start the Jupiter Network Suite (JNS) tool “Configuration Editor” (as described in Section 4).

4. The “File > Open” command is used to select an existing configuration set (or “File > New” used to create a new set);
the full path and name of the set will appear in the window’s title bar. Thereafter when Configurator is started the last
used set will be opened automatically.

Quick Start tip: If you are an experienced Jupiter user, and wish to check the routing switcher
as quickly as possible, see Using the Numeric Set on page 5–11.
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5. To access Jupiter tables, use the “Jupiter” pull–down menu. For example, if you select the Network Description table
the display will be similar to the following (Figure 5–1).

Figure 5–1.

Jupiter Configurator menu
with Network Description
table open.

If a password entry menu appears, it means that a Jupiter password (other than the factory default of “999999”) has been
set. Enter the authorized password and click on “OK.”

The password system is discussed in detail starting on page 5–17.

6. The configuration set should now be edited as appropriate and made active (downloaded) as described beginning on
page 5–8. The pages immediately following provide general information about the Configurator.

Closing the Configurator

To close (quit) the Configurator, select “File > Exit” or click on the Close Box (X) in the upper right–hand corner of the win-
dow.

Other than for convenience, there is no need to leave the Configurator loaded after compiling. However, the JNS application
should be left running and the download connection to the controller board§ should be left in place, in case the a controller
board requests a fresh download of data from the file server.

§ In this manual, “controller board” refers to a VM/SI 3000 Control Processor, CM 4000 Control Module, or similar device.
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Configurator Editing Guidelines

AUTOMATIC TABLE ENTRY

This function is designed to expedite the data entry process and eliminate errors due to differences in spelling and entry of
inappropriate data.

In cases where a controller board or device must be entered on more than one table, Configurator will automatically copy (or
offer as a selectable item) the data entered on the “initial entry” table to all “secondary” tables (including Saturn tables). Enter-
ing information in the same order as the tables appear in the pull–down menu will therefore eliminate most repeat entries. For
example, when a VM 3000 is entered on the Network Description table, the name will be added automatically to the Serial
Protocol table.

Note 1: You cannot enter data on secondary tables first. For example, you must enter a new VM on the Network
Description table. Again, data should be entered in the same order as the tables appear in the pull–down menu.

When certain items are deleted, the editor will automatically delete, when appropriate, the corresponding entries on other
tables. For example, when the name of an input is deleted from the Switcher Input table, the input will be deleted automatically
from the other corresponding tables. The same is true for an output deleted from the Switcher Output table. For instance, if the
VTR12 row on the Switcher Input table is deleted, the corresponding row on the CP Input Set table, i.e., the row defining the
category/number keys and mnemonic, will be deleted as well.

ENTRY/EDIT WITHIN A JUPITER TABLE

� Use the mouse, cursor keys, or TAB to move to the desired field. To accept the change and advance to the next
field, press TAB.

� When a field requires a selection to be made from a fixed list, clicking anywhere in the field will cause a drop–
down arrow to appear. Click on the arrow to show the available choices (or press ALT+DOWN). Click on the
desired choice. (You can also enter the first letter in the list item name; enter the letter again to move to the next
item that starts with that letter, then press RETURN.)

Note 2: In some cases you will need to press “Apply” to update the selections in a drop down list.

� To advance to the next row, press ENTER.

Note 3: New entries should be made at the bottom of tables whenever possible to avoid disrupting system
operation. If entries are made to the middle of tables you must be prepared to clear battery–protected memory
(Pmem) in the VM 3000 and re–establish switcher status and machine links. Clearing Pmem is described in
Appendix B.

� Press “Apply” to save the changes in memory (they are not saved to disk until you select File > Save). If you
attempt to edit another table before Applying your changes, a pop up message will appear asking you to confirm
or abandon the changes before editing a new table. After Applying all changes, the set can be Saved using the
“File > Save” command. The message “Exporting...” will appear.

� In some cases spaces are not allowed. If so the editor will not allow them to be entered.
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When creating a name for a Jupiter set, table, control panel, or other device, it’s a good practice to use letters
and numbers only. If you want to use punctuation or special characters, check the list on page 5–7 before
creating a name.

� To jump to the bottom of a table, press CTRL+DOWN; to jump to the top, press CTRL+UP.

� To scroll to the bottom of a long table, press and hold PAGE DOWN. You can also “drag” the scroll box, or
click and hold on the scroll arrows.

� To copy rows and add them to the bottom of the table, drag–select the row number boxes of the source rows (the
rows selected must form a single rectangle). Use “Edit” and “Copy.” Go to the bottom of the page. Press the
INSERT key. Then use “Edit” and “Paste.”

� To copy rows and insert them in the middle of a table, see “Reordering” below.

� You can exit without writing even after changes have been Applied and the table closed by selecting “File >
Exit.” and answering “No” to the “Save?” question.

� Error detection and explanation – fields that contain insufficient or inappropriate information are marked in
red. Moving the cursor over the field will cause a Help window to appear.

� Auto Complete – the editor will suggest the remaining letters of a word that has been used before. To accept the
auto completed entry, press TAB; otherwise, continue typing the new entry.

REORDERING JUPITER TABLES

Important: It is possible to reorder Jupiter tables, but this can be very disruptive if not done carefully. The order
of entries in certain tables is significant because row numbers are used as cross–references to other tables. If data
is moved from one row to another, these relationships may be broken and system operation will be unpredictable.
When adding new items to tables, add them at the end if possible. If you wish to reorder table data then you must
be prepared to clear battery–protected memory (Pmem) in the VM/SI controller and re–establish switcher status
and machine links. Clearing Pmem is described in Appendix B.

� To insert a new row in the middle of the table, click on the row number box above the row where the new row is
to appear. Notice that row selection is a toggle function. Then go to the “Edit” pull–down menu and select “In-
sert Row.” (Or, just press the INSERT key.)

� To delete an entire row, click on the row number box and use “Edit” and “Delete.” (Or press ALT+DEL.)

� To re–order a table manually, drag–select the row number boxes of the source rows (the rows selected must
form a single rectangle). Make a note of how many rows you have selected. Use “Edit” and “Cut.” Select the
row number box above where you want to paste. Make room for  the source block by pressing the INSERT key
once for each source row. Then use “Edit” and “Paste.”

� To copy rows from one Jupiter table to another, drag–select the row number boxes of the source rows (the rows
selected must form a single rectangle). Make a note of how many rows you have selected. Use “Edit” and
“Copy.” Go to the destination table. Select the row number box above where you want to paste. Press the IN-
SERT key once for each row to be pasted. Then use “Edit” and “Paste.” (If you use this procedure without in-
serting blank rows, the existing rows will be overwritten.)
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FIND / FILL / INCREMENT

“Edit > Find” – searches for a text string in all open tables.

“Edit > Fill”  –  this is a copy/paste function for use with tables containing repetitive material. Select the row or column with the
desired text and then “Edit > Fill Right” or “Edit > Fill Down” to paste the information.

“Edit > Increment” function – similar to “Edit > Fill” except that incrementing numbers are automatically created in columns
to the right or rows below as desired. For example, on the Switcher Input table you could enter “IN 1” in the top left field, then
select the desired fields (the whole column in this example) and “Edit > Increment Down.” This will fill the rest of the column
with “IN 2,” “IN 3,” etc. to the bottom of the table. It is also possible to mix categories (prefixes) within a column and still
automate the process. For example, “VTR 1” could be entered in the top left field, the following 10 rows selected and “Edit >
Increment Down” applied; this would produce 10 rows labelled VTR 1 through “VTR 10.” “CAM 1” could then be entered in
the Name field on row 11, additional rows selected, “Edit > Increment Down” applied, etc.

COPYING AND PASTING A BLOCK

Before changing an existing Jupiter table, be sure to read “Important” on page 5–4.

� To copy a block, drag–select the block of the source fields (the fields selected must form a single rectangle).
Use “Edit” and “Copy.” See Figure 5–2.

       Figure 5–2.

Input Set — KXYZ–INP

Category Entry Mnemonic Logical

CAM 1 C1 CAM11

2 CAM 2 C2 CAM2

3 CAM 3 C3 CAM3

Input

Next, select the top left field of the destination area. In this case, the paste will overwrite the existing text.

Figure 5–3.

Input Set — KXYZ–INP

Category Entry Mnemonic Logical

CAM 1 C1 CAM11

2 CAM 2 C2 CAM2

3 CAM 3 C3 CAM3

Input

Then use “Edit” and “Paste.” the result is shown in Figure 5–4.

        Figure 5–4.

Input Set — KXYZ–INP

Category Entry Mnemonic Logical

CAM 1 CAM11

2 CAM 2 CAM2

3 CAM 3 CAM3

CAM1

CAM2

CAM3

Input
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Keyboard Shortcuts

To select an entire column, click the name of the column. Click anywhere outside the column to un–select.

To select an entire row, click the number of the row. Click anywhere outside the row to un–select.

COPY AND PASTE ROWS BETWEEN THE WINDOWS CLIPBOARD AND JUPITER

Before copying from a Windows program to Jupiter, be sure to read “Important” on page 5–4.

You can use Cut, Copy, and Paste to exchange information between Jupiter and other Windows programs such as Microsoft
Word and Microsoft Excel. For example, suppose you want to create a Jupiter CP Input Set using Microsoft Word or another
Windows text editor. The document might look like this:

VTR � 1 � VT01 � VT01�
VTR � 2 � VT02 � VT02�
VTR � 3 � VT03 � VT03�
VTR � 4 � VT04 � VT04�
VTR � 5 � VT05 � VT05�
VTR � 6 � VT06 � VT06�
VTR � 7 � VT07 � VT07�
VTR � 8 � VT08 � VT08�
VTR � 9 � VT09 � VT09� Figure 5–5. Text as entered using word processor.

The text must be “tab–delimited” (as indicated by the arrows). Spaces must not be used between columns. In the case of a
Microsoft Excel or other Windows spreadsheet document, each field would be entered in a separate cell.

You can drag–select this text, make a note of how many rows you have selected, and use “Edit” and “Copy” in the Word win-
dow. Then select the Jupiter CP Input Set window and select the row number box above where you want to paste. If you want
to insert new rows, press the INSERT key once for each row to be pasted. Then use “Edit” and “Paste.” The result is shown
in Figure 5–6.

Figure 5–6. Resulting Jupiter table.

4

Input Set — KXYZ–INP

Category Entry Mnemonic Logical

5

6

VTR 4 VT04 VT04

VTR 1 VT01 VT011

2

VTR 5 VT05 VT05

VTR 6 VT06 VT06

VTR 2 VT02 VT02

VTR 7 VT07 VT07

VTR 8 VT08 VT08

VTR 9 VT09 VT09

7

8

9

3 VTR 3 VT03 VT03

Input

The same technique can be used to copy from Jupiter and paste into another Windows program.
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Jupiter Naming Rules

When creating a name for a Jupiter set, table, control panel, or other device, the following rules should be observed:

� Eight character maximum.

� The following characters are OK:

Letters A through Z

Numbers 0 through 9

Underscore _
Number sign #
Hyphen –
Caret ^
Dollar sign $
Exclamation point !
Percent sign %
Ampersand &
Braces { }
At sign @
Single quote mark ‘
Apostrophe ’
Right parenthesis  )

� Do not use:

Space
Comma ,
Colon :
Semicolon ;
Forward or  back slash / \
Asterisk *
Period .
Left parenthesis (
Plus +
Equal =
Less or Greater than < >
Brackets [ ]
Question mark ?
Double quotes ”
Vertical bar (pipe) |

� Do not create a filename that is identical to another file (or subdirectory) in the same directory.
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Configuration Set Management

The top of the Configurator menu (page 5–9) shows the name of the selected set. This is the system configuration directory
that is currently selected for editing. 

After a set is edited, it should be saved and then compiled. If compiling is successful, the set name will appear on the Jupiter
Network Suite Control Center “Application” menu; the set can then be selected for downloading, during which a copy is
sent to the system hardware. Another copy always remains in the server, ready for automatic, on–demand download to the
hardware.

The Jupiter can have any number of configuration sets, each of which contains the file and subset types shown on page 5–12.
(The files in quotation marks are example names.)

Any one of the configuration sets can be selected for use by the system. This allows the entire system to be reconfigured from
the file server with only a brief interruption to normal operations.

Modifying and Downloading a System Configuration Set

Quick Start tip: Program the system in small steps and compile often!

As described earlier, a compiled and/or active configuration set cannot be edited directly. And, since creating a new configura-
tion set from scratch is a very time–consuming process, you will probably want to make changes by making a copy of the
uncompiled (source) version of the set, editing it, and then switching the new set on–line. While any number of file manage-
ment schemes can be used to accomplish this, the following procedure is suggested:

� Make a copy of the most recent, known–good source set. Name the copy “CONFIG01.”

� Edit “CONFIG01.” Save the set.

� Compile and Download “CONFIG01.”

� When the next change is needed, select and copy source set CONFIG01. Name the copy “CONFIG02.”

� Edit “CONFIG02.” Save. Compile and download.

� Repeat above steps as needed.

� Eventually you will want to start deleting the older sets.

By numbering the sets, there will never be any doubt about which is the latest version. Also, it will be easy to return to “known
good” sets. This suggestion is detailed in the steps below.
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Source
set

selected
for editing

Compiled set(s)

Source sets

“Activate”
(Download)

VM/SI 3000
Compile

Select for
editing

Save

Network Description

1

Board Name

ES1

VM1

VM1

Type

A

VM

VM

Address

0080CE010000

0080CE010100

0080CE010101

2

3

Copy of
Active Set

Select and
process

Open Configuration Set

NUM–64
NUMERIC
NUM–LE
VGA–DEMO

Configuration sets

CONFIG01

c:\JUPITER\Config

OK Cancel

NUM–128

CONFIG02

Figure 5–7. Configuration set editing and downloading.

Redundant
Address
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COPYING A CONFIGURATION SET FOR EDITING

Make a copy of the latest known–good set as follows:

1. On the “File” portion of the Jupiter Configuration menu (page 5–2), click on “Open.” This will bring up a menu similar
to that shown in Figure 5–8.

This menu will list all existing system configuration sets.

The NUMERIC sets are factory–supplied sets provided for quick start and diagnostic purposes. For more information,
see page 5–11. The list may also contain a test set used at the factory.

Open Configuration Set

NUM–64
NUMERIC
NUM–LE
VGA–DEMO

Configuration sets

CONFIG01

OK Cancel

NUM–128

Figure 5–8.  Select Edit Set menu.

C:\PROGRA~1\Thomson\J

2. Click on the desired set name and “OK.” Wait for the set to load. Close the loading progress window.

3. Select “File > Save As.”

4. Enter a new name for the set (up to eight characters).

When creating a name for a Jupiter set, table, control panel, or other device, it’s a good practice to use letters and numbers
only. If you want to use punctuation or special characters, check the list on page 5–7 before creating a name.

In keeping with the suggestion described earlier, you may wish to name the copy “CONFIG01.”

5. Click on the “OK” button. When the copy is finished, the copy will be the active set.
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MAKING THE DESIRED MODIFICATIONS TO THE SET

Editing procedures for specific modifications are described later in this manual, starting with the Network Description table
on page 5–22. From the Network Description table, you should move on to the Serial Protocol table, then the Switcher De-
scription table, and so on through the remaining Jupiter tables. See page 5–12.

Note: As previously explained, you cannot enter data on “secondary” tables first. For example, you must enter a
new VM on the Network Description table. In general, data should be entered in the same order as the tables ap-
pear in the pull–down menu. For more information, see “Automatic Table Entry” on page 5–3.

Not all tables will apply to every system. For example, some are for machine control, others are for backward compatibility
with Thomson Party Line equipment, etc. Please refer to the description of each table for more information.

If a Thomson Broadcast Automation system is connected to the Jupiter system, special procedures apply to the compile/
download process. See Appendix R, “Changing Jupiter configuration sets with Thomson Automation ES–LAN (QNX ver-
sion) present.”

USING THE “NUMERIC” SETS FOR QUICK SWITCHER CHECKOUT

The factory–supplied numeric configuration sets can be used to set up and operate the routing switcher in the
minimum possible time. The “NUMERIC” set provides for a switcher with up to 256 inputs, 256 outputs, and
four levels; the “NUM–64” set provides for 64 inputs and outputs; and the “NUM–128” set provides for 128
inputs/outputs.

The numeric sets are complete and ready to download, except for entry of at least one VM 3000 Control Chassis
address, entry of the actual switcher Physical Levels and Driver types, and one switcher control panel address.

Use the “File > Open” menu to select one of the Numeric sets and make a copy (as described on page 5–10.)

Select “Jupiter > Network Description” table and change the VM 3000 and SI 3000 addresses to match those
in your system (see page 5–22). The actual switcher Physical Levels and Driver types are entered on the
Switcher Description table (page 5–31). The control panel address must be entered on the MPK Devices De-
scription table (page 5–108).

The set can then be compiled and activated as described on page 5–13.

Inputs and outputs are selected numerically, using the TEST key on a CP 3000 control panel to enter a leading
zero for selections zero through 99. The VTR key is used to enter a “1,” and so on. For complete CP 3000 operat-
ing instructions, see page 6–7.

Quick Start Tip
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Password Table

c:\Program Files\Thomson\JUPITER\Config

Additional
configuration
sets

Configuration set
“CONFIG01”

——Network Description
——Serial  Protocol

——Switcher Description
——Switcher Input
——Switcher Output

——CP Level Sets
——“KXYZ–LEV”
——

——CP Input Sets
——“KXYZ–INP”
——

——CP Output Sets
——“KXYZ–OUT”
——“MC–OUT”
——“SHOP”
——“DELAY–OUT”
——etc.

——CP Override Sets
——“KXYZ–OVE”
——

——CP Sequence Sets
——“KXYZ–SEQ”

——CP Category Sets

——MPK Devices

——Machines
——Protocol Dependent
——Machine Control
——Delegation Groups

——TCS–1 Device Codes
——Party Line Description
——Party Line Input
——Party Line Output
——Party Line Levels

——Status Display Header
——VGA Status Display

——Tally Relay
——Tally Dependency

——Sequential Path Finding
——Non Seq Path Finding

——Exclusion
——Y Line

Configuration set
“CONFIG02”

——Network Description
——Serial  Protocol

——Switcher Description
——Switcher Input
——Switcher Output

——CP Level Sets
——“KXYZ–LEV”
——

——CP Input Sets
——“KXYZ–INP”
——

——CP Output Sets
——“KXYZ–OUT”
——“MC–OUT”
——“SHOP”
——“DELAY–OUT”
——etc.

——CP Override Sets
——“KXYZ–OVE”
——

——CP Sequence Sets
——“KXYZ–SEQ”

——CP Category Sets

——MPK Devices

——Machines
——Protocol Dependent
——Machine Control
——Delegation Groups

——TCS–1 Device Codes
——Party Line Description
——Party Line Input
——Party Line Output
——Party Line Levels

——Status Display Header
——VGA Status Display

——Tally Relay
——Tally Dependency

——Sequential Path Finding
——Non Seq Path Finding

——Exclusion
——Y Line

Figure 5–9.
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VALIDATING, COMPILING, AND ACTIVATING (DOWNLOADING) A CONFIGURATION SET

1. After you have finished editing, select the “Tools > Validate All Tables” pull–down menu on the main menu menu (page
5–2).

If a validation error is reported, move the cursor to the red–colored area of the table to view the reason for the error.
Correct the error and run the validator again.

2. Select the “Tools > Compile” pull–down menu on the main menu menu (page 5–2). When the compiler is finished,
the number of compiler errors (if any) will be reported.

If a compiler error is reported, the error must be corrected and the set re–compiled. To print the error messages, click
on the “Print” command box.

Don’t worry about an error corrupting the active set—even if the active set has the same name as the one you’re working
on. A new set must compile without errors and be explicitly selected for downloading by the Control Center software
before it can go online.

3. Click on “Close.”

4. Use the JNS Console to start the Jupiter Network Suite (JNS) application “Control Center” (as described in Section 4.)
This will open a window similar to that shown in Figure 5–10.

A background program called “Bootp Server” will also be started automatically.

5. Click on the new set for the Active set. Check that the “Select and Reboot” radio button is selected.

Figure 5–10.

6. To initiate the download, click on “Activate.”
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Caution: Once the activate/reboot command has been issued, do not interrupt the process until the reboot is
complete. Interruptions such as sending a new command, turning off power, or disconnecting cables will
have unpredictable consequences. With a CM 4000, such consequences can include corruption of data stored
in flash memory and on the CM hard drive.

After a few seconds, the LEDs on the controller boards will turn red momentarily and the message “Device not con-
nected” or “Startup” will appear on the system control panels. When the download is complete, the LEDs should be
green and the panels returned to their previous status display. Depending on several factors such as the number of boards,
configuration size, need to update the *.sys file, LAN transmission rate, LAN traffic, etc., a complete set change can
take several seconds or multiple minutes.

Download status can also be determined using the Control Center “Board Status” tab.

For more information about Control Center functions, including the “Reboot” and “Restore Backup” buttons, see page
9–1.

7. All control panels should now be operational. For operating instructions, see Section 6. (For Software Control Panel
operation, see Section 7.)
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Troubleshooting

ERROR CONDITIONS

— Red Alarm light on controller board remains On. The meaning of the various possible LED on/off combina-
tions is shown in Appendix S.

— The “Device not connected” message fails to appear or clear. There may be a download fault in the VM/SI
3000 serial control section. It may be possible to correct this by resetting the board manually. See Appendix B.

— A switcher control panel fails to indicate switcher status. There may be a download fault in the controller
board. It may be possible to correct this by resetting the board manually. See Appendix B.

— Party Line control panels (including the MCS 2000) display the message “No party line.” There may be a
download fault in the VM 3000 party line interface section. It may be possible to correct this by resetting the
board manually. See Appendix B.

— Other errors/conditions. The “TFTP Status” and “Board Info/Control” tabs in the Control Center window can
be used to check the system. For more information, see page 9–1.

— A Log Viewer is also available as a diagnostic tool. For more information, see Section 12.

PROGRAM CRASH RECOVERY

If a control panel locks up, normal operation can usually be restored by cycling the power to the panel or to the controller
board. For additional information concerning hardware reset, please refer to Appendix B.

DELETING JUPITER SOFTWARE

To uninstall the Jupiter software, follow the procedure given in the Field Engineering Bulletin supplied with the software.

Caution: The same login must be used for all tasks performed on the Jupiter file server, including uninstalling soft-
ware.

RE–INSTALLING JUPITER SOFTWARE

Refer to the Field Engineering Bulletin supplied with the software.

ZIPPING A CONFIGURATION SET

As part of a troubleshooting procedure, you may want to send a particular configuration set to Thomson Technical Support
for analysis. The Zip tool can be used to assemble all directories and files within a set so that it can be sent as a single com-
pressed file.

To zip a set, click on the “Tools > Zip Configuration Edit Set” menu selection. You will be asked to select a configuration
set, then you will be asked for the location to store the file. The default location is “C:\Jupiter\Logdata\”. You may wish to
change this location (i.e., to a floppy). Once you select OK, the selected set will be zipped up.
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To unzip a set, click on “Tools > Unzip Configuration Edit Set”. You will be asked which file to unzip. Make sure that the
selected file is a valid zip file that was created by the method outlined above. Once you select a zip file and click OK, the set
will be unzipped. If the set already exists, you will be asked if you want to overwrite the set. If you select OK, the set will
be overwritten.

ZIPPING A CONFIGURATION SET WITH DIAGNOSTIC INFORMATION (“SUPPORT PACKAGE”)

To combine the active configuration set with the editor’s diagnostic information in a single zip file, go to “Tools > Create
Support Package.” This file can then be sent to the Technical Services department to help them troubleshoot any difficulties
you are having. The support package will include the version of the configuration set that is currently stored on your hard
disk (i.e., unsaved changes will not be included). If your configuration set is new and has never been saved, it cannot be in-
cluded.

Printing

Printer installation was discussed on page 2–39. If you want to print a single table, bring the table’s window to the top of the
desktop. Then select the “Print” command button on the bottom of the window.

Note: Printing of an entire set is not supported.

On–line Help

Two levels of Help are available for the Configurator: “What’s This” Help, whereby the name of a tool will appear when the
cursor remains stationary over the icon for that tool, and “Implicit” Help, where a brief explanation of a field’s purpose or
requirements will appear along the bottom of the window when the field is selected.

In addition, an Adobe Acrobat version of the manual you are now reading can be accessed by selecting the “Help” pull–down
menu. The Acrobat Reader must be installed to view the manual on–line.

Inadvertent Loss of Power

Following a power interruption, the Jupiter controller board(s) will reset itself and should be back in operation in a few sec-
onds. The controller board uses a combination of flash ROM and battery–protected RAM to maintain programs and user ta-
bles indefinitely.

Disconnecting File Server from LAN

The file server can be disconnected from the LAN without affecting control panel operation. However, if for some reason
a controller board requires re–downloading, it will be unable to complete this operation until the LAN is reconnected and the
JNS program is running properly.

Important:  If for test purposes you wish to disconnect the LAN and reset a controller board, you must wait  60
seconds before pressing the reset switch. If you press reset before 60 seconds, the controller board will hang and
require re–downloading from the server.
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Passwords

Quick Start tip: You may wish to skip the Password table when you first configure the
system. If password levels are needed they can be added later.

The Jupiter passwords are arranged in a hierarchy, with the “99” level password being the equivalent of a supervisor password.
Entry of a 99–level password on the main menu (page 5–2) will allow any system operation, including starting the Jupiter
software and creating or changing passwords. There must be at least one 99–level password in the system at all times. In Figure
5–11, Boss Bill might have a password  of “007007”  with a level of “99.”

In addition, a password level can be established for each control panel and each switcher output. Bill’s control panel has an
inherent  password level of 80 and the switcher output leading to VTR1 has a level of 60. This means that anyone using Bill’s
control panel would be able to select a source for VTR1. Notice that the panel could also be used to select a source for QC
but not for the Lobby monitor.

Figure 5–11. Jupiter password system.

Boss Bill

99

Bill’s control
panel

80

Operator
Dave

70

Dave’s control
panel

50

10

60

90

QC VTR1 LOBBY

—— D E S T I N A T I O N S ——

Password
Levels
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However, Bill can enter his own personal password into his panel (or anyone else’s) and temporarily raise the panel’s level
to “99.” A new source could then be switched to the Lobby:

99

80

90

LOBBY

ÇÇ
ÇÇ
ÇÇ

50

ÇÇÇ
ÇÇÇ
ÇÇÇ
ÇÇÇ
ÇÇÇ
ÇÇÇ

Boss Bill Bill’s control
panel

Dave’s control
panel

Figure 5–12. Raising the level of a panel.

Furthermore, the level of a panel can be raised just long enough to make one switch (or until someone logs out of the panel).
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When the level of a panel is raised only temporarily, then re–entry of a password will be required for special commands such
as  protect* and lock,* and for front–panel definition of overrides.* It may also be required for executing an Input Sequence.*

For example, Operator Dave can protect the feed to VTR1 (Figure 5–13). No other panel, regardless of password level, could
then be used to change the source: †

Figure 5–13. Protecting an output.

ÇÇ
ÇÇ
ÇÇ

99

80

70

60

VTR1

50

PROTECT

Boss Bill Bill’s control
panel

Operator
Dave

Dave’s control
panel

A more rigorous form of protection is lock, where the output must be deliberately unlocked before changing the source for
a particular destination (Figure 5–14). Only the panel used to lock the output could unlock the output.†

Figure 5–14. Locking an output.

ÇÇ
ÇÇ
ÇÇ

99

80

70

60

VTR1

50

LOCK
Boss Bill Bill’s control

panel
Operator

Dave
Dave’s control

panel

* Terms marked with an asterisk are found in the Glossary.
† Except by using supervisory “force unprotect/unlock.” See page 5–21.
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Systems are shipped with a password level of 00 for all panels and outputs; therefore any password can initially be used to
access all control panel functions.

As shown in Figure 5–9, there is only one table of passwords, and this table is used no matter what configuration set is active
or selected for editing. However, the password levels for individual control panels and outputs are stored with individual con-
figuration sets.

CHANGING PASSWORDS

1. On the main menu (page 5–2), select “Jupiter” (or ALT+j) to bring up the configuration set table list (Figure 5–15).

As explained above, it doesn’t matter which configuration set is selected for editing, since the password table applies
to all sets.

Password

Network Description
Serial Protocol

Switcher Description
Switcher Input
Switcher Output

Control Panel Sets F8
MPK Devices

Machines
Protocol Dependent
Machine Control
Delegation Groups

TCS–1 Device Codes
Party Line Description
Party Line Input
Party Line Output
Party Line Levels

Status Display Header

VGA Status Display

Tally Relay
Tally Dependency

Sequential Path Finding
Non–Sequential Path Finding

Exclusion
Y Line

CP Level Set
CP Input Set
CP Output Set
CP Override Set
CP Sequence Set
CP Category Set

Figure 5–15. Configuration set table list.

2. Select “Password” (or press “p”). This will display the password table:

1

Password Table

Password

999999

Level

99 Figure 5–16.
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3. Select the password you want to change.

Guidelines for using the editor are found on page 5–3.

4. Type in the revised password. The password must consist of six numbers.

5. Use TAB (or click) to select the Level field. Type in the revised password level (if any). This must be a number from
00 to 99.

In this example, pressing Enter at this point will create a row for another password. (If left blank, the new row will be
deleted automatically when the table is saved.)

6. When editing is complete, select “OK.” To save the changes, select “File > Save.”

SETTING PASSWORD LEVELS FOR CONTROL PANELS

Please see page 5–114.

SETTING PASSWORD LEVELS FOR SWITCHER OUTPUTS

Please see page 5–53.

FORCE UNPROTECT/UNLOCK

Force unprotect/unlock is available as a file server utility (page 11–1) and with the VGA Status Display (page 6–143).

Force unprotect/unlock is not available from party line–type control panels.
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Network Description

This table must be used when any of the following are first installed on the LAN:

� VM/SI 3000 System Controllers

� Saturn Master Control Switcher†

� Thomson Broadcast Automation system

� Software Control Panel Suite‡

� CM 4000 System Controllers§

0080CE010100

Redundant

2

Network Description

Board Name

VM1 0080CE010101VM

Address

3

SI1 SI 0080CE010102

1

Type Address

Figure 5–17. Network description (example).

Password 5–17

Network Description
Serial Protocol 5–25

Switcher Description 5–31
Switcher Input 5–44
Switcher Output 5–51

Control Panel Sets
Level set 5–55
Input set 5–58
Output set 5–76
Override set 5–98
Sequence set 5–101
Category set 5–103

MPK Devices 5–108

Machines 5–141
Protocol Dependent 5–144
Machine Control 5–148
Delegation Groups 5–161

TCS–1 Device Codes 5–168
Party Line 5–169

Status Display Header 5–172
VGA Status Display 5–173

Tally 5–174

Path Finding 5–196

Exclusion 5–210
Y Line 5–211

Each board is given a user–specified name up to eight characters in length. The system is told which type it is, and the Ethernet
address, in hexadecimal, as shown on the back of the controller chassis. The Ethernet address was furnished by Xerox Corp.
and is unique world–wide. If the board is redundant, the address of the second unit is entered.

Important: Row numbers on Jupiter tables are used as the “logical” numbers for devices. Changing the row num-
ber of an existing device (by inserting/deleting a new controller board in the middle of the table, for example) will
disrupt control of the system, requiring controller boards to be memory–cleared and reset (see “Clearing Bat-
tery–Protected Memory” in Appendix B). One way to avoid this interruption is to add new devices at the end of
tables.

† Saturn configuration instructions are described in the Saturn Installation and Operating manual.
‡ Applies only when Software Control Panel is used for machine control. For more information, see Section 7.
§ For details about CM 4000 applications, see the CM 4000 Installation and Operating Manual.
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Important: Adding a redundant controller board to an existing table will also affect the system as described im-
mediately above.

AUTOMATIC TABLE ENTRY

Because entries on this table are needed on other tables, the Configurator will automatically copy (or offer as a selectable item)
the data entered on this “initial entry” table to all “secondary” tables (including Saturn tables). For example, when a VM 3000
is entered, the name chosen will be added automatically to the Serial Protocol table. For more information about automatic
table entry, see page 5–3.

ENTERING DESCRIPTIONS OF CONTROLLER BOARDS

1. On the top of the Jupiter Configurator window (page 5–2), check to see whether the configuration set you want to
change is selected for editing.

In most cases, you will want to modify the set that is currently active; if so, you may want to copy the active set and
select the copy for editing. For more information, please see Copying a Configuration Set for Editing on page 5–10.

2. Click on “Jupiter > Network Description.” This will open a table similar to that shown on page 5–22.

3. Double–click on the first Board Name box.

Guidelines for using the editor are found on page 5–3.

4. Enter the desired name for the board, up to eight characters.
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5. Press TAB to advance to the board Type box. A pop–up menu will list the possible board types. Select a type based on
hardware and application:

Board Application
“Type”
Entry Notes

VM 3000 Control processor VM

AccuSwitch processor AS
CM 4000

Jupiter XPress (“Snowbird”) processor SB

SI 3000 Control processor SI

Saturn AAP Analog audio processor AA

Saturn AVP Analog video processor AV

Saturn CP Control Panel CP

Saturn DAP Digital audio processor DA

Saturn DVP Digital video processor DV

Saturn HDVP High definition video HD

PC Software control panel suite PC

6. Select the Address box and enter the Ethernet hardware address for the board.

For the VM/SI 3000 and other rack mount boards, the address is shown on the back panel.

Use the Backspace key to erase.

7. If the board is redundant, enter the address of the second unit.

Even though they have the same name, the two boards will have different addresses on this table.

A redundant VM 3000 installation is shown on page 2–4; a redundant SI 3000 installation is shown on page 2–86.

8. To delete a board, click on the row number box and press DELETE.

9. To close the table, click OK.

10. Click on “File > Save” to save the table.

11. Select the next table for editing. When finished, validate, compile, and activate the configuration set. (See Validating,
Compiling and Activating the Configuration Set on page 5–13 if you need more information.)



ConfiguratorSerial Protocol Table

5–25VM 3000 Installation and Operating Manual

Serial Protocol

The Serial Protocol table must be used when a VM/SI controller board is first connected to VTRs, control panels, and other
serial control devices. This includes “remote” (third party) switchers.†

This table is also used when a Saturn video processor serves as a connection point for an MPK bus, when a PC acts as a Soft-
ware Control Panel.‡

It is also used to configure the serial ports of the CM 4000 Control Module.§

2

3

Serial Protocol

1

SNYSI1

SI2 MPK

VM1 MPK

Board (CM 1)
Protocol 1/2 -

SNY

MPK

MPK

(CM 2)
Protocol 3/4 -

MPK

MPK

MPK

(CM 3)
Protocol 5/6 -

AMP

MPK

TCS

(CM 4)
Protocol 7/8 -

ES

MPK

UND

(CM 5)
Protocol 9/10 -

UND

UND

UND

11/12 - (CM 6)
Protocol

UND

UND

UND

13/14 - (CM 7)
Protocol

UND

UND

UND

15/16 - (CM 8)
Protocol

38400

(CM 1)
Baud 1/2 -

(CM 2)
Baud 3/4 -

(CM 3)
Baud 5/6 -

(CM 4)
Baud 7/8 -

(CM 5)
Baud 9/10 -

(CM 6
Baud 11/12 -

(CM 7)
Baud 13/14 -

(CM 8)
Baud 15/16 -

38400

38400

38400

38400

38400

38400

38400

38400

38400

38400

38400

UND

38400

38400

UND

UND

UND

UND

UND

UND

UND

UND

UND

Figure 5–18. Serial protocol table (example).

Password 5–17

Network Description 5–22
Serial Protocol

Switcher Description 5–31
Switcher Input 5–44
Switcher Output 5–51

Control Panel Sets
Level set 5–55
Input set 5–58
Output set 5–76
Override set 5–98
Sequence set 5–101
Category set 5–103

MPK Devices 5–108

Machines 5–141
Protocol Dependent 5–144
Machine Control 5–148
Delegation Groups 5–161

TCS–1 Device Codes 5–168
Party Line 5–169

Status Display Header 5–172
VGA Status Display 5–173

Tally 5–174

Path Finding 5–196

Exclusion 5–210
Y Line 5–211

The VM 3000 has eight serial ports, and the SI 3000 has 16; but the protocol for these ports must be set in pairs. The protocol
setting on the menu shown above corresponds to the system shown on page 1–2. On SI 3000 SI1, ports 1 through 4 are config-
ured for Sony serial machines, ports 5 and 6 for MPK control panels, ports 7 and 8 for Ampex serial VTRs, and 9 and 10 for
ESbus machines (such as Philips D–1 VTRs).

The columns on the right side of the table show the baud rate setting for each port (or port pair).

† Some of the functions described in this section may be extra–cost options. For more information, see page 1–27.
‡ Applies only when Software Control Panel is used for machine control. For more information, see Section 7.
§ For details about CM 4000 applications, see CM 4000 Installation and Operating Manual.
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ENTERING PROTOCOL FOR CONTROLLER BOARD PORTS

1. On the top of the Jupiter Configurator window (page 5–2), check to see whether the configuration set you want to
change is selected for editing.

In most cases, you will want to modify the set that is currently active; if so, you may want to copy the active set and
select the copy for editing. For more information, please see Copying a Configuration Set for Editing on page 5–10.

2. Click on “Jupiter > Serial Protocol.” This will open a table similar to that shown on page 5–25. The Board names should
already be present (they were established using the Network Description table—see page 5–22).

3. Double–click on the appropriate protocol box. A pull–down menu will list the possible protocol types. Click on the
desired type. To accept the entry, double–click again.

Guidelines for using the editor are found on page 5–3.

4. Continue the process for the baud rate fields. 

Baud rates will be selected automatically for some protocols. The possible selections are as follows (NA = not available,
Opt = optional, Std = default):

Figure 5–19. Serial protocol selections.

Device type Protocol 1200 2400 4800 9600 19200 38400 115000

Abekas 200 NA NA Opt Opt Opt Std NA

ASCII ASC Opt Opt Opt Std Opt Opt Note 1

Alpha Image ALP NA NA NA NA NA Std NA

Ampex AMP NA NA NA NA NA Std NA

Automation Note 2

CM ES Tributary CET Opt Opt Opt Opt Opt Std Opt

Datatek DTK NA NA NA NA NA Std NA

DD (Diamond) DIM NA NA Opt Opt Opt Std NA

DEC DEC Opt Opt Opt Opt Opt Std NA

Dune DUN NA NA NA NA NA Std NA

ESbus ES NA NA NA NA NA Std NA
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Device type Protocol 1200 2400 4800 9600 19200 38400 115000

ES Control ESC NA NA NA NA NA Std NA

ES Switch ESW Opt Opt Opt Opt Opt Std Note 1

ESW–Physical ESP Opt Opt Opt Opt Opt Std NA

GVG 102 TEN NA NA NA NA NA Std NA

GVG200 200 NA NA Opt Opt Opt Std NA

GVG Horizon HRZ NA NA NA NA NA Std NA

GVG Native Protocol GNP Opt Opt Opt Std Opt Opt Opt

MPK MPK Note 3 Note 3 NA NA NA Std NA

Microvideo MVD Opt Opt Opt Opt Std NA NA

NVISION Nv NA NA NA NA NA Std NA

Novotronic NVT NA NA NA NA Std NA NA

Nexus NXS NA NA NA NA NA Std NA

Party Line PL NA NA NA Std NA NA NA

Pro–bel ALP NA NA NA NA NA Std NA

RKX RKX NA NA NA NA NA Std NA

Sony SNY NA NA NA NA NA Std NA

Sony Control (PURS) SCT NA NA NA NA Std NA NA

TCS 1 TCS NA NA NA NA NA Std NA

TCS 2 TC2 NA NA NA NA NA Std NA

Triton TRI NA NA NA NA Std NA NA

Utah AVS–1B U12 Std NA NA NA NA NA NA

Utah UDI–1B U96 NA NA NA Std NA NA NA

Vistek VTK NA NA NA Std Opt NA NA

VT_ VT_ Opt Opt Opt Opt Std Opt NA

Note 1: 115K available only with CM 4000.
Note 2: Protocol for automation systems varies. Refer to additional protocol notes below and 

documentation supplied with automation system.
Note 3: Requires special PROMs or control panel settings. See “MPK” notes on page 5–29. 

Additional Protocol Notes

200 is for Model 200 series production switchers and compatibles (e.g., Abekas) (see page 2–81).

Notice that the standard setting for a Model 200 switcher is 38.4 kbaud; this is the recommended data rate. The
communication standard is RS–422; parity is automatically set to “even.” For the production switcher, protocol
setting is described in the Model 200 Peripheral Interface II manual as follows:
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“Communication can follow the RS–232 or RS–422 standard at 9.6K, 19.2K or 38.4K baud with even, odd,
or no parity. Switcher Setup Function #5 PERIPH COMM permits selection of these communication parame-
ters. This function can be accessed by connecting the Diagnostic Pod to the State Processor connector on the
521 Control Module and entering Setup mode #5.”†

The protocol must be exactly the same for all devices on the Peripheral Bus. Refer to the production switcher instal-
lation manual for additional installation and operating instructions.

ASC (ASCII) refers to switcher control using an external computer. Hardware connections are described on page 2–79.
For Diamond–ASCII, the baud rate must match the hardware setting on the DD production switcher XBAR port (nor-
mally 38400) (see page 2–76). A technical description of the Thomson ASCII computer interface protocol is presented
in Appendix N.

ALP (Alpha Image), DTK (Datatek D–2000/2166), TEN (GVG 102), HRZ (GVG Horizon), MVD (Microvideo),
NVT (Novotronic), NXS (Nexus), U12, U96, and VTK (Vistek) all refer to VM 3000 boards controlling one or more
of these “remote” (third party) switchers. U12 is for 1200 baud connection to a Utah AVS–1B with PL–320; U96 is for
9600 baud connection to a Utah UDI–1B. When selected, this entry will apply to VM/SI odd–numbered ports only. (Hard-
ware installation of these switchers is discussed on page 2–12.)

Note: Pro–bel switchers use the “AlphImag” protocol.

CET SMPTE ES Tributary protocol. For CM 4000 applications only. This is the full tributary ESBus automation proto-
col, compliant with SMPTE EG 29–1993, and all associated normative references.

DEC is a custom protocol.

DIM (Diamond) is the protocol used to return mnemonic information to a DD Series production switcher serial port.
The baud rate must match the Diamond hardware setting (normally 38400) (See page 2–76).

DUN is for Dune digital audio switchers. When selected, this entry will apply to VM/SI odd–numbered ports only.

ES (ESbus) is for VM/SI 3000 boards controlling a EBU/SMPTE ESbus–compatible VTR (such as the Philips
DCR–500) or similar machine, or, for a customer–supplied computer program controlling such VTRs.

ESC (ESbus control) is for VM 3000 boards controlling a “remote” (third–party) routing switcher using the proposed
ESbus routing switcher dialect. When selected, this entry will apply to VM/SI odd–numbered ports only. (For a descrip-
tion of this protocol, please contact Thomson.)

ESW (ESswitch) This is a simplified version of the ESbus Tributary protocol. When selected, this entry will apply to
VM/SI odd–numbered ports only. This protocol allows a Thomson Crosspoint Bus router‡ to be controlled by a Thomson
Broadcast Automation or third–party computer. Hardware connections are described on page 2–77 (Automation) and
2–79 (other systems). For a description of this protocol, please contact Thomson.

ESP (ESbus Physical) is a protocol used for “physical” switching where the control system selects physical inputs and
physical outputs on logical levels. (Note: This is not the same as File Server controlled physical switching, as described
on page 14–1.) For a description of this protocol, please contact Thomson.

† Model 200 Peripheral Interface II Protocol and Dialect (Grass Valley Group Manual Number TP0424–00, June 1988), p. 3–2.
‡ “Crosspoint Bus routers” are listed on page 2–3.
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GNP (Grass Valley Native Protocol) is used for Jupiter control of a Grass Valley SMS 7000 or Encore control system
(which is in turn connected to a routing switcher).

MPK is the “Message per Keystroke” protocol used for all MPK devices, such as CP–3000 series control panels. (For
a complete list of MPK devices, see Dev Type on page 5–109.)

Operating a control panel at any baud rate other than 38400 will limit the number of panels per port to one.

For use with a modem, the CP 3000 panel can be equipped with either a 1200 baud PROM or a 2400 baud PROM;
other panels allow the baud rate to be set at the front panel. For more information, refer to page 2–101.

Nv (NVISION)protocol is the same as ESControl except it is not refreshed; it is intended for use with Nvision data rout-
ers. When selected, this entry will apply to VM/SI odd–numbered ports only.

RKX is a routing switcher protocol.

SNY (Sony) is for the Sony machine control protocol.

SCT (Sony Control) is a custom Sony routing switcher protocol (PURS). When selected, this entry will apply to VM/SI
odd–numbered ports only. This protocol requires a 3rd party interface not supplied by Thomson.

PL (Party Line) is for VM 3000 boards on which the Party Line port is active; “Party Line” would be selected for serial
ports 7 and 8. Note that selecting “Party Line” does not actually cause the serial ports to operate according to Party Line
protocol; in fact, it causes the ports to be switched off and the Party Line port to be switched on. (This arrangement is
used because there is only one hardware controller available for serial ports 7–8 and the Party Line port.) The Party Line
port must be configured using the Party Line description table (page 5–169).

TCS/TC2 (Tcs 1 and Tcs 2) — Systems requiring these protocols are shown on page 2–89. If “TCS” is selected, the
CP (Control Panel) version of the protocol will automatically be assigned to the odd side of the port pair and the MI
(Machine Interface) version of the protocol will automatically be assigned to the even side of the port pair.

“TC2” only applies to MCS–2000 applications. When selected, it will automatically be assigned to the odd side of the
port pair (which is connected to the MCS); the even side of the pair would not be available for use.

TRI (Triton) routing switcher protocol applies to VM/SI odd–numbered ports only.

VT_ is a custom protocol.

5. After saving your changes, compile and activate the configuration set. (See Compiling and Activating the Configuration
Set on page 5–13 if you need more information.)
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SATURN VIDEO PROCESSOR – ENTRY FOR MPK PORT

The Saturn Master Control Switcher video processor (either digital or analog) can be used as an alternate connection point
for an MPK bus. (In Saturn stand–alone systems, it would be the only MPK port available.) Typical uses for the MPK bus
include:

� Connection to an MI–3040 General Purpose / Tally Interface (see page 2–105 for a system illustration).

� Connection to a SD–3x Status Display (not presently supported by Saturn MPK port).

� Connection to the Saturn console’s Select button group. In multi–channel Saturn systems, this would allow
selection of the channel to be be controlled. Please refer to the Saturn Installation Manual for more information.

An example entry is shown in Figure 5–20. The name of the video processor comes from the Network Description table. To
define the processor’s port, select “MPK” and “38400” for the first port pair. All other ports can be left undefined.

2

Serial Protocol

1 AVP MPK

Board (CM 1)
Protocol 1/2 -

UND

(CM 2)
Protocol 3/4 -

UND

(CM 3)
Protocol 5/6 -

UND

(CM 4)
Protocol 7/8 -

UND

(CM 5)
Protocol 9/10 -

UND

11/12 - (CM 6)
Protocol

UND

13/14 - (CM 7)
Protocol

UND

15/16 - (CM 8)
Protocol

38400

(CM 1)
Baud 1/2 -

(CM 2)
Baud 3/4 -

(CM 3)
Baud 5/6 -

(CM 4)
Baud 7/8 -

(CM 5)
Baud 9/10 -

(CM 6
Baud 11/12 -

(CM 7)
Baud 13/14 -

(CM 8)
Baud 15/16 -

Figure 5–20.
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Switcher Description

Logical level 
number Logical level 

name

Physical level 
number

1

Switcher Description

MAINROUT VM1 64 64 1 Binary None

2 MAINROUT VM1 64 64 2 Binary Left

3 MAINROUT VM1 64 64 6 Binary Right

4 MAINROUT VM1 64 64 3 Binary None

VIDEO

LEFT

RIGHT

TC

5 MAINROUT VM1 65 65 16 DM400B EnforceDATA

6

Switcher VI RV Board #In #Out PLvL Follow Level Driver 3 LI 3 LO Option AudioLevel
DM 400

MC Off Time

Figure 5–21.  Switcher Description table (example).

Password 5–17

Network Description 5–22
Serial Protocol 5–25

Switcher Description
Switcher Input 5–44
Switcher Output 5–51

Control Panel Sets
Level set 5–55
Input set 5–58
Output set 5–76
Override set 5–98
Sequence set 5–101
Category set 5–103

MPK Devices 5–108

Machines 5–141
Protocol Dependent 5–144
Machine Control 5–148
Delegation Groups 5–161

TCS–1 Device Codes 5–168
Party Line 5–169

Status Display Header 5–172
VGA Status Display 5–173

Tally 5–174

Path Finding 5–196

Exclusion 5–210
Y Line 5–211

This table must be used when the VM 3000 or CM 4000† is first connected to a distribution switcher.§

Each logical level number of the switcher is given a user–specified name up to eight characters in length, and the system is
provided with detailed information about each level.

† CM 4000 installation is described in the CM 4000 Installation and Operating Manual.
§ Some of the functions described in this section may be extra–cost options. For more information, see page 1–27.
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ENTERING SWITCHER LEVELS DESCRIPTIONS

1. On the top of the Jupiter Configurator window (page 5–2), check to see whether the configuration set you want to
change is selected for editing.

In most cases, you will want to modify the set that is currently active; if so, you may want to copy the active set and
select the copy for editing. For more information, please see Copying a Configuration Set for Editing on page 5–10.

2. Click on “Jupiter > Switcher Description.” This will open a table similar to that shown on page 5–21.

3. Switcher Level      Enter a switcher and level name.

Guidelines for using the editor are found on page 5–3.

Important:  Row numbers on Jupiter tables are used as the “logical” numbers for levels. Changing the row number
of a level (by inserting/deleting a new level in the middle of the table, for example) will disrupt control of the
system, requiring controller boards to be memory–cleared and reset (see “Clearing Battery–Protected Memory”
in Appendix B). One way to avoid this interruption is to add new levels at the end of tables. Adding new levels
in the middle of the table will also clear all entries in the Switcher Input and Output tables.

Normally one switcher is named, using up to eight characters.

The level name (also called “logical level name”) can also be up to eight characters. All of the following information
entered on this menu will apply to this level. Conventional names are “VIDEO,” “LEFT,” “RED,” “GREEN,”etc.

For a Venus “ES 401”§ digital audio switcher with two–level stereo mode hardware settings, there must be an entry for
the Left level and another for the Right level; this will allow special stereo mode switching such as Mix and Reverse.
If the ES 401 switcher’s hardware is set for one–level stereo mode, or for one–level mono mode, or if a Venus “ES 400”
digital audio switcher is being configured, only one entry is needed. For information about setting the Venus hardware,
refer to the Venus Installation manual.

If there is more than one Thomson Crosspoint Bus router‡ type in the system (such as a Venus plus a Trinix), there are
two possible approaches to configuration. The additional switcher can be entered as a named level (or levels) within
the main router; however, this will require a unique hardware setting on each level to avoid conflicts (see diagram on
page 2–33). Another solution would be to drive the Venus with one VM 3000 and the Trinix with another; this would
allow level settings to remain independent (see diagram on page 2–34).

4. VI      Select vertical interval switching Yes or No for this level. Normally checked for the video level and unchecked
for all others.

If the VM 3000 is supplied with house reference sync, checking VI will cause switches on this level to start in the house
vertical interval. In other words, the level selected on this menu will start switching first; other levels will follow as soon
as possible. Priority is normally given to video since audio switches outside of vertical interval are not as noticeable.

§ In this manual, “ES 401 switcher” refers to the AES11 synchronous/asynchronous version of the digital audio switcher
matrix board and its associated components; “ES 400 switcher” refers to the original asynchronous (non–reclocking) ver-
sion of the digital audio switcher matrix board and associated components.

‡ “Crosspoint Bus routers” are listed on page 2–3.
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This method of enforcing vertical interval switching applies only to Thomson switchers operating on the Crosspoint
Bus port of the VM. For “remote serial control” applications, including Triton, Horizon, TEN–20 / 20–TEN, and 3rd
party routers, VI should be unchecked on all levels.

5. RV      Reverse switching. This item applies only to certain data switchers. For video, audio, and time code switchers,
leave unchecked.

This box is checked for older model RS–232/422/423 data switchers equipped with DM 400/400A§ Data Matrix boards.
Configuration of DM 400/400A Data Matrix boards is described in Appendix L.

Newer model data switchers equipped with DM 400B§ Data Matrix boards use only one level, and the “RV” box is left
unchecked (even though “reverse” switching is still taking place).

6. MC      Select machine control assignment follow Yes or No for this level. Normally checked for video level and un-
checked for all others. One (only) level can be checked.

As explained in detail elsewhere in this manual, the usual procedure is for the machine assignment system to follow the
distribution switcher; that is, if a certain VTR is selected for a certain destination, then the associated machine control
panel will automatically assume control of that VTR. (See Assigning Machines to Control Panels on page 5–151 for more
information.) This menu item determines which level will be used as the reference in making the machine assignment.

7. Board      Select the name of the VM/CM controlling this level.

The source of these names is the Network Description table (page 5–22).

Each logical level can be controlled by a separate VM.

Redundant VM boards, if any, are ignored on this table. Recall that redundant VM boards have the same logical name.

Using a single VM, one or more Thomson Crosspoint Bus routers can be connected to the Crosspoint Bus port.

Triton routers, or certain non–Crosspoint Bus routers, can be connected to a VM 3000 serial port (odd–numbered only).
SI 3000 serial ports cannot be used for this purpose.

Special entries are required in this column for Saturn Master Control Switchers equipped with an internal switching
matrix.†

§ Type and model of switcher card is shown on front edge of printed circuit board.
† Saturn configuration instructions are described in the Saturn Master Control Switcher Manual.
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8. #In #Out      Enter the number of inputs and outputs for this logical level.

For Venus video switchers, the maximum for one logical level is 1024 in and out.

For Venus audio switchers, where the left and right channels are assigned to different levels, the maximum number of
inputs is 512 per level; the maximum number of outputs is 1024 per level. For example, these values would apply to
a Venus analog audio switcher configured for stereo operation (the usual case) and to a Venus ES 401 digital audio
switcher configured for two–level stereo operation.

For Venus analog audio switchers configured for mono operation, ES 400 digital audio switchers, or ES 401 digital audio
switchers operated in 1–level stereo mode or mono mode, the maximum number of inputs and outputs is 1024.

For three–stage switchers*, this must be the fully–expanded (“target”) size of the switcher. For additional information
concerning three–stage switchers, see Appendix H.

Special entries are required if Output Monitoring is being used (see Appendix O).

For Venus DM 400B Data Matrix switchers, the entry for “#In” and “#Out” should be set to the actual number of inputs
plus 1 to allow an extra number for the “SAFE” input. For example, if the switcher is 64  x 64, both entries should be
“65.” (A DM 400B matrix is always square.) The maximum is 192 in and out.

Mars switchers, which use octal architecture, will require special entries. When the binary driver is used (as described
in Step 11 below), then the “#In/#Out” entries are as follows:

Switcher size No. of inputs (as entered on table) No. of outputs (as entered on table)

24 x 8 64 16

For the maximum number of inputs/outputs for remote (third party) switchers, refer to the manual supplied with the
switcher. 

9. PLvL      Enter the physical (hardware) level number.

This is the level address determined by hardware switches on the switcher itself. These are normally set at the factory
and rarely changed in the field. Refer to the following list and the hardware manual supplied with the switcher for more
information.

A physical level number can range from 1 to 999; however, the maximum number of logical levels is still 96. This num-
ber may be reduced according to the number of outputs being controlled. For more information, see page 1–16.

* See Glossary.
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a. For Venus switchers, the backplane level select jumpers are usually factory set as follows:

Name of level Physical level no. Notes

Analog video 1
Serial digital video (standard definition) 7
Serial digital video (high definition) 9

Analog audio left (A1) 2
Analog audio right (A2) 6
Analog audio A3 8
Analog audio A4 12
AES digital audio 32 Applies to all versions and modes of digital 

audio switchers.
AES digital audio (right) 36 Applies only to right channel of ES 401 

digital audio switchers operated in two–level
stereo mode.

Time code (mono) 3
Data transmit 16
Data receive 16
Data (reserved) 20

These level numbers should be confirmed by checking the documentation package supplied with the switcher.

Analog audio stereo level numbers: Selection of  mono/stereo mode is determined by a backplane
jumper. With this jumper in the Stereo position, the physical level number set by the Level jumper is
automatically applied to the Left stereo channel (in this example, Left audio would be physical level
“2.”); and, the Right stereo channel is automatically given the same number plus 4 (in this example
Right audio would be physical level “6”). Furthermore, stereo operation places restrictions on the
physical level numbers that can be used; specifically, the “L4” level jumper cannot be installed. For
more information, please refer to the “Backplane Jumpers” section of the Venus Installation Manual.

ES 401 digital audio switcher level numbers: Selection of one– or two–level mode is determined by
hardware jumpers and switches: (1) If the “Mono” backplane jumper is On, the ES 401 will operate as a
one–level mono 64 x 64. (2) With this jumper off, dip switch settings on the Matrix and Output boards
will determine whether the switcher is operated as one–level stereo or two–level stereo.

The default setting is Mono jumper OFF, two–level stereo, which permits special stereo mode switch-
ing such as mix and reverse. This setting requires configuration of two levels, such as Level 32 and Lev-
el 36 as shown above. Again, the right channel always has the number of the left channel plus 4. For
more information about these hardware settings, refer to the Venus manual.

Note: If non–factory default numbers are used, the following rules should be kept in mind: 1) For analog
audio left levels, and for digital audio levels, the binary form of the physical level number cannot have the 4s
bit set to 1; e.g., decimal ”2” (binary 00000010) can be used for analog audio left but decimal ”4” (binary
00000100) cannot. This means that the following decimal numbers cannot be used: 4 through 7, 12 through
15, 20 through 23, 28 through 31, 36 through 39, 44 through 47, 52 through 55, 60 through 63, etc. 2) The
analog audio right level number must be the left number + 4.
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b. Concerto switchers are configured much the same as Venus. For more information, refer to Thomson Field Engi-
neering Bulletin 075–0722–00, “Jupiter Crosspoint Bus Control of Concerto Flexframe Routing Matrix.”

c. For Horizon† switchers. The physical level number can range from 0 to 3. 

d. For TEN–20 / 20–TEN† switchers, the physical level number can range from 0 to 3. 

e. Triton switchers, when controlled by Jupiter, use a level scheme different than that described in the Triton manual.
In Jupiter applications, split switching requires each level to be assigned a different number.

Entries in the PLvL column consist of three digits. The first digit serves only to differentiate the table entry from
all other physical levels connected to the VM; the second two digits are derived from the “Router Address” DIP
switch [setting on the rear panel. In a typical video/audio/time code application, the first digit could be “1,” while
the last two digits would be the Router Address for the chassis. For example:

Triton chassis DIP switch setting PLvL entry

Video 0010 (decimal 02) 102
Left and right audio 0000 (decimal 00) 100
Time code 1111 (decimal 15) 115

Note that split switching is possible, but only between chassis; e.g., it is possible to split Audio Left/Right from
Video, but not possible to split Audio Left away from Audio Right.

As a convention, it is suggested that all Triton chassis connected on the same MIDI bus use the same first digit.
Thus if there were a second “group” of Triton switchers connected on another MIDI bus (and per Jupiter require-
ments connected to a second VM), they might have “2” as the first digit in the PLvL entry. For example:

Triton chassis Connected to DIP switch setting PLvL entry

News Video VM2 0010 (decimal 02) 102
News Left and right audio VM2 0000 (decimal 00) 100
News Time code VM2 1111 (decimal 15) 115

Aux Video VM5 0010 (decimal 02) 202
Aux Left and right audio VM5 0011 (decimal 03) 203

In RGB or YUV applications where all three signals must always switch together, the Router Address switches
should be set to the same value on each chassis. However, the Switcher Description table has only one row cover-
ing all three chassis. For example:

Triton chassis DIP switch setting PLvL entry

† When a switcher of this type and a Thomson Crosspoint Bus switcher are entered on this table, an offset of 100 can be used
to avoid having the same level numbers for both switchers. Thus a hardware level setting of “0” on the Alpha Image
switcher could be entered on this table as “100”; or, a hardware Level setting of “1” on the Datatek switcher could be en-
tered on this table as “101.” This eliminates the need to re–set existing level settings on the hardware.
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Red 0000 (decimal 00) 100

In this example, the Green and Blue chassis would also have their Router Address switches set to “0000.”

f. Conventional TVS/TAS square matrix switchers. For these switchers the hardware switches are usually set as
follows:

Name of level Physical level no.

Video 1
Left audio 2
Right audio 8
Time code 4

TVS/TAS data matrix forward/reverse level numbers: two levels must be described on the table—a forward level
and a reverse level; for TVS/TAS data matrix switchers the levels have different physical level numbers.

g. RKX switchers††. The physical level number can range from 0 to 99. 

h. Multiple switchers. 

An example of a multiple switcher installation is shown on page 2–33.

As discussed in Step 3 above, more than one switcher can be operated by a single VM board; however, this will
require a unique hardware setting on each level to avoid conflicts. For example, you could enter a switcher “MAIN-
ROUT” with levels 1, 2, and 6; and switcher “NEWSROUT” with levels 3, 4, and 5.

Alternatively, by dedicating a separate VM board to each switcher, the same physical level numbers can be used
on different switchers if desired. (See diagram on page 2–34.)

i. Logical level mapping (two logical levels on one physical level).

An example of logical level mapping is shown on page 2–31.

In these systems, the same physical level number can be used on more than one logical level (i.e., on more than
one row of the Switcher Levels table). For example, you could enter a switcher “MainRout” with Left Audio on
level 2, and with Right Audio also on level 2. This technique can sometimes help reduce overall switcher size, but
it requires special entries to this table and to the Switcher Outputs table as follows:

— the Switcher Levels table must always show the total number of outputs for the entire physical level. For the
example system shown on page 2–31, the matrix entry would be “60 x 60” for the Left logical level, even
though the level is being used as a 60 x 30. The same applies to the Right logical level; the table entry would be
“60 x 60.”

— the Switcher Outputs table (page 5–51) must indicate the differing physical output numbers used on each
level. For example, output “VT01” might use physical output “20” for video and left audio and physical out-
put “21” for right audio.

††When an RKX and a Thomson Crosspoint Bus switcher are entered on this table, an offset of 100 can be used to avoid
having the same level numbers for both switchers. See also footnote marked with “†” on next page.
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j. Alpha Image A264S†. The physical level number is zero. 

k. Datatek D–2000/2166†. The physical level number can range from 0 to 6. 

l. ESbus switchers§. The physical level number can range from 0 to 254 (but is limited to 126 by the VM 3000).

m. NVISION§ data switchers. The physical level number can range from 0 to 254 (but is limited to 126 by the VM
3000).

n. Microvideo†. The physical level number is 0. 

o. Nexus†. The physical level number is 0. 

p. Novotronic†. The physical level number can range from 1 to 10 (never 0). 

q. Three–stage switchers. See Appendix H.

r. Utah Scientific† switchers, the physical level number can range from 0 to 3. 

s. Vistek Array† switchers, the physical level number can range from 0 to 25. 

Notice that protocol can be assigned on a level–by–level basis.

On the VM crosspoint bus, this would allow a combination of TVS protocol on some levels and Binary protocol on oth-
ers. This would be the case in a system which combines a Venus with a TVS/TAS–2000, for example.

10. Follow Level      Enter name of switcher and logical level that this level is to follow permanently. For video/audio
switchers these boxes are usually left blank, thus allowing for split (breakaway) switching.

For switchers where split switching is not desirable (such as RGB switchers), this entry can be used to force one level
to follow another; for example, “Red” could be entered in the Follow Name box on the menus for the Green and Blue
levels. (This entry is not needed for Triton RGB/YUV applications.)

† When a switcher of this type and a Thomson Crosspoint Bus switcher are entered on this table, an offset of 100 can be used
to avoid having the same level numbers for both switchers. Thus a hardware level setting of “0” on the Alpha Image
switcher could be entered on this table as “100”; or, a hardware Level setting of “1” on the Datatek switcher could be en-
tered on this table as “101.” This eliminates the need to re–set existing level settings on the hardware.

§ When a switcher of this type and a Thomson Crosspoint Bus switcher are entered on this table, an offset of 400 can be used
to avoid having the same level numbers for both switchers. See also preceding footnote. 
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11. Driver      Select distribution switcher protocol (“Driver”).

    Figure 5–22. Switcher protocol selections.

Switcher Protocol

Concerto Binary

Grass Valley Series 7000 (controlled via
SMS 7000)

GVG Native Protocol

Grass Valley Encore–controlled router GVG Native Protocol

Dune Binary

HORIZON Horizon

Mars Binary

RKX RKX

SDR 400 Binary

 TEN–20 20–Ten

20–TEN 20–Ten

Trinix Binary

Triton Triton

TVS/TAS 1000 TVS Prot

TVS/TAS 2000/2001 TVS Prot

TVS/TAS 3000 TVS Prot

Binary Confirm All (test) Binary Confirm all

TVS/TAS Confirm All (test) TVS Confirm all

Venus Binary

Venus Data DM 400/400A Binary

Venus Data DM 400B DM400B

Alpha Image A264S Alpha

Datatek D–2166/2000 Datatek

ESbus switcher Es Bus

Microvideo MVD

Nexus NXS

Novotronic NVT

NVISION data router NVision

Pro–bel Eclipse (SW.P.02) Alpha

Sony Sony

Vistek Array Vistek

Utah Scientific Party Line (UDI–1B) Utah_96

Utah Scientific AVS–1B (PL–320) Utah_12
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12. 3 LI 3 LO      Enter inputs per input stage sub switcher (“3LI”) and outputs per output stage sub switcher (“3LO”).
These entries apply only to three–stage switchers (see Appendix H). For conventional square matrix switchers, leave
blank.

13. Option      This item applies only to data switchers (see page 5–41). For video, audio, and time code switchers, leave
blank.

14. Audio      In the “Audio” column, for Venus switchers, select “Left” for the left audio level, “Right” for the right, and
“Normal” for all others. This will allow special CP 3000 and CP 3800 audio switching modes such as mixing stereo
signals into a mono output, duplicating a mono signal on both channels of a stereo output, and reversing channels.

For Triton switchers, select an “A” for each audio chassis. Triton data switchers with rear–panel DIP switch 7 DOWN
(“controlled as audio”) also require an “A” entry. For Triton video switchers, or for Triton data routers with switch 7
UP (“controlled as video”), leave the column blank.

15. DM 400 Off Time      This item applies only to data switchers (see page 5–43). For video, audio, and time code
switchers, leave blank.

16. After saving your changes, validate, compile, and activate the configuration set. (See page 5–13 if you need more in-
formation.)
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Option   POINT–TO–POINT DATA SWITCHING OPTIONS

(“Normal/Advise/Enforce”)

Normally, a distribution switcher allows an input to be sent to more than one output. For example, the video in Figure 5–23
could be switched to two destinations at the same time.

Figure 5–23.

Video

In a data switcher, it may be desirable to restrict operation to “point–to–point” switching. For example, this would insure that
the transmit data from an editor could be switched to only one VCR at a time, as shown in Figure 5–24.

Figure 5–24.

Editor

VCR 1

VCR 2

Data

Controller level



Configurator Switcher Description Table

5–42 VM 3000 Installation and Operating Manual

When “Enforce” is turned on, and an attempt is made to switch control to a new device, then the device presently being con-
trolled will be switched automatically to a “safe” (non–existent) input (Figure 5–25).

Figure 5–25.

Editor

VCR 1

VCR 2

“Safe input”

Controller level

The control device would then be switched to the new destination (Figure 5–26).

Figure 5–26.

Editor

VCR 1

VCR 2

“Safe input”

Controller level

— For Venus DM 400/400A data routers, the Safe Input is defined as the first input listed on the Switcher Input
table (page 5–48), which is the same as “logical input 1.” The physical input number of the Safe Input
should always be “192;” this insures that the router will tri–state (i.e., the destination will be connected to a
high–impedance source).

— For DM 400B data routers, the Safe Input is defined as whatever input is named “SAFE” on the Switcher
Input table (page 5–48); the physical input number should always be one (1) beyond the last input number
(e.g., if the inputs are numbered 000–063, then the Safe Input would be 064). In these systems selecting the
Safe Input will cause the destination to be switched “off.”

When “Advise” is turned on and an attempt is made to switch control to a new device, the switch will not occur. The system
will display the following message on the control panel:

Input currently in use by <output number>

The operator can then switch the “safe input” to the device presently being controlled. This will avoid having the control de-
vice connected to two machines at the same time.

When “Normal” is turned on and an attempt is made to switch control to a new device, the switch will occur immediately.
There will be no notification of conflict or extra switch to a safe input.
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DM 400 Off Time   DATA SWITCHING – OFF TIME BETWEEN SWITCHES 

Number of frames switcher will dwell on Safe input when switching between controlled devices

When a switch occurs from one VTR control cable to another where the VTRs are of different types, the switch can occur
so rapidly that the editing system may not know that a new type of VTR has been connected. This can result in editing
inaccuracies since the editing system may be using ballistics for the wrong type of VTR. See Figure 5–27.

Figure 5–27.

Editor

VTR 1

VTR 2

Data Switcher

“Safe input”

To avoid this problem, the data switcher can be set to switch to a Safe input, wait for a specified minimum number of frames,
and then switch to the new device. This will cause the editing system to send a request to the new VTR to identify itself and
get the correct ballistics.

The wait period is set in the “DM 400 Off Time” column of the Switcher Description table. A setting of approximately 3/4
second is recommended (20 frames). The maximum value is 99 frames.

The delay will only occur when a data switcher is switching real devices, and only when Enforce (see page 5–42) is turned
on.

The DM 400A data switcher requires a two–row entry on the Switcher Description table; in this case the DM 400 Off Time
entry is made on the Reverse switcher row (the row with the letter “R” in the RV column).

For an overview of data switching, see page 2–32.
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Switcher Input

The switcher input table must be used to assign a logical name to each physical input.

If there is more than one switcher in the system, a table must be defined for each. Figure 5–28 shows a table for switcher
“MAINROUT.”

1

Name

BARS

RIGHTVIDEO

2 TONE

3 TC

4 VT01

5 VT02

6

7

8

BLK

VT03

VT04

LEFT TC

000

001

002

003

004

VT05 005

000P

001

002

003

004

005

000P

001

002

003

004

005

000P

001

002

003

004

005

064P

Switcher Input – MAINROUT

064I

000I 000I 000I

000I

000I060I 060I

Figure 5–28. Switcher input table (example).

Logical Input

Password 5–17

Network Description 5–22
Serial Protocol 5–25

Switcher Description 5–31
Switcher Input 
Switcher Output 5–51

Control Panel Sets
Level set 5–55
Input set 5–58
Output set 5–76
Override set 5–98
Sequence set 5–101
Category set 5–103

MPK Devices 5–108

Machines 5–141
Protocol Dependent 5–144
Machine Control 5–148
Delegation Groups 5–161

TCS–1 Device Codes 5–168
Party Line 5–169

Status Display Header 5–172
VGA Status Display 5–173

Tally 5–174

Path Finding 5–196

Exclusion 5–210
Y Line 5–211

“BARS,” “TONE,” and “VT01” are logical names for various inputs. Each name, which can be up to eight characters long,
corresponds to a switcher physical input number for each level of the switcher. This number is normally attached at the
factory to each connector on the back of the switcher; however, it should be understood that the real source of this number
is the hardware device address, which is usually set with an internal DIP switch or jumper. (For more information, refer to
the manual supplied with the particular switcher.)
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Note: an input name is not entered directly at switcher control panels; rather, it is linked to a category and entry
number through the CP Input Sets table. The category and entry number are then entered at the control panel to
make the switch. The status mnemonic that appears on control panels is also determined by the CP Input Sets table.
For more information, see page 5–58.

Important: Mars physical input numbers, when controlled by a Jupiter system, are not continuous. For example,
physical input numbers 8 through 15 are skipped. For more information, refer to the Mars manual in the Cross-
point/Jupiter control section.

Note: Some switchers (such as Concerto and Triton) use “1” as the first input connector number. In this case, the
physical input number for this connector, as entered on the table, is “0.” Connector “2” is physical input number
“1,” etc.

In Figure 5–28, there are four levels: video, left audio, right audio, and time code. The table shows that the input named
“VT01” is wired to connector 001 on all four levels. Similarly, the input name BARS is associated with connector 000 on
all four levels.

If there is no entry for a particular level, no switch will occur on that level. On this table, when input “TC” is requested from
a control panel, only the time code level will switch.

An automatic split (breakaway) can also be arranged. In this example, a request for the input named “TONE” will obtain input
064 on the video level but input 000 on the other levels. Split switching is described in more detail below.

In Venus DM 400B data switching applications, the switcher input table is used to assign a logical name to each physical
port connected to a “tributary” device. For more information, see page 5–48.
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SPLIT SWITCHING

Split (or breakaway) switching is the selection of one input on one level and another input on another level. An example would
be the selection of color bars on the video level and test tone on the audio levels. Split switches can be manual, where the
operator addresses individual levels and makes each switch separately; or, automatic, where a single category / entry number
will cause the split to occur.

An automatic split can be arranged in either of two ways:

— The switcher can be wired so that the split sources arrive on parallel inputs, as shown in Figure 5–29. On the
video level, color bars are wired in as input 0. However, on the audio levels, test tone is wired in as input 0 and a
time code generator is wired in as input 0 on the time code level. The Switcher Inputs table (Figure 5–28) is
then arranged so that the input named “BARS” will switch to input 0 on all levels. This technique might be
referred to as a “hard–wired split.”

       Figure 5–29. Inputs to four–level switcher, showing a “hard–wired split.”

0

Video

BARS

1 2 3 4

Left audio

TONE TONE

Right audio Time code

0 1 2 3 4 0 1 2 3 4 0 1 2 3 4

TIME CODE
GEN

— A more flexible approach is to modify the Switcher Input table so that a single input name will address differ-
ent physical inputs from one level to another. For example, the switcher could be wired as shown in Figure
5–30, where black burst is input 64 on the video level, test tone is input 0 on the audio levels, and a time code
generator is input 0 on the time code level. The Switcher Input table is arranged so that the input named
“TONE” will switch to those inputs.

       Figure 5–30. Software–controlled split.

62

Video

BLACK

63 65 66 0

Left audio

TONE

1 2 3 464 0

Right audio

TONE

1 2 3 4 0

Time code

1 2 3 4

TIME CODE
GEN

Statusing for split switches is determined by the “I” and “P” suffixes on the Switcher Inputs table, as described in Primary
and Indirect Status Instructions on page 5–60.
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ENTERING OR EDITING INPUT NAMES AND NUMBERS

1. On the top of the Jupiter Configurator window (page 5–2), check to see whether the configuration set you want to
change is selected for editing.

In most cases, you will want to modify the set that is currently active; if so, you may want to copy the active set and
select the copy for editing. For more information, please see Copying a Configuration Set for Editing on page 5–10.

2. Click on “Jupiter” and “Switcher Input.” This will open a list of all existing Switcher Input tables (or open the table if
there is only one).

3. Click on the desired switcher input table name and “OK.” This will bring up a table similar to that shown on page 5–44.

If the table is based on the factory–supplied “Numeric” set, the table illustrates the reason for the name “numeric”—the
“Name” column shows all the inputs with numbers instead of names.

4. Enter/edit the desired logical name and physical input numbers for the inputs.

Guidelines for using the editor are found on page 5–3.

Important:  Row numbers on Jupiter tables are used as the “logical” numbers for sources. Changing the row num-
ber of an existing source (by inserting/deleting a new input in the middle of the table, for example) will disrupt
control of the system, requiring controller boards to be memory–cleared and reset (see “Clearing Battery–Pro-
tected Memory” in Appendix B). One way to avoid this interruption is to add new inputs at the end of tables.

5. After saving your changes, validate, compile, and activate the configuration set. (See page 5–13.)
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DATA SWITCHING APPLICATIONS

In Venus DM 400B data switching applications, the switcher input table is used to assign a logical name to each physical port
connected to a “tributary” device. See Figures 5–31 and 5–32.

Note: Configuration of DM 400/400A Data Matrix boards is described in Appendix L.

Port 00

DM 400B Data
Matrix

Controller

Editor selected
as switcher

OUTPUT
Port 01

Tributary

Tributary

Port 02

VTR 1 selected
as switcher 
INPUT

VTR 2 selected
as switcher 
INPUT

Figure 5–31. Example of DM 400B system.

For a discussion
of the “Safe” input,

see page 5–42.

See Note 1.

1

VT01

2

VT02

3

SAFE

001

002 002

Switcher Input – MAINROUT

002

001 001 001 001

064

002 002

EDIT1 000 000 000 000 000

4

Figure 5–32. Switcher Input table
for system shown in Figure 5–31.

Name RIGHTVIDEO LEFT TC DATALogical Input

Similarly, the switcher output table is used to assign a logical name to each physical port connected to a “controller” device.
See Figure 5–33.

Note 1: All port numbers that reside in the Switcher Output table must also have an entry in the Switcher Input
table (This is done to avoid possible Status display problems and is checked by the PC compiler).

Figure 5–33. Switcher Output table for system shown in Figure 5–31.

1

Switcher Output – MAINROUT

EDIT1 –

2 –

Name Security S–T
Pass
word RIGHTLEFT TC

000 000 000

DATA

000

VIDEO

000

Logical Output
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Controller / Tributary Reassignment

Some VTRs can themselves act as controllers or tributaries. With the DM 400B the associated ports can be configured as both
inputs and outputs; this allows their pinouts to adjust automatically depending on which VTR is selected as the output (con-
troller) and which is selected as the input (tributary). In Figure 5–34, VTR 1 is the controlling device; accordingly it is selected
as a switcher output in order to configure the switcher port correctly. The tributary VTR 2 is selected as a switcher input.

Port 01

Controller
pinout

Tributary
pinout

Tributary
pinout

Controller
pinout

Port 02

DM 400B Data
Matrix

VTR 2 selected
as switcher 
INPUT

VTR 1 selected
as switcher 
OUTPUT

Figure 5–34.

In Figure 5–35, the roles are reversed. VTR 2 is the master and VTR 1 is the slave. The switcher ports are configured properly
by selecting VTR 2 as an output and VTR 1 as an input.

Port 01

Tributary
pinout

Controller
pinout

Port 02

DM 400B Data
Matrix

Controller
pinout

Tributary
pinout

VTR 2 selected
as switcher 
OUTPUT

VTR 1 selected
as switcher 
INPUT

Figure 5–35.

Examples of  Switcher Input and Switcher Output tables for this reassignment application are shown in Figure 5–36.
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Figure 5–36. Switcher Input and Output
tables for application shown on page 5–49.

1

Name

VT01

RIGHTVIDEO

2

VT023

SAFE

LEFT TC

001

002 002

Switcher Input – MAINROUT

001 001 001 001

DATA

064

002 002

1

Switcher Output – MAINROUT

Name

VT01

Security S–T

–

VIDEO

001

LEFT

001

RIGHT

001

TC

001

2 VT02 – 002 002 002 002

Pass
DATA

001

002

Word

002

Logical Input

Logical Output

CP Input and Output Sets and Control Panel Operation

The input and output names in the previous tables must be assigned to Category/Entry selections using a CP Input Set (page
5–58) and CP Output Set (page 5–76). For example, if a CP–3000–type panel is to be used, the “C” (for “controller”) category
button could be used to select the controller (output) and the VCR category button could be used to select the VCRs .
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Switcher Output

The Switcher Output table performs much the same function as the switcher input table (described on page 5–44) except that
it applies to outputs.

1

Switcher Output – MAINROUT

Name

MAT MON

Security S–T

–

VIDEO

000

2 MC QC – 001

3 PATCH 1 – 002

4 PATCH 2 – 003

Pass

5 SHOP – 004

6 VC 2P 1 – 005

7 VC 2P 2 – 006

8 VC 2P 3 – 007

word LEFT

000

001

002

003

004

005

006

007

RIGHT

000

001

002

003

004

005

006

007

TC

000

001

002

003

004

005

006

007

9 VC 2P 4 – 008

6 VC  2S – 009

7 VT 01 – 010

8 VT 02 – 011

008

009

010

011

008

009

010

011

008

009

010

011

Figure 5–37. Switcher output table (example).

Logical Output

Password 5–17

Network Description 5–22
Serial Protocol 5–25

Switcher Description 5–31
Switcher Input 5–44
Switcher Output

Control Panel Sets
Level set 5–55
Input set 5–58
Output set 5–76
Override set 5–98
Sequence set 5–101
Category set 5–103

MPK Devices 5–108

Machines 5–141
Protocol Dependent 5–144
Machine Control 5–148
Delegation Groups 5–161

TCS–1 Device Codes 5–168
Party Line 5–169

Status Display Header 5–172
VGA Status Display 5–173

Tally 5–174

Path Finding 5–196

Exclusion 5–210
Y Line 5–211

Logical Output
Name

     The table is used to give each physical output a logical name up to eight characters in length. If
more than one switcher is in the system, a table must be defined for each. Figure 5–37 shows a table for
switcher “MAINROUT.”

Unlike the Switcher Inputs table, the outputs table has several provisions for security:

Security      A Security Board can be identified for an output by entering the name of a controller board (such as
“VM1”); only controls connected to that board could be used to switch the output. The name must be one of
those already entered on the Network Description table (page 5–22).
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S–T      A Security Board Type can be entered. Only controls connected to a control board of that type could then
be used to switch the output. A dash (“–”) entry means “none.” The following boards can be selected:

VM 3000 Control Electronics Unit
SI 3000 Serial Interface Unit

Pass
word      A password level can be entered for the output. This is described in detail below.

In Venus DM 400B data switching applications, the switcher output table is used to assign a logical name to each physical
port connected to a “controller” device. For more information, see page 5–48.

ENTERING OR EDITING OUTPUT NAMES AND NUMBERS

1. On the top of the Jupiter Configurator window (page 5–2), check to see whether the configuration set you want to
change is selected for editing.

In most cases, you will want to modify the set that is currently active; if so, you may want to copy the active set and
select the copy for editing. For more information, please see Copying a Configuration Set for Editing on page 5–10.

2. Click on “Jupiter” and “Switcher Input.” This will open a list of all existing Switcher Output tables (or open the table
if there is only one).

3. Click on the desired switcher input table name and “Edit.” Selecting the switcher name will bring up a table similar to
that shown on page 5–51.

4. Enter/edit the desired logical name and physical output numbers for this output. Guidelines for using the editor are found
on page 5–3. For information about password levels, please see page 5–53.

Important: Mars physical output numbers, when controlled by a Jupiter system, are not continuous. For
example, physical output numbers 8 through 15 are skipped. For more information, refer to the Cross-
point/Jupiter control section in the Mars manual.

Important: When adding new items to tables, add them at the end if possible. Changing row numbers on
the Switcher Output table will cause panels to control different outputs than those to which they had been
assigned.

Important:  Row numbers on Jupiter tables are used as the “logical” numbers for destinations. Changing
the row number of a destination (by inserting/deleting a new output in the middle of the table, for example)
will disrupt control of the system, requiring controller boards to be memory–cleared and reset (see “Clear-
ing Battery–Protected Memory” in Appendix B). One way to avoid this interruption is to add new outputs
at the end of tables.

Note: Some switchers (such as Concerto and Triton) use “1” as the first output connector number. In this
case, the physical output number for this connector, as entered on the table, is “0.” Connector “2” is physical
output number “1,” etc.
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5. To close the table, click OK.

6. Click on “File > Save” to save the table.

7. Select the next table for editing. When finished, validate, compile and activate the configuration set. (See page 5–13.)

SETTING PASSWORD LEVELS FOR SWITCHER OUTPUTS

In addition to individual Jupiter passwords assigned to each user, individual switcher outputs can be given a password level.
This can be used to  provide varying levels of protection from one switcher output to another.

Note 1: Party line panels always have a password level of zero. Do not assign a password level (other than zero)
to outputs that are to be controlled by an MCS 2000 Master Control switcher or any other party line control panel.
Doing so will cause the MCS 2000 or party line panel to lose control of the output. There is no need to set a
password level for the five outputs feeding the MCS since those outputs are automatically protected by the MCS
itself. No other control panel has access to those outputs.

Note 2: Output passwords are not honored by automation protocol handling.

 To change the password level for a switcher output:

1. On the top of the Jupiter Configurator window (page 5–2), check to see whether the configuration set you want to
change is selected for editing.

In most cases, you will want to modify the set that is currently active; if so, you may want to copy the active set and
select the copy for editing. For more information, please see Copying a Configuration Set for Editing on page 5–10.

2. Click on “Jupiter > Switcher output.” This will open a list of all existing Switcher Output tables (or open the table if
only one table exists).

3. Click on the desired Switcher Output table name and “OK.” This will open a table similar to that shown on page 5–51.

In this example, the password level column is blank, meaning that all outputs have a password level of zero. Therefore
all passwords presently assigned will allow changing the signal being sent to any output.

4. Double–click on the password box you want to change.

5. Enter the desired password level for this output.

Entering a level of “50” would mean that only passwords having levels of 50 or more could be used to enable selection
of an input for this output.

Guidelines for using the editor are found on page 5–3.

6. To close the table, click OK.
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7. Click on “File > Save” to save the table.

8. After saving your changes, validate, compile, and activate the configuration set.
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CP Level Set

1

CP Level Set — KXYZ–LVL

Mnemonic Level Break Switch

2

3

VID VIDEO (MAINROUT)

LEFT LEFT (MAINROUT)

RGHT RIGHT (MAINROUT)

4 TC TC (MAINROUT)

Figure 5–38.

Figure 5–39.

Password 5–17

Network Description 5–22
Serial Protocol 5–25

Switcher Description 5–31
Switcher Input 5–44
Switcher Output 5–51

Control Panel Sets
Level set 
Input set 5–58
Output set 5–76
Override set 5–98
Sequence set 5–101
Category set 5–103

MPK Devices 5–108

Machines 5–141
Protocol Dependent 5–144
Machine Control 5–148
Delegation Groups 5–161

TCS–1 Device Codes 5–168
Party Line 5–169

Status Display Header 5–172
VGA Status Display 5–173

Tally 5–174

Path Finding 5–196

Exclusion 5–210
Y Line 5–211

The CP Level Set table is used to assign levels to control panels. In most cases, control panels are allowed to control all levels,
but creating multiple CP Level Sets allows restricting control to certain levels. Level Sets are assigned to individual control
panels on the MPK Devices table (page 5–108).

Selecting “Control Panel Sets” on the configuration set table list (Figure 5–15 on page 5–20) will open a dialog similar to
that shown in Figure 5–38. This dialog can be used to create, open, copy, and delete Control Panel sets. A example of a com-
pleted CP Level Set table is shown in Figure 5–39.

When creating a name for a Jupiter set, it’s a good practice to use letters and numbers only. If you want to use punctuation
or special characters, check the list on page 5–7 before creating a name.

When creating a new set, you will asked for the set type: “CP 3000” (for four–character display panels), or “CP–3800” series
(for most eight–character display panels).
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Note 1:  For SD 3x and RP 1/2/3 UMD series status displays, DD production switchers, or external computer con-
trol, use set type “CP 3000.”

Note 2: For CP 328 panels, use set type “CP 3000” (even though the CP 328 can display eight characters).

Mnemonic      The Mnemonic column of this table is the source for the ID of each level that will appear on control panels
during input selection.

Level     The Level column determines the order in which the switcher levels will appear in the control panel
status display. Video is normally listed first. In the example shown in Figure 5–38, the order from left to right will be video,
left audio, right audio, and time code. The first level entered will also be the level statused where display space is limited;
e.g., video will be the level statused on the CP 3000 expansion panel. 

Note: For DD switcher applications, the video level feeding the DD must be entered in the first row; other entries
are not used.

The source for the switcher Level names is the Switcher Description table (page 5–31).

Break     Using the Break column, breakaway switching can be disabled on a level by level basis. Since the CP Level Set
can be assigned to individual control panels on the MPK Devices table (page 5–108), this can be used to restrict breakaway
switching to specific panels.

Switch      Using the Switch column, all switching can be disabled on a level by level basis; and, by  CP Level Set  assignment,
on an individual control panel basis. Status will continue to be shown for the level.
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A Note Concerning Level Numbering and External Control Computers Using ASCII Protocol

ASCII protocol switching instructions include specification of output, input, and level; with level indicated by a number from
1 to 7. These level numbers correspond to the order in which levels are listed on the CP Level Set table. In the example table
shown in Figure 5–39, the ASCII level numbers would apply to the switcher levels as follows:

Level number used Example level shown on 
with ASCII protocol  CP Level Set table (Fig.5–38 )

1 VIDEO
2 LEFT
3 RIGHT
4 T/C

Do not confuse these ASCII level numbers with the logical and physical level numbers of the switcher, which may be differ-
ent. (The level names on this table are translated to logical and physical level numbers on the Switcher Description table, as
shown on page 5–31.)

For more information about external computer control, see page 2–77.
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CP Input Set

Figure 5–40. CP Input Set (example showing new Auto Mnemonic column).

1

Input Set — KXYZ–INP

Category Entry Mnemonic Logical

2

3

Test 1 BARS BARS

VTR 1 VT01 VT014

5

Test 2 TONE TONE

Test 3 CODE TC

VTR 2 VT02 VT02

VTR 3 VT03 VT03

VTR 4 VT04 VT04

VTR 5 VT05 VT05

MISC 8 ESS ESS

6

7

8

n

Auto
Mnem Input

Password 5–17

Network Description 5–22
Serial Protocol 5–25

Switcher Description 5–31
Switcher Input 5–44
Switcher Output 5–51

Control Panel Sets
Level set 5–55
Input set 
Output set 5–76
Override set 5–98
Sequence set 5–101
Category set 5–103

MPK Devices 5–108

Machines 5–141
Protocol Dependent 5–144
Machine Control 5–148
Delegation Groups 5–161

TCS–1 Device Codes 5–168
Party Line 5–169

Status Display Header 5–172
VGA Status Display 5–173

Tally 5–174

Path Finding 5–196

Exclusion 5–210
Y Line 5–211

The CP Input Sets are used to link particular category / entry numbers, and mnemonics, to switcher input names. CP Input
Sets are also used to assign an input to each source button on CP 3832 and CP 3864 Control Panels.

� Categories are classes of inputs/outputs. The factory default category sets (as shown on pages 5–65 and 5–66) can
be used; or, custom category sets can be created.† Example: “TEST” as the category for all test signals. The cate-
gory is always followed by:

� An entry number. This defines the unit within the category. To continue the above example, after pressing “TEST,”
the operator presses the “1” key to switch to the color bar input. Note that the entry number is not the same as the
switcher input/output number.

� A mnemonic is an abbreviation, usually with a length of four characters, for a particular switcher input or output.
This is the abbreviation that appears in the status windows of the control panels. Example: “VT01” as a display
mnemonic for switcher input 001.

† If you want to create a custom category set, skip to CP Category Set (page 5–103) and then return to this subsection.
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In the example shown in Figure 5–41, selecting VTR/1 on a control panel will call for the input named “VT01.” The system
will look on the Switcher Inputs table for this input name and switch to the indicated inputs; in this case, input 001 for all four
levels. The mnemonic “VT01” will be used in the control panel status windows to report the switch.

Figure 5–41. Selection of Category/Entry “VTR/1” will
switch to input 001 on all four levels.

1

Input Set — KXYZ–INP

Category Entry Mnemonic Input

2

3

Test 1 BARS BARS

VTR 1 VT01 VT014

5

Test 2 TONE TONE

Test 3 TC TC

VTR 2 VT02 VT02

VTR 3 VT03 VT03

VTR 4 VT04 VT04

VTR 5 VT05 VT05

MISC 8 ESS ESS

6

7

8

n

1

Name

BARS

RIGHTVIDEO

2 TONE

3 TC

4 VT01

5 VT02

6

7

8

VT03

VT04

LEFT

000

001

002

003

004

VT05 005

000P

001

002

003

004

005

000P

001

002

003

004

005

000

000P

001

002

003

004

005

Switcher Input – MainRout

064I I

000I 000I 000I

TCLogical Input

Logical

The Input Sets are assigned to specific control panels on the MPK devices table (page 5–108).

Although each control panel can be assigned a different CP Input Set if desired, the same set is usually assigned to all panels.
Different Output Sets, on the other hand, are often used to control access to outputs on a panel–by–panel basis as described
on page 5–76.

In Venus DM 400B data switching applications, a CP Input Set is used to assign a category/number and mnemonic to each
“tributary” (such as a VTR). For more information, see page 5–48.
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PRIMARY (P) AND INDIRECT (I) STATUS INSTRUCTIONS (“SPLIT MNEMONICS”)

While the Switcher Inputs table has provision for only one mnemonic per input name (page 5–40), split switching requires
a different mnemonic for each device selected.

For example, the top portion of Figure 5–42 shows a four–level switcher with a black burst generator connected to input 64
of the video level, a test tone generator connected to input 0 of the audio levels, and a time code generator connected to input
0 of the time code level.

All of these devices are assigned to the single input name “TONE” on the Switcher Inputs table (as shown at �).

The input named TONE is in turn assigned to the command “TEST 2”  (this link is shown by the dotted line �). Without
further instructions, the mnemonic for all levels would be “TONE” (�). However, you might prefer to have “BLK” as a mne-
monic for video and “TC” as a mnemonic for the time code level.

To get the mnemonic “TC” on the time code level, an “I” (Indirect) suffix is entered back on the Switcher Inputs table at (�).
This tells the system to search that level for the “P” (Primary) suffix for that input. This is found at (�). This Primary entry
is associated with the input named “TC” (	), which in turn is linked to the mnemonic “TC” (
).

A similar technique is used to get the mnemonic “BLK” on the video level.

Note: There can be only one Primary entry per input number within one level of the Switcher Inputs table. How-
ever, within that level, any number of Indirect entries can point to the Primary entry.
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66

Switcher Input
Name VIDEO LEFT RIGHT TC

1 BARS 000 000I 000I 000I
2 TONE 064I 000P 000P 000I
3 TC 000P
4 VT01 001 001 001 001
5 VT02 002 002 002 002
6 VT03 003 003 003 003
7 VT04 004 004 004 004
8 VT05 005 005 005 005

BLK 064P 060I 060I

Switcher Input – MainRout

1 Test 1 BARS BARS
2 Test 2 TONE TONE
3 Test 3 TC TC
4 VTR 1 VT01 VT01
5 VTR 2 VT02 VT02
6 VTR 3 VT03 VT03
7 VTR 4 VT04 VT04
8 VTR 5 VT05 VT05

TEST 4 BLK BLK

Input Set — KXYZ–INP

Auto Logical
Category Entry Mnem Mnemonic   Input

�

�

�

�

�

	




62

Video

BLACK

63 65 0

Left
audio

TONE

1 2 3 464 0

Right
audio

TONE

1 2 3 4 0

Time
code

1 2 3 4

TIME CODE
GEN

Figure 5–42. Primary and indirect status instructions (see notes on page 5–60).
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ENTERING OR EDITING A CP INPUT SET

(Includes procedure for assigning category/numbers or mnemonics)

1. On the top of the Jupiter Configurator window (page 5–2), check to see whether the configuration set you want to
change is selected for editing.

For more information, please see Modifying and Downloading a System Configuration Set on page 5–8.

2. Click on “Jupiter,” “Control Panel Sets,” and “CP Input Set.” This will open a list of all existing CP Input Sets.

 Figure 5–43.  Select CP Input Set menu.

3. If you want to create a new set, click on “New,” and go to Step 4. Or, if you want to edit an existing set, click on the
name of the Input Set; then click “Open Table” and skip to Step 7.

You can also double–click on the name of an existing set to open the table.

If you want to copy an existing CP Input Set for use with a different panel type, you can probably save a lot of time by
following the procedure described on page 5–74.

4. If you are creating a new set, you will be asked to name the set.

Guidelines for using the editor are found on page 5–3.

Important:  Do not use the same name for different CP sets. Also, do not name a CP set with a name used
by the system for a Device Type. Device Type names are entered on the MPK Devices table (page 5–108).
Device Type names are shown on page 5–109.

5. If you want to assign this CP Input Set to a custom CP Category set (for a panel with re–legendable keycaps), enter the
custom CP Category set name. (If you wish to create a custom category set, skip to page 5–103 and then return to this
subsection.)



ConfiguratorCP Input Set

5–63VM 3000 Installation and Operating Manual

If you want to use a factory default category set (as shown on pages 5–65 and 5–66) leave the Category Set as “Default.”

If you wish to associate an existing Input Set with a different category set than the one originally assigned, see page 5–107.

6.  Click on one of the CP types:

cp2002B
cp3000
cp3008
cp3800
cp3808
cp3830
cp320
cp328
cp3310
cpsatrn†

emem
mc3020L
serial
umd3a
cp3824
cp3832

Figure 5–44. 

• If CP 2002, CP 3000, CP 3008, or CP 3800 is selected, clicking on “Apply” and “Open Table” will open a
blank version of the table shown in Figure 5–45. These are 20–category panels. Go to Step 9.

• If CP 320, CP 328, or CP 3808 is selected, clicking “Apply” and “Open Table” will open a blank version of
the table shown in Figure 5–45. These are 16–category panels. Go to Step 10.

• For CP 3030 panels, select type “CP 3000.” Clicking on “Apply” and “Open Table” will open a blank version
of the table shown in Figure 5–45. These are 20–category panels. Go to Step 9.

• If CP 3824 is selected, clicking on “Apply” and “Open Table” will open a blank version of the table shown in
Figure 5–45. This is a 15–category panel. Go to Step 10.

• For CP 3830 or CP 3830P panels, select type “CP 3830.” Clicking on “Apply” and “Open Table” will open a
blank version of the table shown in Figure 5–45. This is a 12–category panel. Go to Step 10.

• If MC 3020L is selected, click on “Apply” and “Open Table” and skip to Step 11.

• For SD–3x series status displays, select type CP 3000.

• For RP 1/2/3 UMD 3A status display, select type UMD3A.

† Not used. Saturn configuration instructions are described in the Saturn Master Control Switcher Installation and Operat-
ing Manual.
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• For Diamond DD applications, both “E–MEM” and “serial” tables will probably be required. Clicking on
“Apply” and “Open Table” will open a blank version of the table shown in Figure 5–45. For the E–MEM
table, skip to Step 12. For the serial table, skip to Step 13.

• For Grass Valley GVG–200 applications, select E–MEM. clicking on “Apply” and “Open Table” will open a
blank version of the table shown in Figure 5–45.  Go to Step 14.

• For Thomson Broadcast Automation or other external computer applications, a type “serial” table will be
required. Click on “Apply” and “Open Table” to open a blank version of the CP table without a “Mnemonic”
column. Skip to Step 15.

• For CP 3832 or CP 3864 control panels (including type “L”), a type “cp3832” table will be required. Click on
“Apply” and “Open Table” to open a blank version of the CP table. Then skip to Step 16.

7. If you click on an existing Input Set, this will call up a table similar to that shown in Figure 5–45.

Figure 5–45. Input Set menu (example).

1

Input Set — KXYZ–INP

Category Entry Mnemonic Input

2

3

Test 1 BARS BARS

VTR 1 VT01 VT014

5

Test 2 TONE TONE

Test 3 CODE TC

VTR 2 VT02 VT02

VTR 3 VT03 VT03

VTR 4 VT04 VT04

VTR 5 VT05 VT05

MISC 8 ESS ESS

6

7

8

n

Auto
Mnem

Logical

8. If you are:

— Adding a new entry, click on the row number above where you want the new entry to appear. Click the “Edit”
pull–down menu. Click on “Insert” and make the addition. Then go to Step 9 through 15 below as appropriate.

Important:  Row numbers on Jupiter tables are used as the “logical” numbers for destinations. Changing
the row number of a destination (by inserting/deleting a new output in the middle of the table, for example)
will disrupt control of the system, requiring controller boards to be memory–cleared and reset (see “Clear-
ing Battery–Protected Memory” in Appendix B). One way to avoid this interruption is to add new outputs
at the end of tables.

— Editing an existing entry, click on the item you want to change. Then go to Step 9 through 15 below as
appropriate.

9. CP 2002, CP 3000, CP 3008, CP 3030, CP 3800
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a. Select the desired Category from the pull–down menu. Then press TAB.

The 20–category factory default set used for CP 2002, CP 3000, CP 3008, CP 3030, and CP 3800 panels is as fol-
lows:

VTR CG NET SAT A
VCR CAM REM EJ** B
FILM PTCH STU FS C
AUX TEST MISC SS D **EMER on CP 3800

b. Specify the desired Entry (unit) number. This can be done by clicking on the desired “Entry” field and typing in
the number. Press ENTER.

Guidelines for using the editor are found on page 5–3.

Note: For an input that is heavily used, an entry number of zero can be specified to help speed up control
panel operation. For example, by assigning color bars as “Test 0,” the mnemonic for color bars will ap-
pear immediately on the control panels whenever “Test” is selected; the operator can then complete the
switch by pressing Take. However, for this to work properly the zero entry must appear in this table
before all other entries for that category; for example, “Test 0” must appear before “Test 1,” “Test 2,”
etc.

c. Select the Input name.

The source for the input names is the Switcher Input table (page 5–44).

d. Check the Auto Mnemonic box or enter the desired Mnemonic.

The Auto Mnemonic function can be used to enter a control panel mnemonic automatically based on the Name
given to the input. In cases where the input Name is more than four characters long, the mnemonic will be truncated
to the first four characters.

If an input Name is changed on the Switcher Input table and Auto Mnemonic is enabled, the mnemonic will change
to the new name automatically.

Note: if you use the Auto Mnemonic feature, it will not work if you go back to a version of the Jupiter
editor prior to 6.2.1.

Remember that a CP 3000 and CP 3030 panel can display four–character mnemonics, while the CP 3008 and CP
3800 can display eight–character mnemonics.

When finished, skip to Step 17.

10. CP 320, CP 328, CP 3808, CP 3824, CP 3830, CP 3830P

a. Enter the desired Category. This can be done by double–clicking on the appropriate field in the Category column;
this will open a pull–down menu of categories. Click on a category and press ENTER.
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The 16–category factory default set used for the CP 3808 panel is as follows:

Default sets may vary —
confirm by creating a new set!

VTR CAM SAT EJ
VCR NET REM FILM
Studio MISC AUX FS
CGEN TEST PTCH STILL

The 16–category factory default set used for CP 320 and CP 328 panels is as follows:

VTR CG NET VCR
CAM AUX EJ SS
REM FILM PTCH STU
TEST SAT FS MISC

The 15–category factory default set used for CP 3824 panel is as follows:

VTR CG NET VCR CAM
AUX SS REM FILM PTCH
STU TEST SAT FS MISC

The 12–category factory default set used for the CP 3830 and CP 3830P panels:

VTR GFX Studio
ENG REM NET
EC POST Xmsn
AUX TEST NUM

Guidelines for using the editor are found on page 5–3.

b. Specify the desired Entry (unit) number. This can be done by double–clicking on the desired “Entry” field and
typing in the number. Press ENTER.

Note: For an input that is heavily used, an entry number of zero can be used to help speed up control
panel operation. For more information, see the note in Step 9 (b) above.

c. Enter the desired Mnemonic.

A CP 320 panel can display four–character mnemonics; the CP 328, CP 3808, CP 3824, and CP 3830 can display
eight–characters.

d. Enter the Input name.

The input name will be a name already entered on the Switcher Input table (page 5–44).

When finished, go to Step 17.
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11. MC 3020L Linkage Panel

If you are entering a set for an MC 3020L Linkage Panel, a menu similar to that shown in Figure 5–46 will appear.

1

Input Set — LinkMach

Machine Name

VT01

2 VC01

3 VC02

4 VC03

Figure 5–46. CP Input Set used to establish machine names
for MC 3020L (example). The corresponding system is shown
on page 2–68.

This list is used to assign a machine to each key of the main MC 3020L panel (the panel with the extra pair of buttons).
The order of these entries will be the order of the buttons on the panel.

The name of the list is entered on the MPK devices table (page 5–118).

If you are:

— Creating a new table, select the name of the first machine from the pull–down menu. The source of these
names is the Machines table (page 5–141).

— Adding a new entry, click on the row number above where you want the new entry to appear. Click the “Edit”
pull–down menu. Click on “Insert.”

— Editing an existing entry, click on the item you want to change.

Additional guidelines for using the editor are found on page 5–3.

A similar procedure is used to enter control panel names for the MC 3020L expansion panel (page 5–87).

When finished, skip to Step 17.
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12. DD (“Diamond”) – E–MEM

For DD applications, both E–MEM and Serial tables will probably be required. The dual entries are necessary because
of the two hardware connections, as previously described (page 2–76).

For the E–MEM table, you will need entries similar to that shown in Figure 5–47.

� Data in this field is not used, but an entry must
be made to satisfy the Jupiter compiler. Each
number in this column must be unique.

Figure 5–47. Input Set menu (example).

1

Input Set — DIA–INP

Category Entry Mnemonic Input

2

3

dflt 1 BARS BARS

dflt 4 VT01 VT014

5

dflt 2 TONE TONE

dflt 3 TC TC

dflt 5 VT02 VT02

dflt 6 VT03 VT03

dflt 7 VT04 VT04

dflt 8 VT05 VT05

dflt n ESS ESS

6

7

8

n

�

�

�

�

�

�

�

�

�

Logical

a. For Category, the word “dflt” is used for all entries.

There are no category choices since the DD identifies inputs and outputs by number only.

b. Enter an Entry number. This can be done by double–clicking on the desired “Entry” field and typing the number.
Press ENTER.

Note: Data in this field is not used, but an entry must be made to satisfy the Jupiter compiler. Each num-
ber in this column must be unique.

c. Enter the desired Mnemonic for the first router input that will be available to the DD.

This is the source of the mnemonics that will appear on the DD. The DD can display four–character mnemonics.

d. Select the Input name of the first router input that will be available to the DD. The source of these names is the
Switcher Input table (page 5–44).

When a switch is made, Jupiter will search this table for the name of the new input. The corresponding mnemonic
will then be sent to the DD.

e. Enter the next Entry number, Mnemonic, and Input name, until you have entered all the inputs that you want avail-
able to the Diamond.

When finished, skip to Steps 17 and 18. Then return to Step 2 and following and build the DD serial table.
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13. DD (“Diamond”) – serial

For the Serial table, you will need entries similar to those shown in Figure 5–48.

Figure 5–48. Diamond Serial Input Set menu.

1

Input Set — ASC–INP

2 1

2

Entry

BARS

TONE

Input

3

3

TC

4

5 4

56

6

VT03

7

78 VT05

VT01

VT02

VT04

48 47 ESS

0

Logical

There are no category choices, since the DD identifies inputs and outputs by number only.

a. Specify the desired Entry (unit) number. This can be done by double–clicking on the desired “Entry” field and
typing the number. Press ENTER.

Each Entry number corresponds to a button on the DD Aux Bus. The buttons are numbered 0–47.

b. Select the name of the router Input that you want assigned to the first button on the DD Aux bus. The source of
these names is the Switcher Input table (page 5–44).

c. Enter the next Entry number and Input name, up to the maximum of 48 rows.

When finished, skip to Step 17.
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14. GVG 200 – E–MEM

If you are entering a set for GVG 200 E–MEM, you will need a table similar to that shown in Figure 5–49.

Figure 5–49. Input Set menu (example).1

Input Set — KXYZ–INP

Category Entry Mnemonic Input

dflt 0 BARS BARS

Logical

The entries on this table are not actually used, but the table must exist for the sake of having a set name on the MPK
devices table (page 5–131) in order to satisfy the compiler. Therefore, the table can consist of a single row with Category
“dflt,” Entry “0,” and the name of a valid input.

When finished, skip to Step 17.

15. Thomson Broadcast Automation / External Computer

If you are entering a set for serial control device, a menu similar to that shown in Figure 5–50 will appear.

Figure 5–50. Serial Input Set menu.

1

Input Set — PC–INP

2

1

2

Entry

CAM1

CAM2

Input

3 3 VTR1

Logical

The purpose of the table is to establish a unique “Entry” number for each switcher “Input” name. In Figure 5–50, Entry
number “1” is associated with Input name “CAM1.” The Entry number is the number that the serial control device must
send to Jupiter. When the Entry number arrives, the software checks this table to find the associated Input name; then
the Switcher Inputs table (page 5–44) is checked to find the corresponding physical input number.

Note:  For Thomson Broadcast Automation systems, it is suggested that you print out this Input Set; you
will need this information when setting up the Automation Switcher Initialization menu. The input names
entered on the Jupiter Input Set table must be in the same order as they are on the Automation table. Any
changes made to one table must also be made to the other.

When finished, skip to Step 17.



ConfiguratorCP Input Set

5–71VM 3000 Installation and Operating Manual

16. CP 3832 / CP 3864

If you are entering a set for CP 3832 or CP 3864 (including type “L”, a menu similar to that shown in Figure 5–51 will
appear. The purpose of the table is to assign a button position (row number) to each switcher “Input” name. In Figure
5–51, button position “1” will be used to select input “CAM1.” Note that destination buttons are defined on a CP Output
Set (page 5–76). Exact table entries will depend on the panel and the application, as shown in the following examples.

For Category, the word “default” is used for all entries.

Input button 1

CP 3832

Input button 32

Figure 5–51. Entries for CP 3832 configured as single–
bus panel.

1

CP Input Set – 3832–IN

default

2 default

1

2

Category Entry

CAM1

CAM2

Input

32 default 32 VTR12

CAM1

CAM2

Mnemonic

VTR12

†

†

†

Logical

Input button 1

CP 3832

Input button 16

IN
OUT

Figure 5–52. Entries for CP 3832 configured as “bal-
anced split” panel. Balanced number of input/output
buttons is determined by output assignments made on
the CP Output Set. For details, see page 5–92.

Category

1

CP Input Set – 3832–IN

default

2 default

1

2

Entry

CAM1

CAM2

Input

16 default 16 VTR12

CAM1

CAM2

Mnemonic

VTR12

†

†

†

Logical

Input button 1

CP 3832

Input button 30

IN

OUT

Figure 5–53. Entries for CP 3832 configured as 30 x 2
“unbalanced split” panel. Total number of input buttons
vs. total number of output buttons is determined by num-
ber of output assignments made on the CP Output Set.
For details, see page 5–92.

Category

1

CP Input Set – 3832–IN

default

2 default

1

2

Entry

CAM1

CAM2

Input

30 default 30 VTR12

CAM1

CAM2

Mnemonic

VTR12

†

†

†

Logical

† Data not used, but entry must be present to satisfy compiler. Each number in this column must be unique.
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Input button 1

Input button 64 Figure 5–54. Entries for CP 3864 operated as single–
bus panel.

1

CP Input Set – 3832–IN

default

2 default

1

2

Category Entry

CAM1

CAM2

Input

64 default 64 VTR12

CAM1

CAM2

Mnemonic

VTR12†

†

†

Logical

Input button 1

Input button 32

IN

UT

Figure 5–55. Entries for CP 3864 configured as 32 x 32
“balanced split” panel. Balanced number of input/output
buttons is determined by output assignments made on the
CP Output Set. For details, see page 5–92.

Category

1

CP Input Set – 3832–IN

default

2 default

1

2

Entry

CAM1

CAM2

Input

32 default 32 VTR12

CAM1

CAM2

Mnemonic

VTR12

†

†

†

Logical

Input button 1

Input button 54

IN

OUT

Figure 5–56. Entries for CP 3864 configured as 54 x 10
“unbalanced split” panel. Total number of input buttons
vs. total number of output buttons is determined by num-
ber of output assignments made on the CP Output Set.
For details, see page 5–92.

Category

1

CP Input Set – 3832–IN

default

2 default

1

2

Entry

CAM1

CAM2

Input

54 default 54 VTR12

CAM1

CAM2

Mnemonic

VTR12

†

†

†

Logical
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Figure 5–57. Entries for CP 3832 (configured as balanced split panel) with 2nd CP 3832 used as source expansion panel.

16 default 16 VTR12VTR12

17 default 17 VTR13VTR13

48 default 48 VCR12VCR12†

†

†

CP 3832 (configured as
balanced split panel)

Input button 1

Input button
17

Input button 16§Input button 48§

CP 3832

IN

OUT

default

default1

CP Input Set – 3832–IN

2

1

2

Category Entry

CAM1

CAM2

Input

CAM1

CAM2

Mnemonic

†

†

Logical

17. To close the table, click OK.

18. Click on “File > Save” to save the table.

The change will apply to all control panels that use the same Input Set. For the system shown on page 5–108, it would
affect all panels in the system since all of them use “KXYZ–INP” as the Input Set.

19. Select the next table for editing. When finished, validate, compile, and activate the configuration set. (See page 5–13
if you need more information.)

§ When two or more CP 3832 panels are used, button assignments are also determined by order of MPK table entries. See
page 5–134.

† Data not used, but entry must be present  to satisfy compiler. Each number in this column must be unique.
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Copying a CP Input or Output Set for Use with a Different Panel Type

After you have created a CP Input or Output Set for one panel type, you may want to copy it for use with a different panel.
For example, you may have a set for CP 3000 panels, and want to use it with a CP 320. You will need to re–enter some of
the category/number selections (because of the difference in the number of possible categories), but you can save time by
copying the set in order to use the same mnemonics and input names.

1. On the main menu, click on “Jupiter” and  “Control Panel Sets.” Then select  “Input” (or “Output”).  A menu similar
to Figure 5–58 will appear.

Figure 5–58.

2. Click on the name of the set you want to copy. Click on “Copy.”

3. Enter a name for the copy.

4. Select the desired CP Type.

5. If you want to use a factory default category set (as shown on pages 5–65 and 5–66), leave the Category Set Name box
as “Default.” If you want to use a custom category set, click on the Category Set Name box and enter the name of the
new Category Set. For more information about custom category sets, see page 5–103.

6. Click on “Apply.”

7. Open the new CP Input Set table and make the necessary changes, if any. (In this example, you would need to enter
different category/number selections because only 16 categories are available on the CP 320).

Note: If you convert a CP Input Set for use with a serial control device (such as an external computer), make
sure there is a unique number for every row in the “Entry”column. See Step 12 on page 5–68.
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CP Output Set

1

Output Set — MC–OUT

Category

STU

Entry

1

Mnemnonic

QC

Output

QC

Level Set Button

2

3

VTR 1 VT01 VT01

VTR 2 VT02 VT02

1

Output Set — NEWS–OUT

EJ 1 NEW1 NEW1

2

3

EJ 2 NEW2 NEW2

EJ 3 NEW3 NEW3

4 VTR 3 VT03 VT03

5

6

VTR 4 VT04 VT04

VTR 5 VT05 VT05

Figure 5–59. CP Output Sets (example showing new Auto Mnemonic column).

Auto
Mnem

Category Entry Mnemnonic Level Set ButtonAuto
Mnem

Logical

Output
Logical

Password 5–17

Network Description 5–22
Serial Protocol 5–25

Switcher Description 5–31
Switcher Input 5–44
Switcher Output 5–51

Control Panel Sets
Level set 5–55
Input set 5–58
Output set 
Override set 5–98
Sequence set 5–101
Category set 5–103

MPK Devices 5–108

Machines 5–141
Protocol Dependent 5–144
Machine Control 5–148
Delegation Groups 5–161

TCS–1 Device Codes 5–168
Party Line 5–169

Status Display Header 5–172
VGA Status Display 5–173

Tally 5–174

Path Finding 5–196

Exclusion 5–210
Y Line 5–211

OVERVIEW

Category Entry Mnemnonic Output     Links category/entry numbers and mnemonics to switcher outputs.

The Output Sets are assigned to specific control panels on the MPK devices table (page 5–108).

Important: Do not give an Output Set the same name as an output. Use of an extension such as “OUT” is recom-
mended to help avoid potential conflicts.

Since each control panel can be assigned a different CP Output Set if desired, these sets are usually used to control access
to outputs on a panel–by–panel basis:
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— You may want a control panel in the master control room to have access to all possible outputs. This panel
might be assigned to Output Set “MC–OUT,” which includes a category/number entry for all destinations.

— However, you may want a control panel in a particular department to have access to only a selected number of
outputs. This panel would be assigned to an Output Set (such as “NEWS–OUT”) which has only those outputs
listed.

Note: If you want the panel to be restricted to a single output, you could instead use the technique al-
ready described, whereby the name of the output, rather than the name of an Output Set, is entered on the
MPK Devices table. For more information, please see page 5–113.

In Venus DM 400B data switching applications, a CP Output Set is used to assign a category/number and mnemonic to each
“controller” (such as an editor). For more information, see page 5–48.

Level Set      For assigning a CP Level Set to individual outputs (multiple switcher installations)

The Level Set column is used when there are multiple switchers in the system and you want the control panels to control and
status more than one switcher. See page 5–96.

Button      For assigning expansion panel buttons to individual outputs

CP 3000/3010 – Outputs are normally assigned to the CP 3010 TAKE button dynamically by the operator (see page 6–24).
However, by entering an expansion button number from 1 to 160 (8 buttons x 20 pages) in the Button column and appropriate
row of the CP Output table (which is in turn assigned to the CP–3000 panel on the MPK devices table—page 5–108), the output
will be assigned permanently to the desired button. Such assignments cannot be changed using the panel itself.

Note:  If an output is permanently assigned to a CP 3010 button, but that output is later removed from the CP Output
table, and the new set downloaded, the CP 3010 will continue to display the name of the output until the output
is manually deleted. This is done by selecting an output that is not defined and pressing the appropriate TAKE key
on the expansion panel.

CP 3800 – When in Multiple Destination mode, CP 3800 outputs can be assigned to the soft keys dynamically by the operator
(see page 6–34). However, by entering a soft key button number from 1 to 80 (8 buttons x 10 pages) in the “Button” column
and appropriate row of the CP Output table (which is in turn assigned to this panel on the MPK devices table—page 5–108),
the output will be assigned permanently to the desired button. Such assignments cannot be changed using the panel itself.

CP 3809 – By entering a CP 3809 expansion panel button number from 1 to 40 (8 buttons x 5 panels max) in the Button column
and appropriate row of the CP Output table, the output will be assigned permanently to the desired button. Note that this CP
Output table must be assigned to the main panel (CP 3808 or CP 3830) on the MPK devices table—page 5–108. (Dynamic
assignment of outputs, using the front panel, is described on page 6–124. )

CP 3810 – By entering a CP 3810 expansion panel button number from 1 to 80 (8 buttons x 10 display “pages” max.) in the
Button column and appropriate row of the CP Output table, the output will be assigned permanently to the desired button.
Note that this CP Output table must be assigned to the main panel (such as a CP 3832 or CP 3864) on the MPK devices table.
See page 5–111.

CP 3832/3864 – although the CP 3832/3864 can be used to expand sources and destinations for another CP 3832/3864, these
panels do not use the “Button” column. Buttons are assigned to outputs by row number. See page 5–92.
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Copying a CP Output Set for Use with a Different Panel Type

After you have created a CP Output Set for one panel type, you may want to copy it for use with a different panel. For example,
you may have a set for CP 3000 panels, and want to use it with a CP 310. You will need to re–enter the category/number selec-
tions (because of the difference in the number of possible categories), but you can save time by copying the set in order to
use the same mnemonics and output names.

As another example, you may have a set for CP 320 panels (which can display four–character mnemonics) and want to use
it with a CP 328 (which can display eight–character mnemonics). You will need to re–enter the mnemonics, but you can save
time by copying the set in order to use the same category/numbers and output names.

The procedure is similar to that already described for a CP Input Set (see page 5–74).
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ENTERING OR EDITING A CP OUTPUT SET

(Includes procedure for assigning category/numbers or mnemonics)

1. On the top of the Jupiter Configurator window (page 5–2), check to see whether the configuration set you want to
change is selected for editing.

For more information, please see Modifying and Downloading a System Configuration Set on page 5–8.

2. Click on “Jupiter > Control Panel Sets,” then “Output.” This will open a list of all existing CP Output Sets.

Figure 5–60.  Select CP Input Set menu.

3. If you want to create a new set, click on “New” and go to Step 4. Or, if you want to edit an existing set, click on the name
of the Output Set, then click “Open Table” and skip to Step 7.

You can also double–click on the name of an existing set to open the table.

If you want to copy an existing CP Output Set for use with a different panel type, you can probably save a lot of time
by following the procedure described on page 5–74.

4. If you are creating a new set, you will be asked to name the set.

Note: When creating a name for a Jupiter set, table, control panel, or other device, it’s a good practice to use
letters and numbers only. If you want to use punctuation or special characters, check the list on page 5–7
before creating a name.

Important:  Do not use the same name for different CP sets. Also, do not name a CP set with a name used
by the system for a Device Type. Device Type names are entered on the MPK Devices table (page 5–108).
Device Type names are shown on page 5–109.

5. If you want to assign this CP Output Set to a custom CP Category set (for a panel with re–legendable keycaps), enter
the custom CP Category set name. (If you wish to create a custom category set, skip to page 5–103 and then return to
this subsection.)
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If you want to use a factory default category set (as shown on pages 5–82 and 5–83), leave the Category Set as “Default.”

If you wish to associate an existing Output Set with a different category set than the one originally assigned, see page
5–107.

6. Click on one of the CP types:

cp2002B
cp3000
cp3008
cp3800
cp3808
cp3830
cp310
cp320
cp328
cp3310
cpsatrn†

emem
mc3020D
mc3020L
serial
umd3a
cp3824
cp3832

Create Output Set

Figure 5–61. .

• If CP 2002B, CP 3000, CP 3008, or CP 3800 is selected, clicking on “Apply” and “Open Table” will open up
a blank version of the table shown in Figure 5–62. These are 20–category panels. Press the INSERT button to
start building the table. Then skip to Step 9.

• For CP 3030 panels, select type “CP 3000.” Clicking on “Apply” and “Open Table” will open a blank version
of the table shown in Figure 5–62. These are 20–category panels. Press the INSERT button to start building
the table. Then skip to Step 9.

• CP 3809 and CP 3810 expansion panels do not have a separate CP Output Set. They use the Output Set as-
signed to the main panel associated with them.

• If CP 320, CP 328, or CP 3808 is selected, clicking “Apply” and “Open Table” will open a blank version of
the table shown in Figure 5–62 . These are 16–category panels. Press the INSERT button to start building the
table. Then skip to Step 10.

• If CP 3824 is selected, clicking “Apply” and “Open Table” will open a blank version of the table shown in
Figure 5–62 . This is a 15–category panel. Press the INSERT button to start building the table. Then skip to
Step 10.

• For CP 3830 or CP 3830P panels, select type “CP 3830.” Clicking on “Apply” and “Open Table” will open a
blank version of the table shown in Figure 5–62. These are 12–category panels. Press the INSERT button to
start building the table. Then skip to Step 10.

† Not used. Saturn configuration instructions are described in the Saturn Master Control Switcher Installation and Operat-
ing Manual.
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• If CP 310 is selected, clicking on “Apply” and “Open Table” will open a blank version of the table shown in
Figure 5–62. This panel does not use categories or mnemonics, but the table is used to assign the panel’s eight
outputs. Press the INSERT button to start building the table. Then skip to Step 11.

• For CP 330 panels operated in dual bus mode, select type “CP 3000.” This panel does not use categories or
mnemonics, but the table is used to assign the panel’s two outputs. Press the INSERT button to start building
the table. Then skip to Step 12.

• If MC 3020D is selected, click on “Edit” to bring up a blank version of the table shown in Figure 5–62. Then
skip to Step 13.

• If MC 3020L is selected, click on “Edit” to bring up a blank version of the table shown in Figure 5–62. Then
skip to Step 14.

• For SD 3x series status displays (when used with master control and/or production switchers) select type CP
3000.

• For RP 1/2/3 UMD 3A status displays (when used with master control and/or production switchers) select
type UMD3A.

• For DD switcher applications, both E–MEM and serial tables will probably be required. Clicking on “Ap-
ply” and “Open Table” will open a blank version of the table shown in Figure 5–62. For the E–MEM table,
skip to Step 15. For the serial table, skip to Step 16.

• For Grass Valley GVG–200 applications, select E–MEM. Clicking on “Apply” and “Open Table” will open
a blank version of the table shown in Figure 5–62.  Press the INSERT button to start building the table. Then
skip to Step 17.

• For Thomson Broadcast Automation or other external computer applications, a type “serial” table will be
required. Click on “Edit” to bring up a blank version of the CP table without a “Mnemonic” column. Press the
INSERT button to start building the table. Then skip to Step 18.

• For CP 3832/3864 panels controlling more than one output, or CP 3810L control panels, a type “cp3832”
table will be required. Click on “Edit” to bring up a blank version of the CP table. Press the INSERT button to
start building the table. Then skip to Step 19.

7. Clicking on an existing Output Set will open a table similar to that shown in Figure 5–62.

Figure 5–62. Output
Set table (example).

1

Output Set — MC–OUT

Category

STU

Entry

1

Mnemnonic

QC

Output

QC

Level Set Button

2

3

VTR 1 VT01 VT01

VTR 2 VT02 VT02

4 VTR 3 VT03 VT03

5

6

VTR 4 VT04 VT04

VTR 5 VT05 VT05

Auto
Mnem

Logical
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8. If you are:

— adding a new entry, click on the row number above where you want the new entry to appear. Click the “Edit”
pull–down menu. Click on “Insert” and make the addition. Then go to Steps 9 through 18 below as appropri-
ate.

Important:  Row numbers on Jupiter tables are used as the “logical” numbers for destinations. Changing
the row number of a destination (by inserting/deleting a new output in the middle of the table, for example)
will disrupt control of the system, requiring controller boards to be memory–cleared and reset (see “Clear-
ing Battery–Protected Memory” in Appendix B). One way to avoid this interruption is to add new outputs
at the end of tables.

— editing an existing entry, double–click on the item you want to change. Then go to Steps 9 through 18 below as
appropriate.

9. CP 2002, CP 3000, CP 3008, CP3030, CP 3800

a. Select the desired Category from the pull–down menu.

The 20–category factory default set used for CP 2002, CP 3000, CP 3008, CP3030, and CP 3800 panels is as fol-
lows:

VTR CG NET SAT A
VCR CAM REM EJ** B
FILM PTCH STU FS C
AUX TEST MISC SS D **EMER on CP 3800

b. Specify the desired Entry (unit) number. This can be done by double–clicking on the desired “Entry” field and
typing in the number. Press TAB.

Guidelines for using the editor are found on page 5–3.

c. Select an Output name from the pull–down menu.

The source for these names is the Switcher Output table (page 5–51).

d. Check the Auto Mnemonic box or enter the desired Mnemonic.

The Auto Mnemonic function can be used to enter a control panel mnemonic automatically based on the Name
given to the output. In cases where the output Name is more than four characters long, the mnemonic will be trun-
cated to the first four characters.

If an Output Name is changed on the Switcher Output table and Auto Mnemonic is enabled, the mnemonic will
change to the new name automatically.

Note: if you use the Auto Mnemonic feature, it will not work if you go back to a version of the Jupiter
editor prior to 6.2.1.
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Remember that a CP 3000 and CP 3030 panel can display four–character mnemonics, while the CP 3008, and CP
3800 can display eight–character mnemonics.

e. Optionally, select a Level Set name.

The Level Set column should be used when multiple switchers are in the system and you want the control panels
to control and status more than one switcher. See page 5–97.

The source of these names is the CP Level Set tables (page 5–55).

f. Optionally, enter a Button number. This is used to assign Expansion Panel buttons to individual outputs:

CP 3010 Expansion Panel –  Outputs are normally assigned to the CP 3010 TAKE button dynamically, by the
operator (see page 6–24). However, by entering an expansion button number from 1 to 160 (8 buttons x 20 pages)
in the Button column, the output will be assigned permanently to the desired button. Such assignments cannot be
changed using the panel itself.

Note: If an output is permanently assigned to a CP 3010 button, but that output is later removed from the
CP Output table and the new set downloaded, the CP 3010 will continue to display the name of the out-
put until the output is manually deleted. This is done by selecting an output that is not defined and press-
ing the appropriate TAKE key on the expansion panel.

CP 3800 – When in Multiple Destination mode, CP 3800 outputs can be assigned to the soft keys dynamically,
by the operator (see page 6–34). However, by entering a soft key button number from 1 to 80 (8 buttons x 10 pages)
in the “Button” column the output will be assigned permanently to the desired button. Such assignments cannot
be changed using the panel itself.

CP 3810 Expansion Panel –  By entering an expansion button number from 1 to 80 (8 buttons x 10 pages) in the
Button column, the output will be assigned permanently to the desired button.

When finished, skip to Step 20.

10. CP 320, CP 328, CP 3808, CP 3830, CP 3830P

a. Enter the desired Category. This can be done by double–clicking on the appropriate field in the Category column;
this will open a pull–down menu of categories. Click on a category and press ENTER.

The 16–category factory default set used for the CP 3808 panel is as follows:

Default sets may vary —
confirm by creating a new set!

VTR CAM SAT EJ
VCR NET REM FILM
Studio MISC AUX FS
CGEN TEST PTCH STILL

The 16–category factory default set used for CP 320 and CP 328 panels is as follows:

VTR CG NET VCR
CAM AUX EJ SS
REM FILM PTCH STU
TEST SAT FS MISC
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The 15–category factory default set used for CP 3824 panel is as follows:

VTR CG NET VCR CAM
AUX SS REM FILM PTCH
STU TEST SAT FS MISC

The 12–category factory default set used for the CP 3830 and CP 3830P panels is as follows:

VTR GFX Studio
ENG REM NET
EC POST Xmsn
AUX TEST NUM

Guidelines for using the editor are found on page 5–3.

b. Specify the desired Entry (unit) number. This can be done by double–clicking on the desired “Entry” field and
typing the number. Press ENTER.

c. Select the Output name.

The source of these names is the Switcher Output table (page 5–51).

Note 1 The CP 3830P controls two outputs, a “Current” output and a “Preview” output; both of these
outputs can be selected at the front panel at any time (as described on page 6–89). Once selected, these
outputs will remain in effect until changed by the operator or PMEM is cleared.

Note 2: At startup, the two outputs controlled by a CP 3830P will be the first two entries in the compiled
CP Output Set. During compile, the system will refer to the CP Category set that applies to the CP
3830P; typically this will be the 12–category default set shown on page 5–83. Since the first category is
“VTR,” the system will check for the first CP Output Set entry in that category; this will be the first entry
in the compiled table and therefore the default Current output. The second entry in the VTR category
will be the default Preview output, etc. 

d. Check the Auto Mnemonic box or enter the desired Mnemonic.

The Auto Mnemonic function can be used to enter a control panel mnemonic automatically based on the Name
given to the output. In cases where the output Name is more than four characters long, the mnemonic will be trun-
cated to the first four characters.

If an Output Name is changed on the Switcher Output table and Auto Mnemonic is enabled, the mnemonic will
change to the new name automatically.

Note: if you use the Auto Mnemonic feature, it will not work if you go back to a version of the Jupiter
editor prior to 6.2.1.

A CP 320 panel can display four–character mnemonics; the CP 328, CP 3808, and CP 3830 can display eight–char-
acters.
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e. Optionally, enter the Level Set name.

The Level Set column should be used when multiple switchers are in the system and you want the control panels
to control and status more than one switcher. See page 5–97.

f. Optionally, enter a Button number.

By entering a CP 3809 Expansion Panel button number from 1 to 40 (8 buttons x 5 panels max) in the Button
column and appropriate row of the CP Output table, the output will be assigned permanently to the desired button.
Note that this CP Output table must be assigned to the main panel (CP 3808 or CP 3830) on the MPK Devices
table—page 5–108. (Dynamic assignment of outputs, using the front panel, is described on page 6–124.)

When finished, go to Step 20.

11. CP 310 24 x 8 Eight–Bus Control Panel

For the eight–bus CP 310 control panel, a special CP Output Set is used to identify the eight outputs that will be con-
trolled by the panel. This set is assigned to the specific CP 310 with the MPK devices table. In this case, there must still
be an entry in each field of the CP Output Set table, even though the only data that will be used is in the Output column.
The category name “dflt” is used throughout, but selection numbers and at least one character for a mnemonic will have
to be entered on each of the eight rows in order to satisfy the system compiler.

When finished, skip to Step 20.

12. CP 330 operating in dual bus mode

For the dual–bus CP 330 control panel, a special CP Output Set is used to identify the two outputs that will be controlled
by the panel. This set is assigned to the specific CP 330 with the MPK Devices table. The only data that will be used
is in the Output column; however, category names, selection numbers, and at least one character for a mnemonic will
have to be entered on both rows in order to satisfy the system compiler.

When finished, skip to Step 20.

13. MC 3020D Delegate Panel

The content of these tables will depend on whether an MC 3020D is assigned to each machine; or, whether a single MC
3020 equipped with expansion panel(s), located in a central control panel cluster, is used to delegate up to 80 machines.

Panel–per–machine. When a separate MC 3020D is located next to each machine, a separate Output Set is created for
each panel. Each Output Set lists the name of the associated machine (Figure 5–63). The name of each MC 3020D Out-
put Set is then entered on the MPK Devices table (Figure 5–144 on page 5–164).

1

Output Set — VT01–OUT

Machine Name

VT01

2

Figure 5–63. CP Output Set used to establish a machine
name for panel–per–machine MC 3020D (example). The
corresponding system is shown on page 5–163.
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Central control arrangement. In this application, the MC 3020D Output Set is actually a list of machines and is used
to assign each machine to a particular button of the CP 3021D Expansion Panel (Figure 5–64). The name of the MC
3020D Output Set is then entered on the MPK Devices table (Figure 5–144 on page 5–164). The order of entry on the
Output Set table will correspond to the order of buttons on the CP 3021. For example, the machine listed in row 1 of
the table will be assigned to the first button of the first expansion panel (the first expansion panel on the ribbon wire).

1

Output Set — MC3020D–OUT

Machine Name

VT01

2 VC01

3 VC02

Figure 5–64. CP Output Set used to establish machine names
for centrally–located MC 3021D (example). The correspond-
ing system is shown on page 5–163. See also page 2–71.

The source of these names is the Machines table (page 5–141).
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14. MC 3020L Linkage Panel

This applies to an MC 3020L, where the main panel is used to select one of 20 machines and the CP 3021 Expansion
Panel is used to link the machine to a button group of a control panel.

The Output Set is used to assign each MC 3020L expansion panel button to the corresponding button of the indicated
machine control panel.  The name of the MC 3020L Output Set is then entered on the MPK Devices table (page 5–118).
The source of these names is the MPK Devices table (page 5–108).

1

Output Set — LinkPanl

Control Panel Name

TAPEMC

2 TAPEMC

3 TAPEMC

4 TAPEMC

5 TMC3010

6 TMC3010

7 TMC3010

8 TMC3010

Figure 5–65. CP Output Set used to establish button assign-
ments for MC 3020L and MC 3000/3010 panels (example).
Corresponding system is shown on page 2–68.

Lock
VT
01

VC
01

VC
02

VC
03

Tape
MC1

TMC
1

Tape
MC2

Tape
MC3

Tape
MC4

TMC
2

TMC
3

TMC
4

Unlink

“TAPEMC”

“TMC3010”

Figure 2–139. Button assignments corresponding
to tables shown in Figure 5–65 and on page 5–67.

When finished, skip to Step 20.
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15. DD (“Diamond”) – E–MEM

For DD applications, both E–MEM and Serial tables will probably be required. The dual entries are necessary because
of the two hardware connections, as previously described (page 2–76).

For the  E–MEM table, you will need entries similar to that shown in Figure 5–66.

1

Output Set — DIA–OUT

dflt 1 DD01

2

3

dflt 2 DD02

dflt 3 DD03

4 dflt 4 DD04

5

6

dflt 5 DD05

dflt 6 DD06

128 dflt 128 DD128

Figure 5–66. Output Set table
(example).

Category Entry Mnemnonic Output Level Set Button
Logical

a. For Category, the word “dflt” is used for all entries.

b. Specify the desired Entry number. This can be done by double–clicking on the desired “Entry” field and typing
the number. Press ENTER.

Note: These Entry numbers must match the numbers assigned to the buttons on the DD M/E Bus, using
the DD “Install > Ident Input >  Ident Xbar” menu. Each DD button that is fed from the router should
be assigned an Entry number from 1 to 128. Refer to the DD installation manual for information about
the DD serial ports and operating instructions.

c. Enter the name of the first router Output wired to the DD. The source of these names is the Switcher Output table
(page 5–51).

d. Enter the next Entry number and Output name, up to the maximum of 128 rows.

When finished, skip to Steps 20 and 21.  Then return to Step 2 and build the DD serial table.
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16. DD (“Diamond”) – serial

For the Serial table, you will need entries similar to those shown in Figure 5–67.

Figure 5–67. Serial Input Set menu.

1

Output Set – ASC–OUT

2 2

3

Entry

DD01

DD02

Output

3

4

DD03

4

5 5

66 DD06

DD04

DD05

1

Logical

a. Specify the desired Entry (unit) number.

Note: These Entry numbers must match the numbers assigned to the six buttons of the DD Delegation
Bus, using the DD “Install > Extern Aux > Config” menu. As a convention, these buttons are assigned
Entry numbers from 1 to 6. This will allow the DD operator to control up to six router outputs (these
router outputs are wired into the DD as inputs). Refer to the DD installation manual for information
about the DD serial ports and operating instructions.

b. Enter the name of the first router Output that is wired to the DD. The source of these names is the Switcher Output
table (page 5–51).

c. Enter the next Entry number and Output name, up to the maximum of 128 rows.

When finished, skip to Step 20.
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17. GVG 200 – E–MEM

For Grass Valley E–MEM applications, a special CP Output Set is used to list the outputs of the routing switcher that
are used as inputs to the production switcher. The Jupiter system can be told to take a snapshot of these outputs and
restore them at a later time (see page 2–81).

If you are entering a set for GVG 200 E–MEM, you will need a table similar to that shown in Figure 5–68.

1

Output Set – GVG–OUT

dflt

2 dflt

1

2

Category Entry

GV01

GV02

Output

3 dflt 3 GV03

4 dflt

5 dflt

4

5

6 dflt 6 GV06

7 dflt 7

8 dflt 8 GV08

GV04

GV05

GV07

n dflt n GVNN Figure 5–68. Output Set table (example).

Logical

For Category, the word “dflt” is used for all entries.

The Entry number is used by the Grass Valley switcher to refer to a routing switcher output shown in the Output column.
In this example, Entry No. 1 has been assigned to the routing switcher output named “GV01.” The source of the Output
names is the Switcher Output table (page 5–51).

When finished, skip to Step 20.
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18. Thomson Broadcast Automation / External Computer

If you are entering a set for a serial control device, you will need a table similar to that shown in Figure 5–69.

Figure 5–69. Serial Output Set table.

1

Output Set – ALAM–OUT

2 2

3

Entry

QC

VT01

Output

3

4

VT02

4

5 5

66 VTO5

VT03

VT04

1

7 7

88 VTO7

VT06

nn VTnn

Logical

The purpose of the table is to establish a unique “Entry” number for each switcher “Output” name. In Figure 5–69, Entry
number “1” is associated with Output name “QC.” The Entry number is the number that the serial control device must
send to Jupiter. When the Entry number arrives, the software checks this table to find the associated Output name; then
the Switcher Outputs table (page 5–51) is checked to find the corresponding physical Output number.

Note: For Thomson Broadcast Automation systems, it is suggested that you print out this Output Set; you
will need this information when setting up the Automation Switcher Initialization menu. The Output names
entered on the Jupiter Output Set table must be in the same order as they are on the Automation table. Any
changes made to one table must also be made to the other.

When finished, skip to Step 20.
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19. CP 3832 / CP 3864 / CP 3810

Note: For CP 3832/64 panels, this table is only needed when more than one output is to be controlled.

If you are entering a set for CP 3832 or CP 3864, a menu similar to that shown in Figure 5–70 will appear. The purpose
of the table is to assign a button position (row number) to each switcher “Output” name. Exact table entries will depend
on the panel and the application, as shown in the following examples. Note that source buttons are defined on a CP Input
Set (page 5–71). 

For Category, the word “default” is used for all entries.

� Split mode. Split mode operation is determined by the checkmark in the Expansion box in the MPK table
(page 5–110). In this application, some buttons are used for inputs and some for outputs. If the number of in-
puts and outputs is the same, the split is “balanced” and the panel can be used with expansion panels. See
Figures 5–70 and 5–71.

1

Output Set — 3832–OUT

default 1 MONITOR1 MON1

2 default 2 MONITOR2 MON2

16 default 16 VTR–4 VTR4

Output button 1

CP–3832

Output button 16

IN

OUT

†

†

†

Figure 5–70. Entries for CP 3832
configured as “balanced split” panel.

Category Entry Mnemnonic Output Lev Set ButtonLogical

Output button 1

CP–3864

Output button 32

IN

OUT

Figure 5–71. Entries for CP 3864
configured as “balanced split” panel.

1

Output Set — 3832–OUT

default 1 MONITOR1 MON1

2 default 2 MONITOR2 MON2

32 default 32 VTR–12 VT12†

†

†

Category Entry Mnemnonic Output Lev Set Button
Logical

† Data not used, but entry must be present  to satisfy compiler. Each number in this column must be unique.
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A split panel can also be configured with a different number of inputs and outputs (“unbalanced split”), but such
panels cannot be expanded. In this application, the number of outputs can be from 1 to 15 (CP 3832) or 1 to 31
(CP 3864). Buttons not assigned to outputs are available for inputs. For example, if two buttons are used for out-
puts, then 30 buttons will be available for inputs on a CP 3832 panel. See Figures 5–72 and 5–73.

Output
button 1

CP–3832

Output
button 2

IN

OUT

†

†

Figure 5–72. Entries for CP 3832 configured as 30 x 2 “unbalanced split” panel.

1

Output Set — 3832–OUT

default 1 MONITOR1 MON1

2 default 2 MONITOR2 MON2

Category Entry Mnemnonic Output Lev Set Button
Logical

Output
button 1

CP–3864

Output
button 10

IN

OUT

†

†

†

Figure 5–73. Entries for CP 3864 configured as 54 x 10 “unbalanced split” panel.

1

Output Set — 3832–OUT

default 1 MONITOR1 MON1

2 default 2 MONITOR2 MON2

10 default 10 VTR–12 VT12

Category Entry Mnemnonic Output Lev Set Button
Logical
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� Expansion mode. Unless the panel is operated in “unbalanced split” mode, control of additional outputs is
possible using adjacent CP 3832 or CP 3864 panels. See Figure 5–74.

1

Output Set — 3832–OUT

default 1 MONITOR1 MON1

2 default 2 MONITOR2 MON2

64 default 64 VTR–12 VT12

96 default 96 AUX–12 AX12

65 default 65 VTR–13 VT13†

†

†

†

†

CP 3864

Output button 1

Output button 65§

Output button 64

Output button 96§

CP 3832

CP 3832IN

OUT

Figure 5–74. Entries for CP 3864 used for destinations and CP 3832 used as
destination expansion panel.

Category Entry Mnemnonic Output Lev Set Button
Logical

§ When two or more CP 3832/3864 panels are used, button assignments are also determined by order of MPK table entries.
See page 5–134.

† Data not used, but entry must be present  to satisfy compiler. Each number in this column must be unique.
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The CP 3832/64 can be also be operated in connection with an adjacent CP 3810 Expansion Panel. See Figure
5–75.

CP 3832
(Main panel)

CP 3810

1

Output Set — 3832–OUT

1 MONITOR1 MON1 1

2 2 MONITOR2 MON2 2

8 8 VTR–4 VTR4 8

9 9 VTR–5 VTR5 9

PAGE
1

PAGE
2

16 16 VTR–12 VTR12 16

Up to
page 10

†

†

†

†

†

default

default

default

default

default

Figure 5–75. Entries for CP
3810  used as multi–destination
panel. Set is assigned to main
panel on MPK Devices table.

Entry Mnemnonic Output Lev Set ButtonCategory
Logical

20. To close the table, click on “OK.”

21. Click on “File > Save” to save the set.

The change will apply to all control panels that use the same Output Set. For the system shown on page 5–108, it would
affect all panels in the system since all of them use “KXYZ–OUT” as the Output Set.

22. Validate, compile, and activate the new configuration set. For more information, refer to page 5–13.

† Data not used, but entry must be present  to satisfy compiler. Each number in this column must be unique.
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Multiple Switcher Installations

Please refer to Figure 5–76 for the following discussion.

When more than one switcher is in the system, and you want to operate the switchers from one control panel, there must be

a separate CP Level Set for each switcher (� and �). This is because the CP Level Set is used to determine how status will
be shown on the panel; specifically, the first entry on the CP Level Set will be the level that is statused. In this example, video
will be statused.

The CP Output Set is used to assign an individual output to a CP Level Set for the appropriate switcher (�). In this example,
all outputs of the  “NewsRout”switcher would be assigned to the CP Level Set named “2000–LEV.”

Similarly, all outputs of the “MainRout” switcher could be assigned to a CP Level Set on an output–by–output basis, but in
this example the Lev Set entry is blank. With no entry, the system will refer back to the MPK Devices table to locate the default
CP Level Set—in this case, “KXYZ–LEV” (�). Thus the “KXYZ–LEV” table will be used to establish  “MainRout” status
(�).
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Figure 5–76. CP Output Set and CP Level Set requirements for multiple switcher installations. See page 5–96 for discussion.

VT01

 Cam9 Cam1
 VT20 VT01

CAM1

CP 3000/E
“STUCP”

VT20

CAM9

VM 3000

TVS/TAS 2000
“NEWSROUT”

Venus
“MAINROUT”

  MPK Device
Devices   Type Exp Pw Mode Board Port Address In Set In Panel Out Set Out Panel Lev Set Over Set Seq Set

1 STUCP CP–3000 L S1 10 00000014 KXYZ–INP KXYZ–OUT KXYZ–LEV KXYZ–OVE

MPK Devices

Level Set — KXYZ–LEV

1 VID VIDEO (MAINROUT)
2 LEFT LEFT (MAINROUT)
3 RGHT RIGHT (MAINROUT)

Mnemonic Level Break Switch

Output Set — KXYZ–OUT

1 VTR 1 VT01 VT01 [BLANK]
2 VTR 2 VT02 VT02 [BLANK]

VCR 20 VT20 VT20 2000–LEV
VCR 21 VT21 VT21 2000–LEV

 Auto Logical
Category Entry Mnem Mnemonic Output Level Set Button

Level Set — 2000–LEV

1 VID VIDEO (NEWSROUT)
2 LEFT LEFT (NEWSROUT)
3 RGHT RIGHT (NEWSROUT)

Mnemonic Level Break Switch

Status

Output

� �

�

�

VM 3000

VM 3000
“’VM1”
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CP Override Set

The override function, which allows single–keystroke selection of a source, is used for a quick or emergency switch to an
often–used input. For example, the black burst generator could be defined as the first “override” source for the system, corre-
sponding to the first soft key position on a CP 3000 or CP 3800 panel. When in a hurry to find black burst, the operator can
then press BLK, TAKE (instead of, for instance, TEST, 1, TAKE).

Override sets are also used to assign an input to each button on CP 300, CP 310, CP 330, and CP 3020 Push Button Control
Panels, and to the button–per–source keys on CP 3824 and FCS 3360§ panels.

The overrides can be permanently assigned with the file server (as described immediately below), and, if desired, temporarily
edited at CP 3000 control panels (as described on page 6–21). Overrides can also be temporarily edited at CP 3800 panels
(as described on page 6–54) and CP 3824 panels (page 6–85).

The order in which the overrides are listed on this table will be the order in which they appear on the panels.

Figure 5–77. CP override set (example).

1

CP Override Set — KXYZ–OVE

Override

BLK

Input

BLK

Edit Levels

YYYY

2

3

4

5

6

BARS BARS YYYY

TONE TONE YYYY

SLNC SLNC YYYY

Usr1 BLK YYYY

Usr2 BLK YYYY

...

...

...

...

...

...

Logical

Password 5–17

Network Description 5–22
Serial Protocol 5–25

Switcher Description 5–31
Switcher Input 5–44
Switcher Output 5–51

Control Panel Sets
Level set 5–55
Input set 5–58
Output set 5–76
Override set 
Sequence set 5–101
Category set 5–103

MPK Devices 5–108

Machines 5–141
Protocol Dependent 5–144
Machine Control 5–148
Delegation Groups 5–161

TCS–1 Device Codes 5–168
Party Line 5–169

Status Display Header 5–172
VGA Status Display 5–173

Tally 5–174

Path Finding 5–196

Exclusion 5–210
Y Line 5–211

§ The FCS 3360 is described in a separate manual, part no. 04–883360–002.
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DEFINING OVERRIDES

1. On the top of the Jupiter Configurator window (page 5–2), check to see whether the configuration set you want to
change is selected for editing.

For more information, please see Modifying and Downloading a System Configuration Set on page 5–8.

2. Click on “Jupiter > Control Panel Sets,” then “CP Override set.” This will display a list of all existing CP Override sets.

Select Override Set

Figure 5–78. Override edit set menu (example).

The menu lists all override sets in the configuration set presently selected for editing.

3. If you want to create a new set, click on “New,” and go to Step 4.  Or, if you want to edit an existing set, click on the
name of the Output Set; then click “Apply” and “Open Table” and skip to Step 6.

4. If you are creating a new set, you will be asked for a set name.

Note: Do not use the same name for different CP sets. Also, do not name a CP set with a name used by the
system for a Device Type. Device Type names are shown on page 5–109.

5. Click on one of the CP types. Select “cp3000” for all panels except the CP 3008, CP 3800, and CP 3824. Clicking on
“Apply” and “Open Table” will bring up a blank version of the table shown in Figure 5–77. Skip to Step 7.

Because they can display eight–character mnemonics, the CP 3008, CP 3800, and CP 3824 all use type “cp3800” over-
ride sets.

6. If you click on an existing Input Set, this will open a table similar to that shown in Figure 5–77.

7. If the panel being configured is a CP 3000, CP 3008, CP 3800, or CP 3824, click on the “Override” field and create a
name for the first override button. This is the name that will appear in the panel’s display window during override mode.
For all other panels, no entry in the “Override” column is required.
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Guidelines for using the editor are found on page 5–3.

8. In the “Input” column, select the name of the switcher input for the first override button.

The source of these names is the Switcher Input table (page 5–44).

Although the CP 3824 has only 24 button–per–input keys, up to 360 inputs can be assigned on this table, i.e., 15 groups
(“pages”) of 24 inputs each. Each page of 24 sources would then be accessed with the Page key.

For CP 330 panels configured for dual bus control (24 x 2), the first 24 rows on this table will apply to the top row of
24 buttons and the next 24 rows to the bottom row of buttons.

9. If you want to allow the override to be changed from the CP 3000, CP 3800, or CP 3824 front panel, check the box in
the “Edit” column.

Note: Front–panel editing does not change the name of the override as established by the Override Set table.
This could result in a situation where the operator selects CAM1 but gets VTR5. For overrides that will be
allowed to be edited from the front panel, it’s a good practice to enter generic names such as “Usr1” or
“Ovr1.”

10. Select the Levels that you want to switch by double–clicking in the appropriate Levels field; this will open a secondary
dialog box showing the names of existing switcher levels (as shown in the Switcher Description table [page 5–31]).
Toggle the desired levels on or off and click OK.

11. To close the Override Set table, click OK.

12. Click on “File > Save” to save the table.

The change will apply to all control panels that use the same override set. For the system shown on page 5–89, it would
affect all CP 3000 panels in the system since all of them use “KXYZ–OVR” as the override set.

13. After saving your changes, compile and activate the configuration set. (See page 5–13 if you need more information.)
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CP Sequence Set

A sequence is a switch of one or more sources to one or more destinations.

The CP 3000 panel can accommodate a maximum of 25 events (switches) in one sequence.

There is no specific limit to the number of sequences, but due to memory restrictions a limit of 16 is recommended.

Figure 5–79. CP sequence set (example).

1

Sequence Set – KXYZ–SEQ

Sequence

SEQ1

Input

VT01

Levels

YYYY

2

3

4

SEQ1 VC01 YYYY

SEQ1 VC02 YYYY

SEQ2 CAM1 YNNN

Output

PRDA

PRDB

PRDC

MON1

...

...

...

...

Logical Logical

Password 5–17

Network Description 5–22
Serial Protocol 5–25

Switcher Description 5–31
Switcher Input 5–44
Switcher Output 5–51

Control Panel Sets
Level set 5–55
Input set 5–58
Output set 5–76
Override set 5–98
Sequence set 
Category set 5–103

MPK Devices 5–108

Machines 5–141
Protocol Dependent 5–144
Machine Control 5–148
Delegation Groups 5–161

TCS–1 Device Codes 5–168
Party Line 5–169

Status Display Header 5–172
VGA Status Display 5–173

Tally 5–174

Path Finding 5–196

Exclusion 5–210
Y Line 5–211

In Figure 5–79, the first three rows show the switching events in “Seq1.” In this example, selecting “SEQ1” will cause three
VTRs to be switched into inputs A, B, and C of a production switcher. All four levels (video, audio left, audio right, and time
code) will be switched. The switches will take place in the vertical interval at maximum system speed.

Sequences are stored as sequence sets;  these sets can be made available to some or all control panels.  For the system shown
on page 5–89 (on the MPK Devices menu), the set in this example would be available to all CP 3000 Switcher Control Panels
in the system since all of them use “KXYZ–SEQ” as the sequence set. Sequences can include outputs not otherwise available
to a panel (i.e., when the outputs are not entered on the CP Output Set assigned to the panel).

When operating the CP 3000, sequences are accessed through the Menu and F keys, as described on page 6–17.

Note 1: Data matrixes can be part of sequences when used in conjunction with the “DM 400 Off Time” feature
(DM 400 Off Time is described on page 5–43). There should not be more than 25 DM 400 safe off time switches
per sequence. Safe off time in sequences must be used with care as specifying too short of a safe off time may result
in the switch occurring too soon; this could result in switches occurring out of sequence.
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Note 2: Great care needs to be used to ensure that the switches defined in CP Sequence Sets involving Data Routers
do not conflict.  Verify that each sequence uses all defined data router inputs and outputs just once, including the
implied reverse switches.  Failure to do this will result in unintended switches, and possibly switching a single
input to multiple outputs at the same time.

DEFINING SEQUENCES

1. On the top of the Jupiter Configurator window (page 5–2), check to see whether the configuration set you want to
change is selected for editing.

For more information, please see Modifying and Downloading a System Configuration Set on page 5–8.

2. Click on “Jupiter > Control Panel Sets” then “CP Sequence Set.” This will open a list of all existing CP Sequence sets.

3. Click on “New.”

4. Enter the desired name for the set, up to eight characters, and select a CP type. Then click on “Apply” and “Open Table.”
An example of the resulting menu is shown in Figure 5–79.

Important:  Do not use the same name for different CP sets. Also, do not name a CP set with a name used
by the system for a Device Type. Device Type names are shown on page 5–109.

5. Add (or edit) sequences as desired.

Enter a name for the first sequence.

Select the first input name (source for these names is the Switcher Input table, page 5–44). Select the first output name.
The source for these names is the Switcher Output table (page 5–51).

Guidelines for using the editor are found on page 5–3.

The Levels column is edited by double–clicking in the field and toggling the desired levels on or off in a secondary dialog
box.

6. After saving your changes, validate, compile, and activate the configuration set.
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CP Category Set

1

Category Set – 3200-CAT

VTR

2

3

19

Font

Net

Aud

Mnemonic

Figure 5–80. CP category set
(example).

Password 5–17

Network Description 5–22
Serial Protocol 5–25

Switcher Description 5–31
Switcher Input 5–44
Switcher Output 5–51

Control Panel Sets
Level set 5–55
Input set 5–58
Output set 5–76
Override set 5–98
Sequence set 5–101
Category set 

MPK Devices 5–108

Machines 5–141
Protocol Dependent 5–144
Machine Control 5–148
Delegation Groups 5–161

TCS–1 Device Codes 5–168
Party Line 5–169

Status Display Header 5–172
VGA Status Display 5–173

Tally 5–174

Path Finding 5–196

Exclusion 5–210
Y Line 5–211

The CP Category Set table allows the category names to be customized. (Categories are classes of inputs/outputs, such as
“VTR” and “CAM.”) This table is the source of the name that appears in the display window when a category key is pressed.

A custom category set can be used with the CP 320, CP 3000, CP 3800, CP 3808, CP 3824, and CP 3830 panels, all of which
have re–legendable keycaps.

Note: The original CP 3000 switcher control panels have factory default categories engraved on the keys; however,
these panels can be retrofitted in the field using the CP 3000RBK Relegendable Button Kit, part no.
44–046025–001.

A CP Category Set is normally assigned to a CP Input Set and to a CP Output Set when those sets are first created. However,
this assignment can be changed later if desired (see page 5–107).

The CP Input and Output Sets are in turn assigned to specific control panels on the MPK Devices table (page 5–89).

When creating a new CP Category set, the menu shown in Figure 5–81 will appear.



Configurator CP Category Set

5–104 VM 3000 Installation and Operating Manual

cp2002B IN
cp2002B OUT
cp3000 IN
cp3000 OUT
cp3800 IN
cp3800 OUT
cp3808 IN
cp3808 OUT
cp3824 IN
cp3824 OUT
cp3830 IN
cp3830 OUT
cp310 OUT
cp320 IN
cp320 OUT
cp328 IN
cp328 OUT
cp3310 IN
cp3310 OUT
cpsatrn IN
cpsatrn OUT†

emem IN
emem OUT
serial IN
serial OUT
umd3a IN
umd3a OUT

Figure 5–81. CP category set create menu.

This menu is used to enter the name of the set and select the set type. 

When finished, a blank version of the table shown in Figure 5–80 will appear.

Guidelines for using the editor are found on page 5–3.

Each CP 3000, CP 3800, or Saturn In Category Set can contain up to 20 category mnemonics; if less than 20 categories are
entered, the remaining category keys will be inoperative.

† “cpsatrn OUT” not used. Detailed Saturn configuration instructions are described in the Saturn Master Control Switcher
Installation and Operating Manual.
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The table entries correspond to the CP 3000 and CP 3800 category keys as follows:

VTR

1

CG

2

NET

3

SAT

EJVCR

4

CAM

5

REM

6

FILM

7

PTCH

8

STU

9

FS

AUX TEST

0

MISC SS

A

B

C

D

Original CP
3000 engraved

keys

CP 3000/3800 key positions
showing number of corresponding

row on Category Set table

1 2 3 4 5

6 7 8 9

11 12 13 14 15

16 17 18 19 20

10

Figure 5–82. CP 3000/3800 key positions.

The table entries correspond to the Saturn category keys as follows:

VTR
1

CGEN
2

CART
3

CAM
4

MISC
5

T/C
6

FDL
7

AUX
8

NET
9

TEST
0

A
clock

STILL GRFX

1 2 3 4

6 7 8

11 12

16 17 18 19

5

9

13

20

10

14 15

E
all

B
timer

F
key

C
preroll

G
mix

D
trans

H
bkgnd Figure 5–83. Saturn key positions.

Each CP 320 and CP 3808 Category Set can contain up to 16 category mnemonics; if less than 16 categories are entered,
the remaining category keys will be inoperative.

The table entries correspond to the CP 320 category keys as follows:

VTR
1

CG
2

NET
3

VCR
4

CAM
5 AUX

REM
6

FILM
7

PTCH
8

STU
9

TEST
0

EJ SS

MISCFSSAT

1 2 3 4 5 6 7 8

9 10 11 12 13 14 15 16
Figure 5–84. CP 320 key positions.
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The table entries correspond to the CP 3808 category keys as follows:

VTR
1

CAM
2

SAT
3

VCR
4

NET
5 FILMREM

6

Stu
7

MISC
8

AUX
9

TEST
0

EJ

STILLCGEN

FS

PTCH

1 2 3 4

5 6 7 8

9 10 11 12

13 14 15 16
Figure 5–85. CP 3808 key positions.

Each CP 3824 Category Set can contain up to 15 category mnemonics; if less than 15 categories are entered, the remaining
category keys will be inoperative. The table entries correspond to the CP 3824 category keys as follows:

VTR
1

CG
2

NET
3

CAM
5

AUX
6

SS
7

FILM
9

PTCH
0

1 2 3 4 5

6 7 8 9 10

11 12 13 14 15

VCR
4

REM
8

STU TEST FS MISCSAT Figure 5–86. CP 3824 key positions.

Each CP 3830 Category Set can contain up to 12 category mnemonics; if less than 12 categories are entered, the remaining
category keys will be inoperative. The table entries correspond to the CP 3830 category keys as follows:

VTR
1

GFX
2

Stu
3

ENG
4

REM
5

NET
6

EC
7

POST
8

Xmsn
9

TEST
0AUX

1 2 3

4 5 6

7 8 9

10 11

NUM

12
Figure 5–87. CP 3830 key positions.
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Changing the Category Set Associated with an Input or Output Set

A custom Category Set can be created at any time. The following procedure is used to assign a new Category Set to an existing
CP Input Set or CP Output Set.

1. On the main menu, click on “Jupiter” and “Control Panel Sets.” Then select  “Input” or “Output,” as desired. A menu
similar to Figure 5–88 will appear.

Figure 5–88. CP set dialog (example).

2. Select the name of the existing set of interest.

3. Click on the Category Set name box, and enter the name of the new Category Set.

If you want to return to the factory default category set, leave the Category Set name as “Default.”

4. Click on “OK.”
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MPK Devices

Figure 5–89. MPK Devices table (example).

STUMC MC–3000 6 00000016

STUCP CP–3000 6 00000014 KXYZ–OVE KXYZ–SEQ

1

MPK Devices

MPK
Type Expansion Pass Board

VM1

Port Address Input Sets Output Sets Level Set Overide Set Sequence Set

2 VM1 KXYZ–INP KXYZ–OUT KXYZ–LEV

Devices word In Panel Out Panel

ENGCP CP–3000 6 00000013 KXYZ–OVE KXYZ–SEQ3 VM1 KXYZ–INP KXYZ–OUT KXYZ–LEV

MC CP–3000 2 00000000 KXYZ–OVE KXYZ–SEQ4 VM1 KXYZ–INP MC–OUT KXYZ–LEV

SHOP CP–3000 2 00000002 KXYZ–OVE KXYZ–SEQ5 VM1 KXYZ–INP SHOP KXYZ–LEV

DELAY CP–3000 2 00000003 KXYZ–OVE KXYZ–SEQ6 VM1 KXYZ–INP DELAY–OUT KXYZ–LEV

TAPECP CP–3000 6 00000008 KXYZ–OVE KXYZ–SEQ7 SI1 KXYZ–INP TAPE–OUT KXYZ–LEV

TAPEMC MC–3000 6 000000168 SI1

CONF CP–3000 3 00000006 KXYZ–OVE KXYZ–SEQ9 VM1 KXYZ–INP CON1 KXYZ–LEV

PROD CP–3020 6 0000001210 VM1 3020–OVEVT01 KXYZ–LEV

TMC03010 MC–3010 6 0000002911 SI1

EDIT CP–320 5 0000003712 VM1 KXYZ–INP EDIT–OUT KXYZ–LEV

Hexadecimal

                                 

Device

Password 5–17

Network Description 5–22
Serial Protocol 5–25

Switcher Description 5–31
Switcher Input 5–44
Switcher Output 5–51

Control Panel Sets
Level set 5–55
Input set 5–58
Output set 5–76
Override set 5–98
Sequence set 5–101
Category set 5–103

MPK Devices

Machines 5–141
Protocol Dependent 5–144
Machine Control 5–148
Delegation Groups 5–161

TCS–1 Device Codes 5–168
Party Line 5–169

Status Display Header 5–172
VGA Status Display 5–173

Tally 5–174

Path Finding 5–196

Exclusion 5–210
Y Line 5–211

This table must be used to define all MPK devices in the system. These include control panels, status displays, and the MI
3040 General Purpose / Tally Interface. It is also used when a PC is used as a Software Control Panel.§

§ Applies only when the Software Control Panel is used for machine control. For more information, see Section 7.
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Important: Row numbers on Jupiter tables are used as the “logical” numbers for devices. Changing the row number of an
existing device (by inserting/deleting a new control panel in the middle of the table, for example) will disrupt control of the
system, requiring controller boards to be memory–cleared and reset (see “Clearing Battery–Protected Memory in Appendix
B). One way to avoid this interruption is to add new devices at the end of tables.

MPK
Devices This column is used to create a name, up to eight characters in length, for each MPK device in the

system. Machine control panels (such as MC 3000, MC 3010, CP 3000 with “Exp” (expansion), CP 3800, and
CP 3810) listed here will automatically appear as a selection on the Machine Control table (page 5–148).

Type Device types (shown on a pull down menu) are limited to the following:

CP 300
CP 300/S
CP 310
CP 310/S
CP 320
CP 320/S
CP 328
CP 328/S
CP 330
CP 330/S
CP 2002B
CP 2002D
CP 3000
CP 3008
CP 3020
CP  3030
CP 3310/5
CP 3310/8
CP 3320
CP 3300/X
CP 3800
CP 3808
CP 3809
CP 3810 (p. 5–137)

CP 3810L (p. 5–137)
CP 3810S
CP 3824
CP 3830
CP 3830P
CP 3832
CP 3832L
CP 3832P
CP 3832S
CP 3864
CP 3864L
CP 3864P
Diamond (p. 5–129)
ES–LAN
ES–TRIB
FCS 3276
FCS 3277
FCS 3296
FCS 3360
FCS 3363
GVG 200 (p. 5–131)
JNS–UMD
MANAGER§
MC 3000

MC 3010
MC 3020D (p. 5–162)
MC 3020L (p. 5–118)
MC 3040/2 (p. 5–117)
MC 3040/4 (p. 5–117)
MC 3040/8 (p. 5–117)
MCS TALY (p. 5–116)
MESS UMD
3040 LOCK
3040 SLCT
MI 3040/T (p. 5–116)
MI 3040/2 (p. 5–116)
MI 3040/4 (p. 5–116)
MI 3040/8 (p. 5–116)
MI 3040IO
SD 3x (p. 5–118)
Serial (p. 5–130)
WPE*
UMD3A (p. 5–118)
VC 3020 (p. 5–115)
VCP 3000 (p. 5–115)
VMC 3000 (p. 5–115)

Selecting a control panel with an “/S” suffix will cause the panel to operate with “sticky levels.”*

Selecting a CP 3810L device type will cause the panel to operate in single bus mode. For more information,
see page 5–137 and following.

Selecting a CP 3810S device type will cause the panel to operate in “sticky output” mode.

Selecting a CP 3830P device type will cause the CP 3830 panel to operate in dual output control (automatic
preview) mode. In this mode, the CHOP button is redefined as the PRESET TAKE button.

* Defined in Glossary section.

§ Custom.
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Selecting a CP 3832P or CP 3864P device type will cause the panel to operate in Preset mode at all times.
This mode can be used to verify input selections before switching.

Selecting a CP 3832L or CP 3864L device type will cause the right–hand group of six buttons to function as
level selection buttons.

Device types “3040SLCT” and “3040LOCK” are used for Input Source Assignment applications, where an
MI 3040 is used to automatically select and lock router outputs controlled by a Jupiter panel feeding assign-
able inputs to a production switcher. For more information, see Appendix U.

Expansion As a general rule, the Expansion box is checked when the panel is used with an expansion panel;
for example, when a CP 3000 is used with a CP 3010. For special uses of this column, see the notes below.

For each MC 3010, there is only one entry whether it is a 4 machine panel (MC 3010/1) or a dual 4 machine
panel (MC 3010/2). The right–hand panel of an MC 3010/2 is not treated as an expansion panel; therefore, the
Expansion box is not checked.

The CP 3800 panel can be defined for Multiple Destination Mode operation (front–panel selectable to Single
Destination mode); or, defined for Single Destination Mode only operation. For front–panel selectable, Mul-
tiple or Single Destination Mode operation, the Expansion box is checked. For Single Destination Mode only
operation, the box is not checked.

When CP 3808 or CP 3830  control panels are associated with a CP 3809 Expansion Panel(s), the CP
3808/3830 Expansion box is checked. The CP 3809 entry is unchecked. Note: The CP 3830P cannot be oper-
ated with an expansion panel.

When a CP 3832 or CP 3864 control panel (including type L)  is to be operated as a “split” panel, with some of
the buttons used for inputs and some for outputs, the Expansion box is checked. For all other applications, the
box is not checked (even when the panel is used in association with another panel to expand the number of
inputs or outputs, the box entry is still unchecked). The split mode cannot be combined with the continuous
Preset mode described above.

For CP 3810 Expansion Panel(s), the Expansion box is always unchecked.

When a CP 330 is defined with the Expansion box checked and an Output Set with two or more outputs
defined, the CP 330 will operate as a 24 X 2 panel with the top row of buttons assigned to one output and the
bottom row to another. The first two outputs defined in the Output Set will be the two output buses it will
control.

Pass
word This table has provisions for entry of password levels (described in detail on page 5–114).

Board Name of controller board connected to this device. The source of these names is the Network Descrip-
tion table (page 5–22).

Port Number of controller board port connected to this device. The port must support the necessary protocol
for this device (as configured on the Serial Protocol table, page 5–25).
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Address Address (hex). Unique serial data bus ID used to select and service this device. Must be entered in
hexadecimal. (Not to be confused with LAN address entered on Network Description table shown on page
5–22).

With the exception of the CP 3800 Series panels and RP 1/2/3 Under Monitor Displays, device addresses such
as “00000018” are determined at time of manufacture and cannot be changed by the user. To display the ad-
dress of a control panel, please see Display Control Panel ID on page 6–21.

Input Sets
Name of CP Input Set to be assigned to this device. The usual practice is to have one CP Input Set,

containing the names of all inputs, apply to all panels. However, special CP Input Sets could be created which
list only selected inputs; such a set could be used to prevent certain panels from selecting specific inputs.
Creation of CP Input Sets was described on page 5–58.

If panel “A” does not have access to a certain input, but that input has been selected by panel “B” for the output
presently being statused by panel A, then panel A has no way of reporting the mnemonic of the input. Under
these conditions, panel A will show asterisks (****) for status.

For each CP 3832 or CP 3864 operated as a:

— Single–bus control panel, select the name of the CP Input Set that will be used to assign sources to the control
panel’s input buttons.

— “Split” panel, with some of the buttons used as inputs and some as outputs, select the name of the CP Input Set
that will be used to assign sources to the control panel’s input buttons.

— Main source panel (controlling the inputs at a multi–panel control station) select the name of the CP Input Set
that will be used to assign inputs to the buttons at this control station. See page 5–133 for more information
about CP 3832/64 multi–panel control stations.

In Panel This column is used only for expansion panel configuration when that panel will be used for addi-
tional inputs.

For each CP 3832 or CP 3864 operated as an expansion input panel (used in association with a main source
panel), select the MPK Devices name of the associated main panel in this column. See page 5–133 for more
information about CP 3832/64 multi–panel control stations.

Note: In some cases you will need to press “Apply” to update the selections in drop down lists.

Out Set CP Output Set name. Creation of CP Output Sets was described on page 5–76.

If the entry is an actual CP Output Set, then the control panel will be able to control all the outputs listed in that
Set. Depending on the contents of the set, this would allow for full–matrix or multi–bus control.

For many single–output panels, this field can be used to enter the name of a single switcher output to be con-
trolled (see Note 1 below for exceptions). The source of the output names is the Switcher Output table (page
5–51).
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Note 1: For a CP 300, CP 310, CP 320,or single–bus CP 330 (inclulding “/S” type) control panels, for a
CP 3020 panel, and for a single–bus CP 3830, enter the name of the output set that contains the name of
the output to be controlled.

For each dual–bus CP 330, enter the name of the output set that will be used to assign the two destinations.

For each CP 328 (including “/S” type), enter the name of the output set that will be used to assign the destina-
tions.

For each CP 3809 Expansion Panel, the “Out Set” column must be blank.

For CP 3810 / 3810S / 3810L Expansion Panel entries, see page 5–137 and following.

If the CP 3830 is to be used to control one output, you cannot enter the name of the output in this column;
instead, you must enter the name of an output set that contains the name of the output.

For each CP 3832 or CP 3864 operated as a:

— Single–bus control panel, enter the name of the output that the panel is to control.

— “Split” panel, with some of the buttons used as inputs and some buttons used as outputs, enter the name of the
CP Output Set that will be used to assign destinations to the control panel’s output buttons.

— Main panel with a CP 3810 Expansion Panel, see page 5–137 and following for details.

Out Panel
This column is used only for expansion panel configuration, when that panel will be used for addi-

tional outputs.

For each CP 3832 or CP 3864 operated as an expansion output panel (in association with a source panel),
select the MPK Device name of the associated main source panel in this column. See page 5–133.

For each CP 3809 Expansion Panel, select the name of the associated CP 3808 or CP 3830 main source
panel.

For each CP 3810 Expansion Panel associated with a main source panel (CP 3832, CP 3864, CP 3808, or CP
3830), select the name of the main panel. See page 5–137 for an example.

For each CP 3830 Dedicated Output Panel, select the name of the associated CP 3830 main source panel
(see page 5–132).

Note: In some cases you will need to press “Apply” to update the selections in drop down lists.

Level Set
Select the CP Level Set name. Creation of CP Level Sets was described on page 5–55.

For each CP 3809  Expansion Panel, the Level Set column must be blank.

Override Set Select the CP Override set name. In addition to defining CP 3000 overrides, CP Override
Sets are also used to assign input buttons on CP 300/310/330 and CP 3020 Push Button Control Panels. Crea-
tion of CP Override sets was described on page 5–98.
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Sequence set Select the CP Sequence set name. Creation of CP Sequence Sets was described on page
5–101.

SETTING UP A SWITCHER CONTROL PANEL FOR FULL–MATRIX, MULTI–BUS, OR 
SINGLE–BUS CONTROL

The output(s) that can be controlled by a control panel will depend on the CP Output Set entry for that panel on the MPK
Devices menu:

1. On the top of the Jupiter Configurator window (page 5–2), check to see whether the configuration set you want to
change is selected for editing.

In most cases, you will want to modify the set that is currently active; if so, you may want to copy the active set and
select the copy for editing. For more information, please see Copying a Configuration Set for Editing on page 5–10.

2. Click on “Jupiter > MPK devices.” This will open a table similar to that shown on page 5–108, which is a list of all control
panels in the system. The column of interest is labelled “Out Set.”

3. Click on the Output Set field you want to change.

4. In most cases, you’ll want to enter the name of the desired CP Output Set (for full/multi–bus operation), or select the
name of a single switcher output (for single bus operation).

Creation of Output Sets was described on page 5–76. The source of the output names is the Switcher Output table (page
5–51).

You may wish to review the “Out Set” discussion on page 5–111 for special entries required for some control panel ap-
plications.

5. After saving your changes, validate, compile and activate the configuration set. (See page 5–13 if you need more in-
formation.)
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SETTING PASSWORD LEVELS FOR CONTROL PANELS

In addition to individual Jupiter passwords assigned to each user, individual control panels can be given a password level.
This can be used to provide varying levels of protection from one control panel to another.

 To change the password level for a control panel:

1. On the top of the Jupiter Configurator window (page 5–2), check to see whether the configuration set you want to
change is selected for editing.

In most cases, you will want to modify the set that is currently active; if so, you may want to copy the active set and
select the copy for editing. For more information, please see Copying a Configuration Set for Editing on page 5–10.

2. Click on “Jupiter > MPK Devices.” This will open a menu similar to that shown on page 5–108, which is a list of all control
panels in the system.

In this example, the Password level column is blank, meaning that all control panels have a password level of zero.
Therefore all passwords presently assigned will enable any panel.

3. Click on the Password field for the control panel you want to change.

4. Enter the desired password level for this panel.

Entering “50” would allow the panel to switch outputs having a security level of 50 or less.

Guidelines for using the editor are found on page 5–3.

5. After saving your changes, validate, compile and activate the configuration set.
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VGA STATUS DISPLAY CONTROL PANEL ENTRIES

Use of control panels with the VGA Status Display requires entries to the MPK Devices table. The following example applies
to the VGA system shown on page A–1.

VC VC–3020 1 00000020

VCP VCP–3000 1 00000021 KXYZ–OVE

VMC VMC–3000 1 00000022

1

MPK Devices

MPK
Expansion

Pass
Board

V

Port Address Input Sets Output Sets Level Set Overide Set Sequence Set

2 V KXYZ–INP KXYZ–OUT KXYZ–LEV

3

4

Devices word In Panel Out Panel

V

Figure 5–90. MPK device table entries for system shown on page A–1.

Device
Type

Force Unprotect / Force Unlock Password

The VGA control panels can be configured to force unlock and force unprotect switcher outputs. This will normally require
use of a password with a level of 90 or above. If you wish to enable force unlock/unprotect on a permanent basis, you should
enter a password level of 90 or above for the VGA panels on the MPK Devices table.

VC VC–3020

VCP VCP–3000 90

VMC VMC–3000

KXYZ–INP

1 00000020

1 00000021

1 00000022V

KXYZ–OUT

1

MPK Devices

MPK
Expansion

Pass
Board

V

Port Address Input Sets Output Sets Level Set Overide Set Sequence Set

2 V KXYZ–LEV

3

4

Devices word In Panel Out Panel

KXYZ–OVE

Figure 5–91. Force unprotect/unlock password entries.

Device
Type

Displaying Time Code on an MC 3000 Associated with a VGA Status Display

The entries shown above will allow the MC 3000 to control any machine pointed to by the VGA cursor. However, while the
MC 3000 is under VGA cursor control no time code will be displayed in the MC 3000 display window. This function will
require entries to the Machine Control table, as shown on page 5–158.
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MI 3040 GENERAL PURPOSE / TALLY INTERFACE ENTRIES

Machine Interface Applications

The following example applies to two “MI 3040/2s,” that is, MI 3040s configured to control two functions (Play and Stop)
on each of 20 machines. For system drawings, see pages 2–93 and 2–96. 

Figure 5–92. Entries for MI 3040s used for machine control.

MI1

MI2

MI–3040/2

MI–3040/2

1

MPK Devices

MPK
Expansion

Pass
Board Port

5

Address

00000026

Input Sets Output Sets Level Set Overide Set Sequence Set

2 5 00000041

Devices word In Panel Out Panel

SI1

VM1

Device
Type

Entries will also be required on the Machine Control table (page 5–159.)

Tally Interface Applications

When an MI 3040 is configured as an “MI 3040/T,” that is, configured to control tally lights (as shown on page 2–107 and
following), an entry similar to that shown as row 1 in Figure 5–93 will be required. If there is more than one MI 3040, an entry
with a unique Device Name will be required for each. This entry is the source of the Device Name for the MI 3040 and this
same name must be selected on the Tally Dependency table (page 5–180).

If the tally system is being used in connection with a Saturn Master Control Switcher or a MCS 2000 Master Control Switcher,
an additional entry will be required to allow the Jupiter system to gather tally information from the MCS. This entry will be
similar to row 2 in Figure 5–93. The Device Name (“MCS_TLY” in this example) must also be selected on the Tally Depend-
ency table (page 5–180). If more than one master control switcher is in the system, there must be an entry for each—for exam-
ple, with Device Names such as “MCS_TLY1,” “MCS_TLY2,” etc. For Saturn, the “Board” is always the name of the video
processor; the MPK “Port” is always “1” (this is true even if the MPK port is not physically connected to the MI–3040). For
an MCS 2000, the “Board” is the name of the device that is the source of the TCS 2 bus, i.e., the device that is connected to
the Machine Control port of the EC 2000 Control Electronics.

Figure 5–93. Entry for MI 3040 used for tally.

TALLY1

MCS_TLY

MI–3040/T

MCS_TALY

SI1

DVP–1

5

1

000000261

MPK Devices

MPK
Expansion

Pass
Board Port Address Input Sets Output Sets Level Set Overide Set Sequence Set

2

Devices word In Panel Out Panel
Device
Type

External Control of Saturn Master Control Switcher (“MI 3040IO” application)

Using the MI 3040 General Purpose / Tally Interface, an external device can transmit commands to, and receive status from,
a Saturn Master Control Switcher. In this application, the MI 3040 is configured in software as an “MI 3040IO.” For more
information, refer to “MI 3040IO” in the Saturn Installation and Operating manual.
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MC 3040 (MI 3040) ENTRIES

Non–Thomson Machine Control Panel or Computer Applications

With the MI 3040 General Purpose / Tally Interface, a non–Thomson machine control panel or computer can use the Jupiter
system to transmit commands to and receive status from a VTR or similar machine. In this application, the MI 3040 is config-
ured in software as an “MC 3040.”

Note: The MC 3040 and MI 3040 hardware is identical.

The following example applies to an “MC 3040/4,” that is, an MI 3040 configured to control four functions (Play, Stop, Ready,
and Cue) for up to 10 control panels. For system drawings, see pages 2–97 and 2–100.

MC3040 MC3040/4 SI1 5 000000401

MPK Devices

MPK
Expansion

Pass
Board Port Address Input Sets Output Sets Level Set Overide Set Sequence SetDevices word In Panel Out Panel

Figure 5–94. Entry for MC 3040.

Device
Type

Entries will also be required on the Machine Control table (page 5–148).
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MC 3020D DELEGATE PANEL ENTRY

Table entries for this panel are discussed on page 5–162.

MC 3020L LINKAGE PANEL ENTRY

MPK Devices

TAPEMCL MC–3020L 00000031 LINKMACH LINKPANL1

MPK
Expansion

Pass
Board Port

6

Address Input Sets Output Sets Level Set Overide Set Sequence SetDevices word In Panel Out Panel

SI1

Figure 5–95. Entry for MC 3020L. The corresponding system is shown on page 2–68.

Davice
Type

Hardware installation of the MC 3020L has already been described (page 2–67).

The MPK Devices table must be used to identify each MC 3020L in the system. A name for the MC 3020L is entered along
with the name of a CP Input Set that is actually a list of the machines assigned to the MC 3020L’s main panel. Also entered
is the name of a CP Output Set that is actually a list of the control panels assigned to the expansion panel.

For information concerning creation of the CP Input Set (machine list), see page 5–62.

For information concerning creation of the CP Output Set (control panel list), see page 5–76.

Important: The system automatically defaults to “No expansion panel.” “No” (unchecked) is the correct entry,
even though the MC 3020L is being operated with an expansion panel (a CP 3021).

SD 3X AND RP 1/2/3 UNDER MONITOR DISPLAY ENTRIES

Hardware installation was discussed on page 2–121. Software configuration varies according to the switching equipment
used.
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SYSTEMS WITH JUPITER–CONTROLLED DISTRIBUTION SWITCHER ONLY

SD 3x Applications

Video

MPK bus

Routing
switcher

Output names

M/E 3

M/E 2

M/E 1

VM 3000 
“VM1”

SD 35
“SD3–M/E1”

SD 33 SD 33 
“SD3–M/E2” “SD3–M/E3”

Figure 5–96. Example of SD 3x installation.

MPK Devices

1

MPK
Expansion

Pass
Board Port Address

2

3

4

5

SD3–M/E1 VM1 4 00000032SD–3x

SD3–M/E2 VM1 4 00000033SD–3x

SD3–M/E3 VM1 4 00000034SD–3x

Devices word Level Set

KXYZ–LEV

KXYZ–LEV

KXYZ–LEV

Sequence SetOut Panel Override SetIn Panel Output Sets

M/E 1

M/E 2

M/E 3

Input Sets

UMD–INP

UMD–INP

UMD–INP

Figure 5–97.  Entries for system shown in Figure 5–96.

Device
Type

The Address of each SD 3x display is shown on the rear panel.

The “Input Set” specified should be of type CP 3000 and include all inputs and mnemonics that will be used on the status
display. Each “Output Set” is not an actual Output Set, but is rather the name of the router output feeding the monitor next
to the particular status display. The status display will follow the first level listed in the Level Set, e.g., if Video is the first
level listed, then the mnemonic of the video input feeding the monitor will be shown.
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RP 1/2/3 Applications

Configuration of the RP 1/2/3 displays is similar to the SD 3x except that Device Type “UMD3A” is selected on the MPK
table. In addition, the address of RP displays can be changed using rear–panel switches. See Figures 5–98 and 5–99.

      Figure 5–98. Example of RP 1/2 installation.

Video

MPK bus

Routing
switcher

Output names

M/E 3

M/E 2

M/E 1

VM 3000 
“VM1”

RP 1
“UMDRP1”

RP 2 RP 2 
“UMDRP2A” “UMDRP2B”

MPK Devices

1

MPK
Expansion

Pass
Board Port Address

2

3

4

5

UMDRP1 VM1 4 00000031UMD3A

UMDRP2A VM1 4 00000032UMD3A

UMDRP2B VM1 4 00000132UMD3A

MI3040T VM1 1 11111111MI3040/T

Devices word Level Set

KXYZ–LEV

KXYZ–LEV

KXYZ–LEV

Sequence SetOut Panel Override SetIn Panel Output Sets

M/E 1

M/E 2

M/E 3

Input Sets

UMD–INP

UMD–INP

UMD–INP

Figure 5–99. Entries for system shown in Figure 5–98.

Device
Type

For RP 1 Under Monitor Displays, the Address is set with a pair of rotary switches on the rear panel. For RP 2 dual displays,
the address of the first (left–hand) display is set with the rotary switches; the address of the second display is the same number
plus 100 hex. For RP 3 triple displays, the address of the first display is set with the rotary switches; the address of the second
display is the same number plus 100 hex; and the address of the third display is the same number plus 200 hex. For example,
if the first display is set to “AA,” then the address of the second display is “1AA” and the address of the third display is “2AA.”

The “Input Set” specified should be of type “UMD3A” and include all inputs and mnemonics that will be used on the status
display. Each “Output Set” is not an actual Output Set, but is rather the name of the router output feeding the monitor next
to the particular status display. The status display will follow the first level listed in the Level Set, e.g., if Video is the first
level listed, then the mnemonic of the video input feeding the monitor will be shown.
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Tally light operation. For tally light operation, the MPK table must include an “MI 3040/T” entry (even if no actual MI 3040
hardware is in the system):

— If there is no MI 3040/T connected to the VM/SI controlling the RPs, you must define an imaginary MI 3040T
and assign it to the VM/SI controlling the RPs. Entries for “Port” and “Address” are not used but must be pres-
ent to satisfy the compiler. See row 4 of Figure 5–99. The purpose of this entry is to launch a tally process
within the VM/SI.

— If an MI 3040/T does exist, and is connected to the VM/SI controlling the RPs, use the actual VM Board name,
Port, and Address.

Tally light operation will also require entries to the Tally Relay and Tally Dependency tables (see pages 5–174 and 5–180).
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SYSTEMS WITH SATURN / MCS 2000 MASTER CONTROL SWITCHER

SD 3x Applications

Video

Jupiter Control lines

Routing
switcher

Output names

MCS–A

MCS–B

MCSK1

MCSK2

MCSBP

PRESET PROGRAM AIR

A B K1 K2 BP

Preset Program On air

Saturn / MCS 2000
Master control switcher

“SD3 PRST” “SD3 PRGM” “SD3 AIR”

VM 3000 
“VM1”

Figure 5–100. Example of status display system with Saturn/MCS master
control switcher. Equipment shown here corresponds to tables on page 5–123.

If the system includes a Saturn or MCS 2000 Master Control Switcher, the software must be able to follow through the
switcher to determine what input has been selected. Therefore, an additional MPK Devices table entry will be required to
allow the Jupiter system to gather “tally” information from the switcher. This entry will be similar to row 4 of the MPK De-
vices table in Figure 5–101; in this example it is based on the system shown in Figure 5–100.

Note 1: If the Saturn is equipped with the internal matrix option, the UMDs should be configured to operate under
“Saturn Control” (as opposed to Jupiter Control). This must be done in order for the displays to show the correct
status of the internal matrix. For information about Saturn Control of UMDs, refer to the Saturn installation manu-
al.

Note 2: The device called “MCS_TLY” exists only in software tables. Saturn systems require a “Board” entry that
points to the Video Processing Unit; the “Port” number is always “1.” For MCS 2000 systems, the “Board” entry
points to the controller connected to the MCS–2000; the “Port” number is always “7.”

Special Output Set tables of type SD 3x must also be created to name all router outputs that can be selected for the Preset,
Program, and Air status displays (Figure 5–101). These router outputs must also be entered on a Tally Dependency table as
shown.

If there is more than one master control switcher in the system, there must be an entry for each—for example, with the Device
Names “MCS_TLY1,” “MCS_TLY2,” etc.
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Note 3: The software used to control the status displays is based on that used to control tally lights. For a more
complete understanding of the system logic, you may wish to review the tally description beginning on page 5–174.

Figure 5–101. Tables for system shown on page 5–122.

1

Output Set — Program

Category

MISC

Entry

1

Mnemnonic

X

Output

MCS–A

2

�

MISC 0 X MCS–B� These rows must be in
reverse order of the rows
in the Preset Output Set

� Data in this field is not used, but an entry must be
selected to satisfy the Jupiter compiler.

x Data in this field is not used, but at least one charac-
ter must be entered to satisfy the compiler.

Saturn application MCS–2000 application

DVP–1

SD3–PRST SD–3x 4 00000032 PRESET

SD3–PRGM SD–3x 4 00000033 PROGRAM

SD3–AIR SD–3x 4 00000034 ONAIR

MCS_TLY MCS_TALY

1

MPK Devices

MPK
Type

Expansion Pass Board

VM1

Port Address Input Sets Output Sets Level Set Overide Set Sequence Set

2 VM1 KXYZ–INP KXYZ–LEV

3

4

VM1

Devices word In Panel Out Panel

KXYZ–INP KXYZ–LEV

KXYZ–LEVKXYZ–INP

1 VM1 7

1

Output Set — Preset

Category

MISC

Entry

0

Mnemnonic

X

Output

MCS–B

Lev Set Button

2

�

MISC 1 X MCS–A�

ButtonLev Set

1

Output Set — On air

Category

MISC

Entry

1

Mnemnonic

X

Output

MCS–A

Lev Set Button

2

3

�

MISC 0 X MCS–B�

VTR 3 X MCSBP�

MCS–A

MCS–B

6 MCSBP

1

Tally Dependency

Name

MCS_TLY

Opto

0

Output Tally

2

3

MCS_TLY 1

MCS_TLY

Output Set — On air

Logical

Logical

Logical

Logical

Device
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RP 1/2/3 Applications

Configuration of the RP 1/2/3 displays for use with Saturn/MCS master control switchers is similar to the SD 3x, except for
the following:

� Device Type “UMD3A” is selected on the MPK table.

� The address of RP displays can be changed using rear–panel switches. For more information, see page 5–120.

� Output Sets are of type UMD3a.

� For information about activating RP 1/2/3 tally lights, see “Tally Light Operation” on page 5–121.
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SYSTEMS WITH NON–SATURN / NON–MCS 2000 MASTER CONTROL 
OR ANY MODEL PRODUCTION SWITCHER

SD 3x Applications

(Please refer to the illustrations on pages 5–126 and 5–103.)

These entries will be similar to those already described (page 5–122), with the following additions:

With a production switcher (or non–Saturn / non–MCS 2000 master control switcher) in the system, an MI 3040 configured
as an “MI 3040/T” will be needed to follow signals through the switcher. The entry will be similar to row 4 of the MPK Devices
table on page 5–127.

If there is more than one MI 3040, an entry with a unique Device Name will be required for each.

This table is the source of the Device Name for the MI 3040 and this same name must be entered on the Tally Relay and Tally
Dependency tables.

RP 1/2/3 Applications

Please refer to the illustrations on pages 5–126 and 5–103. Also see “RP 1/2/3 Applications” on page 5–124.
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MI 3040/T
“TALLY1”

Relays

Video

Jupiter Control lines

Routing
switcher

Production switcher

20 1 3 4

Output names

MCS–A

MCS–B

MCSK1

MCSK1

MCSBP

PROD1

PROD2

20 1 3 4

Opto–isolators

Equal number of connections

Switcher tally
relays

PRESET PROGRAM AIR

“SD3 PRST” “SD3 PRGM” “SD3 AIR”

Optional tally light.
See Note 3 on
page 5–123

PRD

Input name

VM 3000 
“VM1”

A B K1 K2 BP

Preset Program On air

Saturn / MCS 2000
 master control switcher

Figure 5–102. Example of status display system with Saturn / MCS 2000 master control switcher and
production switcher. Equipment shown here corresponds to tables on page 5–127.
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Figure 5–103. Tables for system shown on page 5–126.

1

Output Set — Program

Category

MISC

Entry

1

Mnemnonic

X

Output

MCS–A

2

�

MISC 0 X MCS–B� These rows must be in
reverse order of the rows
in the Preset Output Set

� Data in this field is not used, but an entry must be
selected to satisfy the Jupiter compiler.

x Data in this field is not used, but at least one charac-
ter must be entered to satisfy the compiler.

Saturn application MCS–2000 application

DVP–1

SD3–PRST SD–3x 4 00000032 PRESET

SD3–PRGM SD–3x 4 00000033 PROGRAM

SD3–AIR SD–3x 4 00000034 ONAIR

MCS_TLY MCS_TALY

1

MPK Devices

MPK
Type Expansion

Pass
Board

VM1

Port Address Input Sets Output Sets Level Set Overide Set Sequence Set

2 VM1 KXYZ–INP KXYZ–LEV

3

5

VM1

Devices word In Panel Out Panel

KXYZ–INP KXYZ–LEV

KXYZ–LEVKXYZ–INP

1 VM1 7

1

Output Set — Preset

Category

MISC

Entry

0

Mnemnonic

X

Output

MCS–B

Lev Set Button

2

�

MISC 1 X MCS–A�

ButtonLev Set

1

Category

MISC

Entry

1

Mnemnonic

X

Output

MCS–A

Lev Set Button

2

3

�

MISC 0 X MCS–B�

VTR 3 X MCSBP�

Output Set — On air

TALLY1 MI–3040/T 000000284 5SI1

MCS–A

MCS–B

6 MCSBP

TALLY1 0 PROD1 TALLY1 /3

TALLY1 1 PROD2 TALLY1 /3

1

Tally Dependency

Tally Device

MCS_TLY

Opto

0

Output Tally

2

3

MCS_TLY 1

MCS_TLY

4

5

3 PRD1

Tally Relay

Tally Device

TALLY1

Relay Logical Input

Logical

Logical

Logical

Logical

Device
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PERMANENT DISPLAY OF MNEMONIC

To display a mnemonic on a permanent basis, use the MPK Devices table to assign an Input Set to the status display containing
only one input name and mnemonic.  See Figure 5–104.

SD3–NET 4 00000032 NET–INP NETMON KXYZ–LEVSD–3x1

MPK Devices

MPK Expansion Pass Board

VM1

Port Address Input Sets Output Sets Level Set Overide Set Sequence SetDevices word In Panel Out PanelDevice
Type

Figure 5–104.

1

Input Set — NET–INP

Category Entry Mnemonic Logical

2

Net 1 NET NETIN

Auto
Mnem Input

The Output Set entry is not used in this application; however, the name of an actual Output Set (or Output) must be entered
to satisfy the compiler.

On the Input Set table, the Input field must be the name of an actual input.
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EXTERNAL CONTROL DEVICE ENTRIES

Note: Even though they are not shown on the Serial Protocol table as MPK devices, “ESswitch,” ASCII, DD, and
GVG200 control devices require entries to the MPK Devices table.

DD SERIES SWITCHERS

Hardware installation was discussed on page 2–76; serial port configuration was discussed on page 5–25. Figure 5–105 shows
an example table for the system on page 2–76.

DIA–MNEM DIAMOND SI3 4 DIA–INP DIA–OUT

DIA–ASCI SERIAL SI3 ASC–INP ASC–OUT

1

MPK Devices

MPK
Expansion

Pass
Board Port Address Input Sets Output Sets Level Set Overide Set Sequence Set

2 6 KXYZ–LEV

Devices word In Panel Out Panel

KXYZ–LEV

Figure 5–105. Entry for system shown on page 2–76.

Device
Type

The dual entries are necessary because of the two hardware connections.

No “Address” entry is required.

The Input, Output, and Level Sets named on this table should include all inputs, outputs, and levels that will be controlled
by the Diamond switcher. As a precaution, you may wish to restrict control to selected outputs.

For device Type “Diamond,” the Input and Output Sets must be created specifically for use by E–MEM devices. The Input
Set is the source of the mnemonics that will appear on the Diamond console. The Output Set contains a cross–reference be-
tween each router output wired to the DD switcher and a number that the DD will use to refer to that output.

Notice that device Type “Serial” is used for the “ASCII” protocol connection. For device Type “Serial,” the Input and Output
Sets must be created specifically for use by “serial” devices: the Input Set describes which router inputs can be selected by
the DD (and a number that the DD will use to refer to that input); the Output Set describes which router outputs are wired
to the DD (and a number that the DD will use to refer to that output).

For details concerning CP Input Sets, see page 5–58.

For details concerning CP Output Sets, see page 5–76.

For details concerning CP Level Sets, see page 5–55.
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THOMSON BROADCAST AUTOMATION SYSTEMS – SERIAL CONTROL

Hardware installation was discussed on page 2–77; serial port configuration was discussed on page 5–28. Figure 5–106 shows
an example table for the system on page 2–77. Note that no MPK address is required.

MSL4000 Serial SI3 13 ALAM–INP ALAM–OUT1

MPK Devices

MPK
Expansion

Pass
Board Port Address Input Sets Output Sets Level Set Overide Set Sequence Set

2

KXYZ–LEV

Devices word In Panel Out Panel

Figure 5–106. Entry for automation system shown on page 2–77.

Device
Type

The MSL 4000 can use the same CP Level Set that all the control panels use as long as the levels the automation system needs
to control are defined. CP Level Sets are discussed in detail starting on page 5–55.

The MSL 4000 uses a “Serial” type CP Input Set (page 5–58) and a “Serial” type CP Output Set (page 5–76). 

COMPUTERS USING “ESSWITCH” ROUTING SWITCHER DIALECT OR 
THOMSON ASCII PROTOCOL

Hardware installation was discussed on page 2–79; serial port configuration was discussed on page 5–25. Figure 5–107 shows
an example table for the system in Figure 2–92 on page 2–79. Note that no MPK address is required.

PC–OUTSWITCHPC SERIAL SI3 9 PC–INP KXYZ–LEV1

MPK Devices

MPK
Expansion

Pass
Board Port Address Input Sets Output Sets Level Set Overide Set Sequence SetDevices word In Panel Out Panel

Figure 5–107. Entry for system shown in Figure 2–92 on page 2–79.

Device
Type

The Input, Output, and Level Sets named on this table should include all inputs, outputs, and levels that will be controlled
by the external control computer. As a precaution, you may wish to restrict computer control to selected outputs.

The Input (page 5–58) and Output (page 5–76) sets must be created specifically for use by “serial” devices.

The Level Set must be created as a type “CP–3000” (see page 5–55.) For an important note about level numbering and external
computer control, see page 5–57.
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MODEL 200 PRODUCTION SWITCHERS

Hardware installation was discussed on page 2–81; serial port configuration was discussed on page 5–29. Figure 5–108 shows
an example table for the system on page 2–81.

GVG GVG200 SI3 2 00000023 GVG–INP GVG–OUT KXYZ–LEV1

MPK Devices

MPK
Expansion

Pass
Board Port Address Input Sets Output Sets Level Set Overide Set Sequence SetDevices word In Panel Out Panel

Figure 5–108. Entry for system shown on page 2–81.

Device
Type

The “Address” shown on this table may appear to be the address of the production switcher, but is in fact the address of the
VM/SI 3000 on the Peripheral bus. This address must be a number between 000000000 and 00000023.

The CP Input (page 5–58) and Output (page 5–76) sets must be created specifically for use by “E–MEM” devices.

Configuration – Production Switcher

The Peripheral bus and the VM/SI 3000 must be enabled from the production switcher:

“From the [production] switcher operator’s viewpoint, the PERIPH ENABLE pushbutton on the Model 200 panel
must be ON to enable communication over the Peripheral Bus. Specific peripherals are enabled or disabled for
participation in the E–MEM Learn [or Recall] via the MISC menu in the STREAMLINE control panel. This menu
contains the selections for turning any or all of the 24 possible peripherals ON or OFF. After the operator has made
these selections, the [production] switcher’s internal software generates the correct peripheral Learn [or Recall]
command data and transmits it over the Peripheral Bus whenever the operator sets up an E–MEM Learn [or Recall]
of the USER PGM level and presses an E–MEM register pushbutton.”†

For the example shown in Figure 5–108, peripheral number 23 would have to be enabled.

Refer to the Model 200 production switcher manual for additional installation and operating instructions.

† Model 200 Peripheral Interface II Protocol and Dialect (Grass Valley Group Manual Number TP0424–00, June 1988) , p.
3–3.
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CP 3830 DUAL CONFIGURATION

Dedicated Output Panel

Dual CP 3830 panels can be configured so that the second panel is always used for output selection. The output panel’s buttons
will glow amber.

MPK bus

VM 3000 
“VM1”

CP 3830
“CP3830IN”

CP 3830
“CP3830OU”

Dedicated
output panel

Figure 5–109.

CP3830IN CP–3830 2 00000042

CP3830OU CP–3830 2 00000043

1

MPK Devices

MPK
Expansion

Pass
Board

VM1

Port Address Input Sets Output Sets Level Set Overide Set Sequence Set

2 VM1

KXYZ–INP

KXYZ–OUT KXYZ–LEV

Devices word In Panel Out Panel

KXYZ–LEVKXYZ–OUT

Figure 5–110. Entry for system shown in Figure 5–109.

CP3830IN

Device
Type

Do the following to connect two CP 3830 panels together with one being an input panel and the other being an output panel:

1. The Expansion box must be unchecked for both the input and output CP 3830.

2. The Output Set should be the same for both panels. The compiler requires the LEV SET field to be defined.

The CP 3830 input panel can be independent of the output CP 3830. The output CP 3830 can still change the output
for the input CP 3830 by selecting the new output name and doing a TAKE.

3. The CP 3830 that is defined as the output panel must have the name of the associated CP 3830 selected in the “Out Panel”
field (e.g., CP–3830IN).
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CP 3832 / 3864 MULTI–PANEL APPLICATIONS

Except for unbalanced split§ configurations, CP 3832 and CP 3864 panels can be combined to increase the number of sources
and destinations to a maximum of 128 x 128.

SINGLE–BUS APPLICATION

128 X 1 control station

MPK bus

VM 3000 
“VM1”

Main
CP 3864

“CP3864A”

Input button 1

Expansion
CP 3864

“CP3864B”

Input button 65

Figure 5–111.

CP3864A CP–3864 2 00000043 3832–IN MON–1

CP3864B CP–3864 2 00000044

1

MPK Devices

MPK
Expansion

Pass
Board

VM1

Port Address Input Sets Output Sets Level Set Overide Set Sequence Set

2 VM1

KXYZ–LEV

Devices word In Panel Out Panel

Note: Assignment of specific CP sets to a panel
identifies it as the “main” panel, i.e., the panel with
input button number 1.

Figure 5–112. Entry for system shown in Figure 5–111.

CP3864A

Device
Type

In this example, two CP 3864s are being operated as a 128 x 1 control station.

The top CP 3864 has been selected as the “main” panel; therefore it will be assigned to specific CP sets. Enter the name of
the CP Input Set that will be used to assign inputs to all the buttons at this control station (for more information about CP Input
Sets, see page 5–58). In the “Output Sets” column, enter the name of the output to be controlled. The main panel will always
have the lowest–numbered input buttons.

Any panel used to expand the number of inputs (the bottom CP 3864 in this example) will use the “In Panel” column to select
the MPK Device name of the main panel. It would use the CP sets assigned to the main panel. The first expansion panel listed
in this table will have the button numbers immediately following those of the main panel; in this example panel “CP3864B”
will have button numbers 65–128.

MPK Device table entries for other CP 3832/64 applications was discussed on page 5–110 and following.

§ For a discussion of balanced and unbalanced split configurations, see page 2–58.
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X–Y APPLICATION (WITH BALANCED SPLIT PANEL)

48 X 16 control station

Hardware installation was discussed on page 2–58. Figure 5–114 shows an example MPK Devices table for the system in
Figure 5–113.

MPK bus

VM 3000 
“VM1”

Input button 17 Expansion CP–3832
“CP3832IN”

Main CP–3832
“CP3832S”

48
sources

16
destinations

Input button 1

Figure 5–113.

CP3832IN CP–3832 2 00000043

CP3832S CP–3832 2 00000044 3832–IN 3832–OUT

1

MPK Devices

MPK
Expansion

Pass
Board

VM1

Port Address Input Sets Output Sets Level Set Overide Set Sequence Set

2 VM1 KXYZ–LEV

Devices word In Panel Out Panel

Note: Assignment of specific CP sets to a panel
identifies it as the “main” panel; i.e., the panel with
input button number 1.

Figure 5–114. Entry for system shown in Figure 5–113.

CP3832S

Device
Type

In this example, the top CP 3832 is being operated as a source expansion panel. In the MPK table, use the “In Panel” column
to select the MPK Device name of the main panel (the bottom CP 3832 in this example). Any additional source panels would
also refer to the “CP–3832S” in their In Panel column; they would use the CP sets assigned to the main panel.

The bottom CP 3832 is being operated in split mode, so the “Expansion” box is checked. The CP 3832 is considered to be
the main panel because it is being used in split mode; therefore it will be assigned to specific CP sets. Enter the name of the
CP Input and CP Output Sets that will be used to assign inputs and outputs to all the buttons at this control station. The main
panel will always have the lowest–numbered input buttons.

If additional panels are added to provide more destinations, they would refer to the “CP–3832S” in their Out Panel column.
They would use the CP sets assigned to the main panel. The first expansion panel listed in this table will have the button num-
bers immediately following those of the main panel; the next expansion panel listed will have the next higher set of button
numbers, etc.

The button numbers shown in Figure 5–113 correspond to the row numbers of the CP Input and Output Sets. See page 5–58
(CP Input Sets) and page 5–76 (CP Output Sets). MPK Device table entries for other CP 3832/64 applications was discussed
on page 5–110 and following.
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X–Y APPLICATION (NO SPLIT PANEL)

64 X 32 control station

MPK bus

VM 3000 
“VM1”

Destination Panel
“CP3832”

64
sources

32
destinations

Source (Main) Panel
“CP3864”

Figure 5–115.

CP3864 CP–3864 2 00000043 3832–IN 3832–OUT

CP3832 CP–3832 2 00000044

1

MPK Devices

MPK
Expansion

Pass
Board

VM1

Port Address Input Sets Output Sets Level Set Overide Set Sequence Set

2 VM1

KXYZ–LEV

Devices word In Panel Out Panel

Note: Assignment of specific CP sets to a panel
identifies it as the “main” panel.

Figure 5–116. Entry for system shown in Figure 5–115.

CP3864

Device
Type

In this example, the CP 3864 is being operated as a source and “main” panel and the CP 3832 is being operated as a destination
panel.

The top CP 3864 is considered to be the “main” panel because it controls the inputs; therefore it will be assigned to specific
CP sets. Enter the name of the CP Input and CP Output Sets that will be used to assign inputs and outputs to all the buttons
at this control station. See page 5–58 (CP Input Sets) and page 5–76 (CP Output Sets).

Any additional source panels would refer to the main panel (the CP 3864 in this example) in their In Panel column. They
would use the CP sets assigned to the main panel. The first input expansion panel listed in this table will have the button num-
bers immediately following those of the main panel; the next input expansion panel listed will have the next higher set of
button numbers, etc.

For the CP 3832 in this example, use the Out Panel column to select the MPK Device name of the main panel. If additional
panels are added to provide more destinations, they would also refer to the main panel (the CP 3864) in their Out Panel col-
umn; they would use the CP sets assigned to the main panel. The first output panel listed in this table will have the lowest–num-
bered set of buttons; the next output panel listed will have the next higher set of button numbers, etc.

MPK Device table entries for other CP 3832/64 applications was discussed on page 5–110 and following.
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X–Y APPLICATION (NO SPLIT PANEL)

128 X 128 control station

MPK bus

VM 3000 “VM1”

CP 3864
“P3864Y1”

128
sources

128
destinations

CP 3864
“P3864X2”

CP 3864
“P3864Y2”

Main Panel
CP 3864

“P3864X1”

Input button 1

Input button 65

Output button 1

Output button 65

Figure 5–117.

P3864X1 CP–3864 00000043 3832–IN 3832–OUT

P3864X2 CP–3864 00000044

P3864Y1 CP–3864 00000045

P3864Y2 CP–3864 00000046

1

MPK Devices

MPK
Expansion

Pass
Board

VM1

Port Address Input Sets Output Sets Level Set Overide Set Sequence Set

2 VM1

KXYZ–LEV

3 VM1

4 VM1 2

Devices word In Panel Out Panel

2

2

2

Note: Assignment of specific CP sets to a panel identifies it as the “main” panel,
i.e., the panel with input button number 1. Beyond the main panel, button
numbering depends on the order in which panels are entered on this table.

Figure 5–118. Entry for system
shown in Figure 5–117.

P3864X1

P3864X1

P3864X1

Device
Type

In this example, the top two CP 3864s are being operated as source panels and the bottom two as destination panels.

The “main” panel is always an input panel. In this example, the top CP 3864 has been selected as the main panel and will
therefore be assigned to specific CP sets. Enter the name of the CP Input and CP Output Sets that will be used to assign inputs
and outputs to all the buttons at this control station. See page 5–58 (CP Input Sets) and page 5–76 (CP Output Sets).

Any additional source panels (CP 3864 “P3864X2” in this example) would refer to the main panel (the top CP 3864) in their
In Panel column. They would use the CP sets assigned to the main panel. The first input expansion panel listed in this table
will have the button numbers immediately following those of the main panel; the next input expansion panel listed will have
the next higher set of button numbers, etc.

All destination panels use the Out Panel column to select the MPK Device name of the main panel; they would use the CP
sets assigned to the main panel. The first output panel listed in this table will have the lowest–numbered set of buttons; the
next output panel listed will have the next higher set of button numbers, etc. MPK Device table entries for other CP 3832/64
applications was discussed on page 5–110 and following.
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CP 3810 APPLICATIONS 

The optional CP 3810 panel can be associated with a CP 3832, CP 3864, CP 3808, or CP 3830, providing control of up to
80 output buses. The CP 3810 can also be assigned to one output, providing breakaway (split) switching and/or multi–level
status.

Multi–Bus Control

In the example shown in Figure 5–119, a CP 3832 is being used to select 32 inputs while the CP 3810 is used to select 80
outputs.

MPK bus

VM 3000 
“VM1”

CP 3832
“CP3832”

CP 3810
“CP3810”

32
sources

80 destinations
(8 windows X 10 pages)

Figure 5–119.

CP3832 CP–3832 2 00000043 3832–IN 3832–OUT

CP3810 CP–3810 2 00000044

1

MPK Devices

MPK
Expansion

Pass
Board

VM1

Port Address Input Sets Output Sets Level Set Overide Set Sequence Set

2 VM1

KXYZ–LEV

Devices word In Panel Out Panel

Figure 5–120. Entry for system shown in Figure 5–117.

CP3832

Device
Type

Notice that the Expansion boxes for both panels are unchecked.

Main panel entries — In this example, a CP 3832 is the “main” panel and is therefore assigned specific CP sets. In the “Input
Set” column, enter the name of the CP Input Set that will be used to assign inputs to the main panel (for more information
about CP Input Sets, see page 5–58). In the “Output Set” column, enter the name of the CP Output Set that will be used to
assign outputs to the CP 3810 (for more information about CP Output Sets, see page 5–76).

Note: Even when associated with a CP 3810, the main panel is still configured independently and can be operated
independently. In this example, the CP 3832 will operate as a single–bus control panel (because Expansion  = No).
The CP 3832 will be assigned to the first output listed in CP Output Set “3832–OUT.”

CP 3810 entries — In the “In Panel” column, enter the name of the main panel. CP 3810S (“sticky outputs”) entries are similar
to the CP 3810, except the Device Type is “CP–3810S.”

For operating instructions, see page 6–126.
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Single Bus Control (“CP 3810L”)

In the example shown in Figure 5–121, a CP 3832 is used to select inputs and a CP 3810 is used to control the individual levels
of one output. The CP 3810 can thus be used for breakaway switching.

The corresponding MPK table entries are shown in Figure 5–122.

MPK bus

VM 3000 
“VM1”

CP 3832
“CP3832”

CP 3810
“CP3810”

32
sources

Levels for 1
destination

Figure 5–121.

CP3832 CP–3832 2 00000043 3832–IN VT01

CP3810 CP–3810L 2 00000044 CP3832

1

MPK Devices

MPK
Expansion

Pass
Board

VM1

Port Address Input Sets Output Sets Level Set Overide Set Sequence Set

2 VM1 KXYZ–LEV

Devices word In Panel Out Panel

KXYZ–LEV
†

Figure 5–122. Entry for system shown in Figure 5–121.

Device
Type

Notice that the Expansion boxes for both panels are unchecked.

Main panel entries — In this example, a CP 3832 is the “main” panel and is therefore assigned specific CP sets. In the “Input
Set” column, enter the name of the CP Input Set that will be used to assign inputs to the main panel (for more information
about CP Input Sets, see page 5–58). In the “Output Set” column, enter the name of the output that will be controlled.

Note: Even when associated with a CP 3810, the Main panel is still configured independently and can be operated
independently. In this example, the CP 3832 will operate as a single–bus control panel (because Expansion = No).

For the CP 3810, select Device Type “CP–3810L.” Enter the name of the Main panel in the Input Set column.

For operating instructions, see page 6–126.

† Data not used, but entry must be present to satisfy compiler.
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X–Y Application

In the example shown in Figure 5–123, a CP 3864 is used to select inputs, a CP 3832 is used to select outputs, and a CP 3810
is used to control/status the individual levels of the output selected by the CP 3832. The CP 3810 can thus be used for break-
away switching.

CP 3832
“CP3832”

CP 3810
“CP3810”

32
destinations

64
sources

STATUS
of individual levels

CP 3864
“CP3864”

MPK bus

VM 3000 
“VM1”

Figure 5–123.

CP3832 CP–3832 2 00000044

CP3810 CP–3810L 2 00000045

CP3864 CP–3864 2 00000043 3832–IN 3832–OUT1

MPK Devices

MPK
Expansion

Pass
Board

VM1

Port Address Input Sets Output Sets Level Set Overide Set Sequence Set

2 VM1

KXYZ–LEV

3 VM1 KXYZ–LEV

Devices word In Panel Out Panel

†

Figure 5–124. Entry for system shown in Figure 5–117.

CP3864

CP3864

Device
Type

Notice that the Expansion boxes for all panels are unchecked.

Main panel entries — In this example, a CP 3864 is used to select inputs and is therefore the “main” panel. As such, it is as-
signed specific CP sets, as follows: In the “Input Set” column, enter the name of the CP Input Set that will be used to assign
inputs to the main panel (for more information about CP Input Sets, see page 5–58). In the “Output Set” column, enter the
name of the CP Output Set that will be used to assign Outputs to the destination panel CP 3832 (for more information about
CP Output Sets, see page 5–76).

Destination panel entries — In the Out Panel column, select the name of the main panel.

CP 3810 entries — Select “CP 3810L” as the device type. In the In Panel column, select the name of the main panel.

For operating instructions, see page 6–126.

† Data not used, but entry must be present to satisfy compiler.
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Single Bus Status Only (Stand–alone) (“CP–3810L”)

In this mode, the panel is configured to status a single output. No other panel is associated with the panel. and there is no
switcher control. An example entry is shown in Figure 5–126.

MPK bus

VM 3000 
“VM1”

CP 3810
“CP3810”Levels for 1

destination

Figure 5–125.

CP3810 CP–3810L 2 00000044 3832–IN VT01 KXYZ–LEV1

MPK Devices

MPK
Expansion

Pass
Board

VM1

Port Address Input Sets Output Sets Level Set Overide Set Sequence SetDevices word In Panel Out Panel

Figure 5–126.

Device
Type

Select “CP–3810L” as the device Type. In the Output Set column, enter the name of the output to be statused.

For operating instructions, see page 6–126.
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Machines

hexadecimal

1

Machines

2

VT01 Sony Mch SI1 1

VT05 Ampex Mch SI1 7 80A2

Figure 5–127. Machines table for system shown on page 5–143.

Name Type Board Port AddressMachine Device

Password 5–17

Network Description 5–22
Serial Protocol 5–25

Switcher Description 5–31
Switcher Input 5–44
Switcher Output 5–51

Control Panel Sets
Level set 5–55
Input set 5–58
Output set 5–76
Override set 5–98
Sequence set 5–101
Category set 5–103

MPK Devices 5–108

Machines 
Protocol Dependent 5–144
Machine Control 5–148
Delegation Groups 5–161

TCS–1 Device Codes 5–168
Party Line 5–169

Status Display Header 5–172
VGA Status Display 5–173

Tally 5–174

Path Finding 5–196

Exclusion 5–210
Y Line 5–211

This table is the source for information about machines using Sony or Ampex serial protocol. Data entered here is automatical-
ly made available on the Machine Control table.§

Important:  Row numbers on Jupiter tables are used as the “logical” numbers for devices. Changing the row num-
ber of an existing device (by inserting/deleting a device in the middle of the table, for example) will disrupt con-
trol of the machine, requiring linkages to be reestablished. One way to avoid this interruption is to add new de-
vices at the end of tables.

Name This column lists the device names of all serial control machines in the system. 

This is the source for machine names that appear on the control panels. Although this field will accept eight
characters, you may wish to limit machine names to four since that is the maximum that can be displayed on
the MC 3000’s expansion panel.

§ Some of the functions described in this section may be extra–cost options. For more information, see page 1–27.



Configurator Machines Table

5–142 VM 3000 Installation and Operating Manual

Type Device types (shown on a pull–down menu) are limited to the following:

� Sony machine serial protocol

� Ampex machine serial protocol

Note 1: Machines controlled with parallel connections to an MI 3040 are not entered on this table; they are
entered instead on the Machine Control table (pages 5–148 and 5–159).

Note 2: Machines that use TCS or ESbus protocol are entered on the Protocol Dependent Devices table (page
5–144).

Board Select the name of controller board connected to this machine. The source of these names is the Net-
work Description table (page 5–22).

Port Number of controller board port connected to this machine. The port must support the necessary proto-
col for this machine (as configured on the Serial Protocol table, page 5–25).

Address  (hex) Unique serial data bus ID used to select and service this machine, entered in hexadecimal.
(Not to be confused with LAN address entered on Network Description table shown on page 5–22.)

VTR addresses

— not required for Sony “serial” VTRs (as listed on page 2–83).

— required for Ampex “serial” VTRs. The address “80A2” is the usual factory setting. “Daisy–
chaining” Ampex VTRs (not presently recommended) would require changing these addresses in
the VTR itself.
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Sony Mach “VT01”
Address: none

Ampex Mach “VT05”
Address: 80A2 hex

CP with EXP. “TAPECP”
Address: 00000008 hex

MC with EXP. “TAPEMC”
Address: 00000016 hex

“SI1”

Ampex protocol

MPK protocol

Sony protocol

Figure 5–128. VTRs as listed in Machines table on page 5–141. (Ma-
chine control panels are listed in MPK table on page 5–108.)
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Protocol Dependent Devices

hexadecimal

Protocol Dependent Devices

Device Board Port Address

1

2

VT04 TCS1–MI SI1 4 40

VT10 ES–Mch SI1 10 00001000

Figure 5–129. Protocol Dependent Devices
table for system shown on page 5–146.

Name
Device
Type

Password 5–17

Network Description 5–22
Serial Protocol 5–25

Switcher Description 5–31
Switcher Input 5–44
Switcher Output 5–51

Control Panel Sets
Level set 5–55
Input set 5–58
Output set 5–76
Override set 5–98
Sequence set 5–101
Category set 5–103

MPK Devices 5–108

Machines 5–141
Protocol Dependent 
Machine Control 5–148
Delegation Groups 5–161

TCS–1 Device Codes 5–168
Party Line 5–169

Status Display Header 5–172
VGA Status Display 5–173

Tally 5–174

Path Finding 5–196

Exclusion 5–210
Y Line 5–211

This table is used for initial entry of special protocol control devices and machines using “Alamar” (Thomson Broadcast Au-
tomation), “ESbus,” and “TCS” protocols. Data entered here is automatically made available on the Machine Control table.

Important:  Row numbers on Jupiter tables are used as the “logical” numbers for devices. Changing the row num-
ber of an existing device (by inserting/deleting a device in the middle of the table, for example) will disrupt con-
trol of the machine, requiring linkages to be re–established. One way to avoid this interruption is to add new de-
vices at the end of tables.

§ Some of the functions described in this section may be extra–cost options. For more information, see page 1–27.
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Device Name This column lists the device names of all Thomson Broadcast Automation, ESbus, and TCS de-
vices in the system.

This is the source for machine names that appear on the control panels. Although this field will accept eight
characters, you may wish to limit machine names to four since that is the maximum that can be displayed on
the MC 3000’s expansion panel.

Device Type Device types (shown on a pull–down menu) are limited to the following:

Alamar
ESbus machine

ESbus panel
TCS–1 control panel

TCS–2 control panel
TCS–1 machine interface

For more information concerning Alamar (Thomson Broadcast Automation), refer to the
documentation supplied with the automation system.

A TCS1–CP entry means that the device uses TCS 1 Machine Control System control panel
protocol. For MCS 2000 master control switchers, the newer TCS2–CP control panel proto-
col should be used if possible. Machines must use the TCS1–MI machine interface protocol.

Board Port Name of controller board and number of port connected to this device. The source of these names
is the Network Description table (page 5–22). The port must support the necessary protocol for this device (as
configured on the Serial Protocol table, page 5–25).

Address  (hex) Unique serial data bus ID used to select and service this device. Must be entered in hexadeci-
mal. (Not to be confused with LAN address entered on Network Description table shown on page 5–22).

Control panel addresses such as “00000018” are determined at time of panel manufacture
but can sometimes be changed by the operator (depending on the panel type). A control
panel address is not required for TCS 1 and MCS 2000 panels.

VTR addresses

—required for Betacart using TCS 1 MI–8B or BBC 2300 interface (page 2–90). Re-
quired for other VTRs using TCS 1 interfaces (as shown on page 2–89). Device addresses
entered on this table are always hexadecimal; and since the highest device number that can
be set in an TCS interface is decimal 99, the highest possible entry on the table in this case
would be 63 hexadecimal. (A decimal–hexadecimal–binary table is shown in Appendix D.)
The source of this address is a DIP switch within the interface. 

—required for ESbus VTRs.
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ES–bus protocol

TCS1–MI “VT04” 
Address: 40 hex

ES Bus Mach “VT10”
Address: 00001000 hex

TCS1 protocol

MI–2003

“SI1”

Figure 5–130. Machine control devices listed in table on page 5–129.

SATURN MASTER CONTROL SWITCHER

Saturn machine control configuration instructions are described in the Saturn Installation and Operating manual. 
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Machine Control

Figure 5–131. 

Password 5–17

Network Description 5–22
Serial Protocol 5–25

Switcher Description 5–31
Switcher Input 5–44
Switcher Output 5–51

Control Panel Sets
Level set 5–55
Input set 5–58
Output set 5–76
Override set 5–98
Sequence set 5–101
Category set 5–103

MPK Devices 5–108

Machines 5–141
Protocol Dependent 5–144
Machine Control 
Delegation Groups 5–161

TCS–1 Device Codes 5–168
Party Line 5–169

Status Display Header 5–172
VGA Status Display 5–173

Tally 5–174

Path Finding 5–196

Exclusion 5–210
Y Line 5–211

1

Machine Control

Device Name Device Type Delegation In/Out Associated

2

TAPEMC MC–3000E Out PRDA

3

Mnemonic

TAPEMC

VT01 Sony Mch In VT01

VC01 Sony Mch In VC01

VC02 Sony Mch In VC02

4

Group Name

VT01

VC01

VC02

TAPEMC MC–3000E Out PRDBTAPEMC5

TAPEMC MC–3000E Out PRDCTAPEMC6

TMC3010 MC–3010 Out PRDXTMC30107

Preroll

2

2

2

This table is used to associate machines, machine controls, and router inputs/outputs in order to provide control panel group
delegation and automatic machine assignment functionality (“control follows video”).§ It is also used when a PC is used as
a Software Control Panel.† 

Important:  Row numbers on Jupiter tables are used as the “logical” numbers for devices. Changing the row num-
ber of an existing device (by inserting/deleting a device in the middle of the table, for example) will disrupt con-
trol of the machine, requiring linkages to be reestablished. One way to avoid this interruption is to add new de-
vices at the end of tables.

§ Some of the functions described in this section may be extra–cost options. For more information, see page 1–27.
† Applies only when the Software Control Panel is used for machine control. For more information, see Section 7.
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Device Name Device Type     These columns repeat the descriptions of all machines (as entered on
the Machines table, page 5–141) and machine control panels (as entered on the MPK Devices table, page
5–108). Also repeated here are special protocol devices from the Protocol Dependent table (page 5–144), and
MI/MC 3040 devices from the MPK table.

Mnemonic
Use of this column varies according to the device type.

For machines, this entry will appear on the panel controlling the machine:

� For a serial control machine, the Mnemonic is always the same as the Device Name.

� For a parallel control machine connected to an MI 3040, the Mnemonic column is used to create a
mnemonic for the machine.

For control panels and MC 3040 external machine control panel applications, the Mnemonic column is used
only as a comment field.

Delegation
Group

  This column is used to select a delegation group for assignment to a control panel. This allows a
machine operator to use the optional MC 3020 Delegation Panel to permit control of a particular machine by a
particular control panel. This function is explained in detail starting with Group Delegation on page 5–161.

The source of the Group names is the Delegation Group table (page 5–161).

Associated
Name

In/Out
  These entries are required for the machine assignment system to function, whereby

machine control “follows” the routing switcher.

For machines, the entry in the In/Out column is always “In.” The Associated Name will be selected from a list
of all router inputs (source = Switcher Input table, page 5–44). For a discussion of Associated Name entries,
please see Assigning Machines to Control Panels starting on page 5–151.

For a CP 3000E, CP 3800, or CP 3810, the entry in the In/Out column is “Out.” The Associated Name col-
umn is left blank.

For a complete description of MC 3000 and MC 3010 entries, please see Assigning Machines to Control
Panels starting on page 5–151.



Configurator Machine Control Table

5–150 VM 3000 Installation and Operating Manual

Preroll Number of seconds needed by this machine to come up to speed following a Play command. Most
machines will lock up in one second or less; two seconds is often used as a preroll value to provide a safety
margin. This value is used by the MC 3000 Machine Control Panel, Saturn Master Control Switcher, and
MCS 2000 Master Control Switcher. Only machines, MI–3040/2, MI–3040/4, and MI–3040/8 can have
preroll.

The Saturn, MC 3000, and MCS 2000 use this setting during Mark/Search operations. When SET MARK is
pressed, the present time code is stored; when SEARCH MARK is pressed, the machine will move the tape to
that point minus the preroll value. If there is no entry to the Machine Control Devices table, a two–second
preroll will be used automatically. Note: The Saturn and MCS 2000 both allow temporary override of the
Preroll vale; in this case, the value entered on the Machine Control Devices table is ignored during the next
transition.

For more information, see page 6–132 and Appendix E.

SATURN MASTER CONTROL SWITCHER

Saturn machine control configuration instructions are described in the Saturn Installation and Operating manual. 
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ASSIGNING (LINKING) MACHINES TO CONTROL PANELS

The Jupiter system has an automatic machine assignment function, whereby control of a VTR is linked to a remote panel based
on the VTR being switched to a destination associated with that panel. In other words, machine control follows the routing
switcher.

Note 1: The MCS 2000 Master Control switcher, if installed in the system, bypasses the machine linkage process
described below. The normal MCS 2000 machine control functions, as described in the MCS manual, still apply.

Note 2: The GUI machine control panel, if installed in the system, also bypasses the machine linkage process de-
scribed below.

Note 3: If the system includes MC 3020 Delegate Panels, machines must be both linked and delegated to control
panels. Please refer to Delegation Groups on page 5–161 for more information.

Note 4: As described on page 5–157, it is possible to link machines to control panels even if those machines do not
pass through the routing switcher. However, this will still require an understanding of the “follow–the–switcher”
technique described below.

Note 5: As a further variation, the “follow switcher” scheme can be bypassed entirely:

— Machines can be assigned by default to specific control panels on a semi–permanent basis. See page 5–156.

— Machines can be assigned to specific control panels with an MC 3020L Linkage Panel. See page 2–67.

Summary of linkage system setup:

� The switcher inputs, outputs, category names/numbers, etc. must already be established.

� Each machine must be connected to a VM/SI 3000 Control Processor and the protocol for the bus leading to the
machine established. See page 5–152 for an example system.

� All machine control panels are described. In most cases, this is done using the MPK Devices table.

� The device names of all VTRs must be established on the Machine table (page 5–141).

� The Machine Control table is then used to associate machines and control panels to the router:

— The table must show the names of the routing switcher outputs which are wired to the destination (a pro-
duction switcher, in this example) that is associated with a particular machine control panel.

— The table must include the routing switcher input names associated with each VTR.

The linkage setup procedure is described in detail on the following pages.
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Figure 5–132. Example of machine control linkage. Equipment shown here corresponds to table shown in Figure 5–133.

VT01 VC01 VC02

PRDC

PRDB

PRDA

Production switcher 1

A B C D

“VT01”

“VC01”

“VC02”

Routing
Switcher

“TAPEMC”

MC–3000

CP–3000

VC01VT01

Button groups

video and audio

control lines

software links

Input names

Output names

VC02

MC–3010

“TMC–3010”

Production switcher 2

X Y Z

PRDX

SI 3000 “SI1”

3

1 2

6



ConfiguratorMachine Control Table

5–153VM 3000 Installation and Operating Manual

EXAMPLE OF MACHINE CONTROL TABLES SETUP

1

Machine Control

Device Name Device Type Delegation In/Out Associated

2

TAPEMC MC–3000E Out PRDA

3

Mnemonic

TAPEMC

VT01 Sony Mch In VT01

VC01 Sony Mch In VC01

VC02 Sony Mch In VC02

4

Group Name

VT01

VC01

VC02

1

Machines

2

VT01 Sony Mch SI1 1 2

VC01 Sony Mch SI1 2 2

MPK Devices

MPK
Expansion

Pass
Board Port Address Input Sets Output Sets Level Set Overide Set Sequence Set

2 TMC3010 MC–3010 SI1 6 00000029

Devices word In Panel Out Panel

1 TAPEMC MC–3000E SI1 6 00000016

3 VC02 Sony Mch SI1 3 2

TAPEMC MC–3000E Out PRDBTAPEMC5

TAPEMC MC–3000E Out PRDCTAPEMC6

TMC3010 MC–3010 Out PRDXTMC30107 Figure 5–133.

Device
Type

Name Type Board Port Address Preroll
Machine Device

The Machine Control table shown in Figure 5–133 corresponds to the system shown in Figure 5–132. The applicable entries
in the MPK Devices and Machines tables are shown for reference.

The “Associated Name” is the name of the routing switcher input or output to be associated with this particular device.

The first three rows show the names of the machines in the system and the associated routing switcher input names.

The next three rows (4, 5, and 6) relate to the SELECT buttons on the MC 3000 expansion panel; the order of entry on this
table will be the same as the order of buttons on the panel. In this example, we want the first SELECT button to be assigned
to whatever VTR is feeding routing switcher output “PRDA;” this is the output that feeds input A of the production switcher.
Associated names are also entered for the following two SELECT buttons: “PRDB” and “PRDC.”

The next row (7) is similar to the entries just described, but pertains to the MC 3010 Dual 4 Machine Control panel. Again,
the order of entry on this table will be the same as the order of button groups on the panel.

Given this table, Figure 5–132 shows what will happen when the indicated routing switcher crosspoints are closed. For exam-
ple, the VTR “VT01” is shown switched to input A of the production switcher; that is, routing switcher input VT01 has been
switched to output PRDA. The system will locate these two input/output names in the Machine Control table and find that
control of VT01 must be assigned to the first SELECT button on the MC 3000 expansion panel. The device name and status
for VT01 will be sent to the status displays indicating that control of the machine is now linked to this panel. (A detailed view
of the MC 3000 expansion panel displays is shown in Figure 5–134.)
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OPERATIONAL SEQUENCE FOR LINKAGE

Figure 5–134 shows a detailed view of the CP 3000 and MC 3000 control panels previously shown in Figure 5–132 and listed
in Figure 5–133.

The objective in this example is to use the CP 3000 switcher control panel to assign VTR “VT01” as the “A” input to the
control room’s production switcher, and thereby link the machine to the MC 3000 Machine Control Panel.

For this discussion, it is assumed that switcher output PrdA has already been assigned to the first TAKE key of the CP 3000
expansion panel (the output assignment procedure is described on page 6–24).

� SELECT source. The operator presses “VTR,” then “1” on the CP 3000.

� TAKE to destination. Operator selects production switcher input “A” as the destination by pressing the first TAKE key
on the expansion panel.

 This will cause two things to happen:

— The VTR will be switched into the production switcher as “input A”, and the CP 3000 expansion panel will
show the display mnemonic for the VTR (“VT01”) in the status window.

— The system will check the Machine Control table (Figure 5–133) to see what control panel is associated with
the production switcher. At this point the link is established: the device name of the VTR, which is  “VT01,”
appears over the first SELECT button on the expansion panel next to the MC 3000 machine control panel, and
the status of the machine appears as well.

� The START and STOP buttons (immediately below the device name) can now be used to operate VT01. Or:

� Press SELECT key to assign control of the VT01 to MC 3000 panel to the left.

The full status of VTR VT01, including time code, will appear in the MC 3000 display window.

� CONTROL all functions of  VT01 using MC 3000.

If a different VTR is switched to production switcher input A, control of the new VTR will be brought to the MC 3000 machine
control panel at the same time. In other words, no matter what VTR is selected as input “A,” a control command entered on
the first button group of the expansion panel will be sent to the correct VTR.

It should be noted that this is the only way to gain control of a machine: it must be done by first selecting the machine with
the switcher. This is true even if the machine does not actually pass through the switcher, as described on page 5–157.
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CP–3000 Switcher control

Expansion panelMC–3000 Machine control

Expansion panel

SELECT source

TAKE to
destination

CONTROL all functions of machine
selected by expansion panel

Production switcher

A B C

A B C

VT01
PrdA

VC01
PrdB

Identifies machines selected as
sources for production switcher

A B C

START and
STOP machine

SELECT machine
to be controlled by
MC–3000. Note
asterisk next to
machine name

Machine control linkage
follows routing switcher

VC02
PrdC

STOP
VC01

STOP
VC02

��

�

�

Switcher input name

Switcher output nam

Status
Machine name

STOP
�VT01

CAT=VTR  SELECT=VT01
VT01 VT01 VT01 VT01

 00:54:49:11 T1
 VT01       STOP MAN

Figure 5–134. Example of automatic machine linkage sequence. Please see page 5–154 for discussion.
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DEFAULT (SEMI–PERMANENT) LINKAGE

Using the file server, machines can be linked directly to a specific control panel on a semi–permanent basis. An example sys-
tem is shown in Figure 5–135. In this arrangement, only the file server can re–assign control of a machine to another panel.
In other words, the normal linkage function (where machine control follows the routing switcher) is bypassed. The entries
needed on the Machine Control table are shown in Figure 5–136.

“VT01”

“VC01”

“VC02”

“TAPEMC”

MC–3000

VC02VC01VT01

SELECT buttons
control lines

software links established
by file server

SI 3000 “SI1”

3

1 2

6

Figure 5–135. Default machine control linkage.

Figure 5–136. Default linkage entries
for system shown in Figure 5–135.

1

Machine Control

Device Name Device Type Delegation In/Out Associated

2

TAPEMC MC–3000E Def VT01

3

Mnemonic

TAPEMC

VT01 Sony Mch In

VC01 Sony Mch In

VC02 Sony Mch In

4

Group Name

VT01

VC01

VC02

TAPEMC MC–3000E Def VC01TAPEMC5

TAPEMC MC–3000E Def VC02TAPEMC6
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LINKAGE FOR MACHINES THAT DO NOT ENTER THE ROUTING SWITCHER

In some cases, machines may be wired directly to one destination, or to several destinations through distribution amplifiers
only (see Figure 5–137). Although these machines do not pass through the routing switcher, it is still possible to use switcher
control panels to establish linkages. In order to do this, imaginary switcher input and output names must be used as pointers
on the Machine Control menu. These names, along with imaginary physical I/O numbers, must be entered on the Switcher
Input and Output tables (pages 5–44 and 5–51). Also, the physical I/O numbers must be within the size range set on the
Switcher Description menu (page 5–31).

Figure 5–137. Machine control linkage in system without routing switcher.

PRDC

PRDB

PRDA

Production switcher

A B C D

“VT01”

“VC01”

“VC02”

“TapeMC”

MC–3000

CP–3000

VC02VC01VT01

SELECT buttons

video and audio

control lines

software links

Imaginary routing
switcher input

names

Imaginary routing
switcher output

names

VC02

VC01

VT01

SI 3000 “SI1”

3

1 2
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START/STOP MACHINE CONTROL USING EXPANSION PANELS

The CP 3010 expansion panel and the CP 3810 expansion panel can be used as a limited–function machine control panels,
providing Start and Stop commands for VTRs.

When the CP 3010 is used as an expansion panel for a CP 3000 control panel, Start/Stop machine control is provided by the

 and >  buttons. When the CP 3810 is used as an expansion panel, Start/Stop machine control is provided by the  PLAY/
STOP buttons. In both cases, machine control will require the following:

— The switcher level that is checked as the “MC” level on the Switcher Description table (page 5–31) must be the
same as the first level shown in the CP Level set (page 5–55) that is assigned to the CP 3000 (or to the main
panel paired with the CP 3810) on the MPK Devices table (page 5–108). For example, the Video level would be
checked as the “MC” level, “Video” would appear as the first level in the CP Level set, and this CP Level Set
would be assigned to the main panel on the MPK Devices table;

and:

— The machine control buttons on the expansion panel must be assigned to the desired VTR by a process similar
to that described beginning on page 5–151.

VGA / MC 3000 STATUS DISPLAY TABLE ENTRIES

Use of control panels with the VGA Status Display requires entries to the MPK Devices table, as described on page 5–115.

For an MC 3000 to display time code it would have to be linked to the machine exactly as any other MC 3000. This would
require the following:

• Use of an “optional entry”on the Machine Control table, such as that shown in Figure 5–138. The Associated
Name could be the name of the switcher output connected to a nearby monitor.

• The switcher control panel would be used to switch video from the machine to the Associated output (the
nearby monitor, in this example). This would establish the link. Full status from the machine, including time
code, would then appear in the MC 3000 display window.

1

Machine Control

Device Name Device Type Delegation In/Out AssociatedMnemonic

VMC VMC–3000 Out VGMon

Group Name

VMC

Optional entry

Figure 5–138.

SATURN MASTER CONTROL SWITCHER

Saturn machine control configuration instructions are described in the Saturn Installation and Operating manual.
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MI 3040 GENERAL PURPOSE INTERFACE ENTRIES

Use of an MI 3040 for parallel control of machines requires entries to the MPK Devices table (as described on page 5–116)
and to the Machine Control table (Figure 5–139).

1

Machine Control

Device Name Device Type Delegation In/Out Associated

2

Mi1 MI–3040/2 In CRT2

3

Mnemonic

CRT2

MI2 MI–3040/2 In VT07

MI2 MI–3040/2 In VT08

MI1 MI–3040/2 In CRT1

4

Group Name

VT07

VT08

CRT1 Figure 5–139. Example of entries for
machines controlled by MI 3040s.

There are two MI 3040/2s shown in this example: one controls a pair of VTRs and the other a pair of audio cart machines.

The Device Names for the MI 3040s were already entered on the MPK Devices table; they are selected here from the drop–
down menu.

The Mnemonic column is used to create a mnemonic for each machine connected to the MI 3040. This is the source for the
machine name that appears on control panels.

Note: The Jupiter system identifies each machine according to the order of entry on this table. Therefore this order
must be the same as the hardware connections to the MI 3040. In this example, VT07 would be connected to ports
0 and 1 of the MI–3040 assigned to SI1; VT08 would be connected to ports 2 and 3 of the MI 3040 assigned to
SI1 (for system drawings, see pages 2–93 and 2–96). Audio cart CRT1 would be connected to ports 0 and 1 of the
MI 3040 connected to VM1; CRT2 would be connected to ports 2 and 3 of the MI 3040 connected to VM1 (see
page 2–96).

MC 3040 (MI 3040) ENTRIES

The following example applies to non–Thomson control panels or computers connected to an “MC–3040/4,” that is, an MI
3040 configured for four functions (Play, Stop, Ready, and Cue) on each of 10 control panels or devices.

If there is only one control panel (or computer), only a one–row entry would be required for this table.

Note: The Jupiter system identifies each control panel according to the order of entry on this table. Therefore this
order must be the same as the hardware connections to the MC 3040.

For system drawings, see pages 2–97 and 2–100. An entry must also be made to the MPK Devices table (page 5–117).

1

Machine Control

Device Name Device Type Delegation In/Out AssociatedMnemonic

MC3040 MC–3040/4 Out PRDA

Group Name

VT01

2 MC3040 MC–3040/4 Out PRDBVT02

3 MC3040 MC–3040/4 Out PRDCVT03

4 MC3040 MC–3040/4 Out PRDDVT10

5 MC3040 MC–3040/4 Out PRDECART

6 MC3040 MC–3040/4 Out PRDFMC3040

7 MC3040 MC–3040/4 Out PRDGMC3040

8 MC3040 MC–3040/4 Out PRDHMC3040

7 MC3040 MC–3040/4 Out PRDIMC3040

8 MC3040 MC–3040/4 Out PRDJMC3040

Figure 5–140. Example entries for
MC 3040.
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Delegation Groups

Configuring the MC 3020D Group Delegation Panel

1

Delegation Group

Name

MCS

2 STU

3 ENG

4 TAPE

Figure 5–141. Delegation groups menu (example).

Password 5–17

Network Description 5–22
Serial Protocol 5–25

Switcher Description 5–31
Switcher Input 5–44
Switcher Output 5–51

Control Panel Sets
Level set 5–55
Input set 5–58
Output set 5–76
Override set 5–98
Sequence set 5–101
Category set 5–103

MPK Devices 5–108

Machines 5–141
Protocol Dependent 5–144
Machine Control 5–148
Delegation Groups

TCS–1 Device Codes 5–168
Party Line 5–169

Status Display Header 5–172
VGA Status Display 5–173

Tally 5–174

Path Finding 5–196

Exclusion 5–210
Y Line 5–211

The MC 3020D Group Delegation Panel can be used to restrict control of a specific VTR to a particular control panel or panels.
Note that the MC 3020D does not actually connect a control panel to a machine; rather, it  allows the connection to be made
using the normal machine linkage procedures already described on page 5–151.

The Delegation Groups menu (Figure 5–141) is used to establish the names of the desired machine control panels or groups
of panels. The four groups shown in this example correspond to the control panels outlined in Figure 5–142. The order of
these entries will be the order of the buttons on all MC 3020D Machine Delegate Panels in the system (Figure 5–143).
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MPK Devices Table Entries

The MPK Devices table (Figure 5–144 on page 5–164) must be used to identify each MC 3020D in the system:

— In the panel–per–machine arrangement, the table is used to assign each MC 3020D to a specific machine. This
is done by assigning a unique “CP Output Set” to each panel, where each “Output Set” shows only the name of
a single machine. Each Output Set is of the type “MC 3020D.”

— In the central control location arrangement, only the name of the single MC 3020D would be entered along
with the name of a “CP Output Set” that is actually a list of the machines assigned to the CP 3020 Expansion
Panel(s). (Installation of the central control scheme was described on page 2–71.)

It is not necessary to indicate on the MPK Devices table whether or not the MC 3020D is being operated with an expansion
panel (a CP 3021, as used in the central control scheme).

Machine Control Devices Table Entries

The Machine Control menu (Figure 5–145 on page 5–164) must be used to assign each switcher or machine control panel to
one of the groups. The source of these names is the Delegation Group menu.

Important:  The delegation system requires all control panels to be assigned to a group. Any control panel not
assigned to a group will continue to have access to all machines, even if those machines have been assigned to a
group.

Example of Operation

In Figure 5–142, if the VTR operator pressed the “MCS” button on the MC 3020D Machine Delegate panel next to VTR
“VT01,” then the MCS 2000 Master Control panel would be allowed to control VT01. The VTR would still have to be selected
as a source for the MCS 2000 in the usual manner, but no other panel would be allowed to take control.

Saturn Master Control Switcher delegation

Saturn configuration instructions are described in the Saturn Master Control Switcher Installation and Operating Manual.
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Figure 5–142. Delegation system (example).

Group “STU”

Group “MCS”
CP–3000

Group “ENG”

Group “TAPE”

MC–3020D Machine Delegate Panels
(see Figure 5–143 for button labels)

“VT01”

“VC01”

“VC02”

MC–3000/E
Device name “STUMC”

MCS–2000
Device name “MCS”

Device name “ENGCP”

CP–3000/E

Device name “TAPECP”

“DELEVT01”

“DELEVC01”

“DELEVC02”

CP–3000/E
Device name “STUCP”

VT01 VC01 VC02

PRDA

PRDB

PRDC
Routing
Switcher

Production switcher

A B C

Alternative central control arrangement

See page 2–71 for  hardware installation

VM 3000
“VM2”

Party line
connection

Serial ports

SI 3000
“SI1”

VM 3000
“VM1”



Configurator Delegation Groups

5–164 VM 3000 Installation and Operating Manual

ENGMCS STU TAPE All
groups

No
groups

Master Control
group Studio

group
Tape Room

group

Engineering
Room group

Figure 5–143. MC 3020D Group Delegation
Panel for system shown in Figure 5–142.

MPK Devices

MPK
Expansion

Pass
Board Port Address Input Sets Output Sets Level Set Overide Set Sequence SetDevices word In Panel Out Panel

1 STUCP CP–3000 VM1 6 00000014 KXYZ–INP STU–OUT KXYZ–LEV KXYZ–OVE

2 STUMC MC–3000 VM1 6 00000016

3 ENGCP CP–3000 VM1 6 00000013 KXYZ–INP KXYZ–OUT KXYZ–LEV KXYZ–OVE

4 DELEVT01 MC–3020D SI1 6 00000017 VT01–OUT

5 DELEVC01 MC–3020D SI1 6 00000018 VC01–OUT

6 DELEVC02 MC–3020D SI1 6 00000019 VC02–OUT

7 TAPECP CP–3000 SI1 6 00000012 KXYZ–INP VTR–OUT KXYZ–LEV KXYZ–OVE

Figure 5–144. MPK Device menu for system shown in Figure 5–142. In the alternative “central control” arrangement, there would be
only one MC 3020D entry, and the indicated “Out Set” would be a list of machines assigned to the expansion panel (see page 5–85).

Device
Type

8

Machine Control

Device Name Device Type Delegation In/Out Associated

9

STUCP CP–3000E STU Out

10

Mnemonic

STUCP

VT01 Sony Mch In VT01

VC01 Sony Mch In VC01

VC02 Sony Mch In VC02

2

Group Name

VT01

VC01

VC02

STUMC MC–3000E STU Out PRDASTUMC3

MCS TCS1–CP MCS InMCS1

STUMC MC–3000E STU Out PRDBSTUMC4

STUMC MC–3000E STU Out PRDCSTUMC5

ENGCP CP–3000E ENGENGCP6

TAPECP CP–3000E TAPETAPECP7

Figure 5–145. Machine Control table for system shown in Figure 5–142.
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EXAMPLE OF DELEGATION AND LINKAGE SEQUENCE

Please refer to Figure 5–146.

1. The VTR operator uses the MC 3020D panels to delegate control of all three machines to the studio control panels. The
“STU” buttons on the MC 3020Ds are lit.

2. In the Studio, the CP 3000/E Switcher Control Panel is used to switch VT01 to PRDA. PRDA is the switcher output
connected to the “A” input of the production switcher. Also, the VC01 is switched to PRDB. Camera 1 remains switched
to PRDC.

3. Because of the Associated Name entries in the Machine Control Devices menu (Figure 5–145), the MC 3000/E Machine
Control panel in the studio will indicate that links are established to VT01 and VC01 (upper right corner of Figure
5–146). Both machines are stopped.

The VC02 does not appear. Even though the operator delegated it to the studio, it was not selected as the “C” input of
the production switcher. Thus no link has been established.

4. The small START and STOP buttons on the MC expansion panel can now be used for either the VT01 or the VC01,
or both.

5. On the MC expansion panel, the SELECT button under the mnemonic VT01 is used to send control of the VT01 to the
main section of the CP 3000 (left half of panel). This provides full function control of the machine.
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Group “STU”

“VT01”

“VC01”

“VC02”

MC–3000/E
Device name “STUMC”

“DELEVT01”

“DELEVC01”

“DELEVC02”

CP–3000/E
Device name “STUCP”

VT01 VC01 VC02

PRDA

PRDB

PRDC

Production switcher

A B C

ENGMCS STU TAPE

ENGMCS STU TAPE

ENGMCS STU TAPE

 VT01 VC01 CAM1
 PRDA PRDB PRDC

 STOP STOP 
�VT01 VC01 

CAM1

 00:54:49:11 T1
 VT01       STOP MAN

Software link
VM 3000
“VM1”

SI 3000
“SI1”

Figure 5–146. Delegation and linkage sequence (example).
For discussion please see page 5–165.
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PERMANENT DELEGATION

To assign a machine to a particular control panel on a permanent basis, use the Machine Control menu to enter the group name
of the panel in the “Delegation Group” column for the machine.

2

Machine Control

Device Name Device Type Delegation In/Out Associated

3

4

Mnemonic

VT01 Sony Mch MCS In VT01

VC01 Sony Mch MCS In VC01

VC02 Sony Mch MCS In VC02

Group Name

VT01

VC01

VC02

MCS TCS1–CP MCS InMCS1

Figure 5–147.

In this example (Figure 5–147), all three Sony machines have been permanently assigned to the master control switcher
(MCS).

Important:  The delegation system requires all control panels to be assigned to a group. Any control panel not
assigned to a group will continue to have access to all machines, even if those machines have been assigned to a
group.

This delegation method does not require use of an MC 3020 Group Delegation Panel.
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TCS 1 Device Codes

decimal

1

TCS 1 Device Codes

CRT1

2

3

CRT2

VT01

Machine Code

1

2

3

Figure 5–148. TCS 1 device codes table (example).

Password 5–17

Network Description 5–22
Serial Protocol 5–25

Switcher Description 5–31
Switcher Input 5–44
Switcher Output 5–51

Control Panel Sets
Level set 5–55
Input set 5–58
Output set 5–76
Override set 5–98
Sequence set 5–101
Category set 5–103

MPK Devices 5–108

Machines 5–141
Protocol Dependent 5–144
Machine Control 5–148
Delegation Groups 5–161

TCS–1 Device Codes 
Party Line 5–169

Status Display Header 5–172
VGA Status Display 5–173

Tally 5–174

Path Finding 5–196

Exclusion 5–210
Y Line 5–211

This menu must be used if a MCS 2000 Master Control Switcher or a TCS 1–type control panel is part of the system. These
controls use a decimal code number from 1 to 99 to refer to machines, and this code must be cross–referenced to the machine’s
device name used by the Jupiter system.

The decimal Code numbers shown in Figure 5–148 are identical to the decimal code numbers entered on the MCS 2000 Setup
Menu, as described in the MCS 2000 manual. On TCS 1 panels, such as the MC–12/3, these numbers are entered with a front–
panel keypad switch; on the MC–24A they are entered with thumbwheel switches.

The source of the Machine names used on this table is the Machines table (page 5–141).

Machines Controlled by TCS 1 Interfaces

If the machine must be connected to the system with a TCS 1 type interface (as shown on page 2–89), then the address of
the TCS 1 interface must be entered in hexadecimal on the Protocol Dependent Devices table (page 5–144). The address of
the interface is set with internal DIP switches.

§ Some of the functions described in this section may be extra–cost options. For more information, see page 1–27.



ConfiguratorParty Line

5–169VM 3000 Installation and Operating Manual

Party Line Tables

Configuring the VM 3000 party line port

PARTY LINE DESCRIPTION

1

Party Line Description

Board

VM1

Type Poll No.

S 112

Figure 5–149. Party Line Description table (example).

Password 5–17

Network Description 5–22
Serial Protocol 5–25

Switcher Description 5–31
Switcher Input 5–44
Switcher Output 5–51

Control Panel Sets
Level set 5–55
Input set 5–58
Output set 5–76
Override set 5–98
Sequence set 5–101
Category set 5–103

MPK Devices 5–108

Machines 5–141
Protocol Dependent 5–144
Machine Control 5–148
Delegation Groups 5–161

TCS–1 Device Codes 5–168
Party Line

Status Display Header 5–172
VGA Status Display 5–173

Tally 5–174

Path Finding 5–196

Exclusion 5–210
Y Line 5–211

This table must be used when the Party Line port of a VM 3000 is connected.§ The source of the Board names is the Network
Description menu (page 5–22).

The entry for Type determines the protocol that will be generated by the VM 3000. Extended allows party line type panels
to control 250 inputs and 150 outputs; super allows such panels to control 250 inputs and 250 outputs. Most current party
line control panels will adjust automatically to either type. The usual setting is super. 

The Polling Number is the lowest polling number for the party line control panels in the system. For example, if there are
three party line panels and their polling numbers are 120, 122, and 124, then the entry would be 120. The polling number for
each party line panel is set at the panel itself, either with internal DIP switches or, as is the case with the MCS–2000, by front–
panel programming. For more information, please refer to the manual supplied with the panel.

A detailed description of the party line, sample points, and polling numbers can be found in the CE 2200 Polling and Control
board section of the TVS/TAS 2000 Technical Manual.

§ Some of the functions described in this section may be extra–cost options. For more information, see page 1–27.
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PARTY LINE INPUT AND OUTPUT

1

Party Line Output

Output

LINE

PLOutput

54

2 MCPS 55

Logical

1

Party Line Input

Input

BARS

PLInput

0

2 VT01 1

3 VT02 2

Logical

Figure 5–150. Party Line Input And Output tables (example).

These menus must be used when party line–type control panels are installed in the system. This includes the MCS 2000 Master
Control switcher.

These panels are capable of controlling up to 250 inputs and 250 outputs (using super party line) whereas the Jupiter system
itself can control several thousand inputs and outputs. Thus a maximum of up to 250 of the switcher inputs and outputs can
be selected for control by party line panels.

Accordingly, these conversion tables list up to 250 “PL input” and “PL output” numbers, and for each of these, the name of
the input (from the Switcher Input menu, page 5–44); or the name of the output (from the Switcher Output menu, page 5–51).

As a convention, you may wish to keep the physical input numbers and the “PL input” numbers exactly the same, but this
is not necessary. For example, you may wish to have:

PL input 0 = BARS = physical input 000.
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PARTY LINE LEVELS

1

Party Line Levels

Level

VIDEO (MAINROUT)

PLevel

1

2 LEFT (MAINROUT) 2

3 RIGHT (MAINROUT) 4 Figure 5–151. Party line levels menu (example).

This menu must be used when party line–type control panels are installed in the system. This includes the MCS 2000 Master
Control switcher.

These panels are capable of controlling up to seven levels, whereas the Jupiter system itself can control 126 levels. Thus a
maximum of up to seven of the switcher levels can be selected for control by party line panels. Accordingly, this conversion
table lists up to seven party line level numbers, and for each of these, the name for the physical level (from the Switcher De-
scription menu, page 5–31).

If you are adding the Jupiter to an existing TVS/TAS 2000 system, you may wish to maintain the traditional party line level
numbers (as on Figure 5–151), but this is not necessary. For example, you may wish to have

Party line level 1 = KXYZ VIDEO = Physical Level 1
Party line level 2 = KXYZ LEFT = Physical Level 2
Party line level 4 = KXYZ RIGHT = Physical Level 8

For the MCS 2000 Master Control switcher, party line level identification is established with the Setup mode, as described
in the MCS 2000 manual.

Remember that the Physical Level entry (page 5–31) must agree with the DIP switch settings on the switcher’s crosspoint
boards.
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Status Display Headers

Thomson            WXYZ TELEVISION FACILITY CONTROL SYSTEM              PAGE: 00
May 10, 1999                   SWITCHER STATUS                          12:34:56
––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––
OUTPUT      VIDEO     LEFT     RIGHT    TC
––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––
PRDA        VT01      VT01     VT01     VT01
PRDB        VC01      VC01     VC01
PRDC        VTR1      VTR1     VTR1
PRDD        CAM1      ANN1     ANN1
VTR1        VTR2      VTR2     VTR2
VTR2        SAT1      SAT1     SAT1     SAT1
VTR3        CON2      CON2     CON2
VTR4        TST4      TST4     TST4
STUA        BARS      TONE     TONE
STUB        CAM1      CAM1     CAM1
STUC        STUA      STUA     STUA
CON1        VTR5      VTR5     VTR5     VTR5
CON2        CG02      CRT2     CRT2
CON3        CAM3      VC09     VC09
SAT1        CONA      CONA     CONA
SAT2        NET       NET      NET
SAT3        ENG2      ENG2     ENG2
SAT4        TSTB      TSTB     TSTB VGA Status Display

1

Header

WXYZ TELEVISION FACILITY CONTROL SYSTEM

Figure 5–152. Status display headers table (example).

Password 5–17

Network Description 5–22
Serial Protocol 5–25

Switcher Description 5–31
Switcher Input 5–44
Switcher Output 5–51

Control Panel Sets
Level set 5–55
Input set 5–58
Output set 5–76
Override set 5–98
Sequence set 5–101
Category set 5–103

MPK Devices 5–108

Machines 5–141
Protocol Dependent 5–144
Machine Control 5–148
Delegation Groups 5–161

TCS–1 Device Codes 5–168
Party Line 5–169

Status Display Header 
VGA Status Display 5–173

Tally 5–174

Path Finding 5–196

Exclusion 5–210
Y Line 5–211

This table is the source of the header that appears centered at the top of the VGA Status Display pages. Up to 60 characters
can be entered. Only the entry on Row 1 is used.

For more information about the VGA Status Display, see Appendix A.

Note: This table was originally designed for use during configuration of the VG 3000 Video Display / Status Gen-
erator, which is no longer available (the functionality of the VG 3000 has been replaced by the VGA output of the
VM 3000). For more information about the VG 3000 Video Display / Status Generator, please contact Thomson.
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VGA Status Display Table

1

VGA Status Display Table

Board

VM1

Page File Name

VGA01

Video Mode

VC8

2

Password 5–17

Network Description 5–22
Serial Protocol 5–25

Switcher Description 5–31
Switcher Input 5–44
Switcher Output 5–51

Control Panel Sets
Level set 5–55
Input set 5–58
Output set 5–76
Override set 5–98
Sequence set 5–101
Category set 5–103

MPK Devices 5–108

Machines 5–141
Protocol Dependent 5–144
Machine Control 5–148
Delegation Groups 5–161

TCS–1 Device Codes 5–168
Party Line 5–169

Status Display Header 5–172
VGA Status Display

Tally 5–174

Path Finding 5–196

Exclusion 5–210
Y Line 5–211

Figure 5–153. VGA Status Display table (example).

This table is used when a VGA status display is installed.

Board is the name of the VM 3000 providing the VGA output. This must be the same as the name already entered on the
Network Devices table.

Page File Name is the source of the name of the file that will be created when the “Tools > Generate VGA Files” command
is run.

Note: The “Generate VGA Files” command is designed for use during initial installation only—it always uses the
original factory default settings when building the Page Description file. If you decide to modify your VGA dis-
play with custom formatting, do not  re–run the Generate VGA Files command. If you do, your modifications will
be overwritten.

Video Mode allows selection of color or black and white. When “Color 80” is selected the table will display “VC8;” when
“B/W 80” is selected the display will be “VB8.”

For details concerning VGA hardware installation and software configuration, please refer to Appendix A.
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Tally

RELAY DESCRIPTION

Figure 5–154. Tally Relay description table.

1

Tally Relay

Tally Device

TALLY1

Relay

0

Logical Input

VT01

2

3

TALLY1 1 VC02

TALLY1 2 VC01

4

Password 5–17

Network Description 5–22
Serial Protocol 5–25

Switcher Description 5–31
Switcher Input 5–44
Switcher Output 5–51

Control Panel Sets
Level set 5–55
Input set 5–58
Output set 5–76
Override set 5–98
Sequence set 5–101
Category set 5–103

MPK Devices 5–108

Machines 5–141
Protocol Dependent 5–144
Machine Control 5–148
Delegation Groups 5–161

TCS–1 Device Codes 5–168
Party Line 5–169

Status Display Header 5–172
VGA Status Display 5–173

Tally

Path Finding 5–196

Exclusion 5–210
Y Line 5–211

An overview of Jupiter tally and a discussion of hardware installation can be found on page 2–107.

Note: The Jupiter Tally software package described here cannot tally sources that are wired directly to a Saturn
internal matrix. If the Saturn is equipped with an internal matrix, the Saturn Tally system is available (but cannot
be connected to the Jupiter Tally system). Please refer to the Saturn installation/operating manual for additional
information.

The Relay Description table must be used when an MI 3040 has been configured to operate as a “MI 3040/T,” i.e., for operation
with tally lamps. The Tally Dependency table must also be used (page 5–180 ).

The table has a one–row entry for each of the tally lights in the system. The entry shows the name and relay number of the
MI 3040 connected to each light; the source of this name is the MPK Devices table (page 5–116). Each relay is associated with
the name of a routing switcher input, so that whenever that input is switched to air the relay will close. The source of the
switcher input names is the Switcher Input table (page 5–44).

§ Some of the functions described in this section may be extra–cost options. For more information, see page 1–27.
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Figure 5–155 shows a tally system with a Jupiter–controlled routing switcher, a Saturn (or non–Saturn) master control
switcher, and a direct feed to the transmitter. The corresponding Tally Relay Descriptions table is also shown. Notice that the
table remains the same whether or not a Saturn master control switcher is used.

Figure 5–156 shows a system with a Jupiter–controlled routing switcher, Saturn (or non–Saturn) master control, and a produc-
tion switcher. The master control switcher is connected directly to the transmitter. The corresponding Tally Relay Descrip-
tions table is also shown. Notice that the table remains the same whether or not a Saturn master control switcher is used.

Figure 5–157 shows a system in which the master control switcher is connected to the transmitter indirectly, i.e., by re–entry
through the routing switcher. Again, the figure includes the corresponding Tally Relay Descriptions table. In this case, a tally
light for the master control switcher must be identified in the table (but not necessarily installed, as described previously).

The table is also used for systems with UMD SD 3x and RP 1/2/3 Status Displays, when an MI 3040 is being used to trace
inputs back through a production switcher. See page 5–127.

Figure 5–158 shows a system with RP 1/2/3 Status Displays when the front panel tally lights are used. The Tally Relay De-
scription table must include a one–row entry for each RP tally light pair. The source for the “Name” is the MPK Devices table
(Figure 5–99 on page 5–120); the “Relay” entry is always “1” and the “Switcher Input” number is an existing switcher input
name as defined on the Switcher Input table (page 5–44). The “Switcher Input” entry is not actually used, but to satisfy the
compiler a name must be entered which is unique within this table.

In all cases, the Tally Dependency table must also be completed, as described on page 5–180.
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MPK bus

MI–3040/T
“TALLY1”

Relays
Video and audio

Jupiter control lines

Routing
switcher

 Tally light

Master control switcher

VC02 VT01VC01

20 1

Input names

Tally Device Relay Logical Input

1 TALLY1 0 VT01
2 TALLY1 1 VC02
3 TALLY1 2 VC01

Tally Relay

Transmitter

ÏÏÏÏÏÏÏÏÏÏ

ÏÏ

ÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏ
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Figure 5–155. Tally system with Jupiter–controlled
router, Saturn (on non–Saturn) master control, and di-
rect feed to transmitter. Equipment shown corresponds to
table at left.
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MPK bus

MI–3040/T
“TALLY1”

Relays
Video and audio

Jupiter control lines

Routing
switcher

Production switcher

 Tally light

Master control switcher

VC02 VT01PRD VC01

20 1 3

Input names

Tally Device Relay Logical Input

1 TALLY1 0 VT01
2 TALLY1 1 VC02
3 TALLY1 2 VC01
4 TALLY1 3 PRD

Tally Relay

Transmitter

ÏÏÏÏÏÏÏÏÏÏ

ÏÏÏ
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Figure 5–156. Tally system with Jupiter–controlled router, Saturn
(or non–Saturn) master control, production switcher, and direct
feed to transmitter. Equipment shown corresponds to table at left.
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MPK bus

MI–3040/T
“TALLY1”

Relays

Transmitter

Video and audio

Jupiter control lines

Routing
switcher

Production switcher

 Tally light

Master control switcher

VC02 VT01PRD MCSVC01

20 1 3 4

Input names

Tally Device Relay Logical Input

1 TALLY1 0 VT01
2 TALLY1 1 VC02
3 TALLY1 2 VC01
4 TALLY1 3 PRD
5 TALLY1 4 MCS

Tally Relay
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Figure 5–157. Tally system with Jupiter–controlled router, Saturn
(or non–Saturn) master control, production switcher, and indirect
feed to transmitter. Equipment shown corresponds to table at left.
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MPK bus

MI–3040/T
“TALLY1”

Relays

Transmitter

Video and audio

Jupiter control lines

Routing
switcher

Production switcher

 Tally light

Master control switcher

VC02 VT01PRD MCSVC01

20 1 3 4

Input names

Tally Device Relay Logical Input

1 TALLY1 0 VT01
2 TALLY1 1 VC02
3 TALLY1 2 VC01
4 TALLY1 3 PRD
5 TALLY1 4 MCS
6 UMDRP1 1 111
7 UMDRP2A 1 222
8 UMDRP2B 1 333

Tally Relay
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M/E 3

M/E 2

M/E 1

VM 3000 
“VM1”

RP 1 
“UMDRP1”

RP 2 RP 2 
“UMDRP2A” “UMDRP2B”

Figure 5–158. RP 1/2/3 tally system with Jupiter–controlled router,
Saturn (or non–Saturn) master control, production switcher, and indirect
feed to transmitter. Equipment shown corresponds to table at left.
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TALLY DEPENDENCY

Figure 5–159. Tally Dependency table (example).

1

Tally Dependency

Tally Device

MCS_TLY

Opto

0

Logical Output

MAIN–A

Tally

2

3

MCS_TLY 1 MAIN–B

MCS_TLY 2 KEYINS1

4

5

MCS_TLY 3 KEYINS2

MCS_TLY 4 MIXINS1

6 MCS_TLY 5 MIXINS2

7 MCS_TLY 6 BYPASS

Password 5–17

Network Description 5–22
Serial Protocol 5–25

Switcher Description 5–31
Switcher Input 5–44
Switcher Output 5–51

Control Panel Sets
Level set 5–55
Input set 5–58
Output set 5–76
Override set 5–98
Sequence set 5–101
Category set 5–103

MPK Devices 5–108

Machines 5–141
Protocol Dependent 5–144
Machine Control 5–148
Delegation Groups 5–161

TCS–1 Device Codes 5–168
Party Line 5–169

Status Display Header 5–172
VGA Status Display 5–173

Tally

Path Finding 5–196

Exclusion 5–210
Y Line 5–211

OVERVIEW

This table must be used when an MI 3040 has been configured to operate as a “MI 3040/T,” i.e., for operation with tally lamps.
The Tally Relay table must also be used (page 5–174).

Note 1: The Jupiter Tally system described in this manual cannot tally sources that are wired directly to a Saturn
internal matrix. If the Saturn is equipped with an internal matrix, the Saturn Tally system is available (but cannot
be connected to the Jupiter tally system). Please refer to the Saturn Installation and Operating manual for additional
information.

Note 2: The Tally Dependency table is also used for systems with under monitor status displays, when input mne-
monics must be tracked back through a master control or production switcher. See page 5–123.

The table has two basic purposes: first, to establish the identity of the main output of the system (the output being fed by the
tallied source); and second, to allow the Jupiter system to track sources through switchers other than the routing switcher.

Whatever source is feeding the main output (usually a transmitter) is tallied. When the main output is fed directly from the
routing switcher, it is referred to as an unqualified output; a sample entry is shown in Figure 5–160.
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Figure 5–160. Entry used when main output is fed by router.

1

Tally Dependency

Tally Device Opto Logical Output

XMIT

Tally

2

If the main output is fed from a switcher other than the router (such as a master control switcher), then the main output is not
identified as such. Instead, the names of all possible routing switcher outputs that could be selected for the main output are
listed (“Output” column in Figure 5–161). In this case, the master control switcher must tell the Jupiter system which routing
switcher output has been selected; this is done by energizing the appropriate opto–isolator (“Name/Opto” columns).

Figure 5–161. Entry used when main output is fed by
switcher other than router.

1

Tally Dependency

Tally Device

MCS_TLY

Opto

0

Logical Output

MAIN–A

Tally

2 MCS_TLY 1 MAIN–B

3 MCS_TLY 2 KEYINS1

4 MCS_TLY 3 KEYINS2

5 MCS_TLY 4 MIXINS1

6 MCS_TLY 5 MIXINS2

7 MCS_TLY 6 BYPASS

There may be additional switching layers other than the router (such as a production switcher). In this case, the system must
be able to determine (a) whether the switcher is on the air, and if it is, (b) which routing switcher output has been selected.
An entry to the “Tally” column (Figure 5–162) will identify the tally light associated with the switcher; if the light is on, then
the switcher is on the air. If it is on the air, the opto–isolators will be checked to find out which router output has been selected.

Figure 5–162. Additional switcher entries.

1

Tally Dependency

Tally Device

TALLY1

Opto

0

Logical Output

PROD1

Tally

TALLY1 /3

2 TALLY1 1 PROD2 TALLY1 /3

The source of the Tally column data (name of MI 3040 / relay number connected to each tally light) is the Tally Relay table
(page 5–174).

Entries for specific systems are shown below; this is followed by a detailed example of system operation.
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BASIC TALLY SYSTEM WITH SATURN MASTER CONTROL SWITCHER

Direct Connection to Transmitter

Please see Figure 5–164.

This table has only one type of entry: MCS_TLY.

Saturn (“MCS_TLY”) entries

These entries are used in systems equipped with a Saturn Master Control Switcher (or BTS MCS 2000). They allow
the Jupiter system to find out which of the sources feeding the master control switcher have been switched to the MCS
“On–air” output. There are always five entries for the MCS 2000, one for each of the five inputs from the routing
switcher. For the Saturn, there are seven entries.

The source of the Name used here is the MPK Devices table (for discussion, see page 5–116). As a convention, the name
“MCS_TLY” is used.

The Opto–isolator number entries must be assigned as follows:

Figure 5–163. Additional switcher entries.

MCS_TLY
Opto–isolator no.

Assigned to
MCS 2000 input

Assigned to
Saturn input

0 Input 1 BKGDA

1 Input 2 BKGDB

2 Key 1 KEY 1

3 Key 2 KEY 2

4 ––– MIX 1

5 ––– MIX 2

6 Bypass BYPASS

Note 1: The device called “MCS_TLY” and the “opto–isolators” associated with it exist only in software ta-
bles.

Note 2: There are no entries for MCS 2000 Mix 1 and Mix 2 (these are audio inputs). If the MCS 2000 is
mixing or keying, then both the mix source and the key source will be tallied by the Jupiter system.

The Switcher Outputs are the names of the five router outputs leading to the master control switcher. The source of
the switcher output names is the Switcher Output table (page 5–51).

The MCS_TLY entries do not include a dependency on a relay, since no tally light is associated with the master control
switcher. (There is no tally light because in this system the master control switcher is always on–air.) The last two col-
umns are therefore left blank.
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KEY 1 KEY 2BKGDA BKGDB BYPASS

Video
router

BUS INPUTS

000

MAIN–B001

KEYINS1002

KEYINS2003

BYPASS004

MIX 1 MIX 2MAIN A MAIN B BYPASS

Audio
router

BUS INPUTS

MAIN–A000

MAIN–B001

MIXINS1002

MIXINS2003

BYPASS004

L RL R L R L R L R

ISO1 ISO2

ISO 1005

ISO 2006

MAIN–A

Saturn audio processorSaturn video processor

Transmitter

Tally Device Opto Logical Output Tally

1 MCS_TLY 0 MAIN–A
2 MCS_TLY 1 MAIN–B
3 MCS_TLY 2 KEYINS1
4 MCS_TLY 3 KEYINS2
5 MCS_TLY 4 MIXINS1
6 MCS_TLY 5 MIXINS2
7 MCS_TLY 6 BYPASS

Tally Dependency

Physical
Output

Output
name

Figure 5–164. Example tally system with Jupiter–controlled
router (Venus), Saturn master control, and direct feed to
transmitter. Equipment shown corresponds to table at left.
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Indirect Connection to Transmitter

Please see Figure 5–165.

There are two types of entries on this table: an unqualified output entry and MCS_TLY entries.

Unqualified output

This is the name (“XMIT”) of the routing switcher output leading to the transmitter (or the name of the output leading
to the primary program line). All sources switched to this output will be tallied. The rest of the row remains blank. There
can be more than one unqualified output if desired.

Saturn (“MCS_TLY”) entries

Entries are similar to those already described (page 5–186) except for the last two columns. Since the master control
switcher is connected indirectly to the transmitter (by re–entry through the routing switcher), each entry must include
the Name of the MI 3040/T and the relay Number associated with the master control switcher’s tally light.
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KEY 1 KEY 2BKGDA BKGDB BYPASS
BUS INPUTS
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Saturn audio processorSaturn video processor

Transmitter

Tally Device Opto Logical Output Tally

1 XMIT
2 MCS_TLY 0 MAIN–A TALLY1 /4
3 MCS_TLY 1 MAIN–B TALLY1 /4
4 MCS_TLY 2 KEYINS1 TALLY1 /4
5 MCS_TLY 3 KEYINS2 TALLY1 /4
6 MCS_TLY 4 MIXINS1 TALLY1 /4
7 MCS_TLY 5 MIXINS2 TALLY1 /4
8 MCS_TLY 6 BYPASS TALLY1 /4

Tally Dependency

XMIT007

XMIT007

MI–3040/T
“TALLY1”

Relays

20 1 3 4

Audio
router

Video
router

Physical
Output

Output
Name

Figure 5–165. Example tally system with Jupiter–controlled
router (Venus), Saturn master control, and indirect feed to
transmitter. Equipment shown corresponds to table at left.
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CONFIGURATION FOR SYSTEMS WITH SATURN MASTER CONTROL SWITCHER AND 
PRODUCTION SWITCHER

Direct Connection to Transmitter 

Please see Figure 5–167.

There are two types of entries on this table: MCS_TLY entries; and production switcher entries. There is no unqualified output
entry.

Saturn (“MCS_TLY”) entries

These entries are used in systems equipped with a Saturn Master Control Switcher (BTS MCS 2000). They allow the
Jupiter system to find out which of the sources feeding the master control switcher have been switched to the “On–air”
output. There are always five entries for the MCS 2000, one for each of the five inputs from the routing switcher. For
the Saturn, there are seven entries.

The source of the Name used here is the MPK Devices table (for discussion, see page 5–116). As a convention, the name
“MCS_TLY” is used.

The Opto–isolator number entries must be assigned as follows:

Figure 5–166.

MCS_TLY
Opto–isolator no.

Assigned to
MCS 2000 input

Assigned to
Saturn input

0 Input 1 BKGDA

1 Input 2 BKGDB

2 Key 1 KEY 1

3 Key 2 KEY 2

4 ––– MIX 1

5 ––– MIX 2

6 Bypass BYPASS

Note 1:  The device called “MCS_TLY” and the “opto–isolators” associated with it exist only in software
tables.

Note 2: There are no entries for MCS 2000 Mix 1 and Mix 2 (these are audio inputs). If the MCS 2000 is
mixing or keying, then both the mix source and the key source will be tallied by the Jupiter system.

The Switcher Outputs are the names of the five router outputs leading the master control switcher. The source of the
switcher output names is the Switcher Output table (page 5–51).

The MCS_TLY entries do not include a dependency on a relay, since no tally light is associated with the MCS. (There
is no tally light because in this system the MCS is always on–air.) The last two columns are therefore left blank.
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KEY 1 KEY 2BKGDA BKGDB BYPASS
BUS INPUTS

000

MAIN–B001

KEYINS1002

KEYINS2003

BYPASS004

MIX 1 MIX 2MAIN A MAIN B BYPASS

Audio
router

BUS INPUTS

MAIN–A000

MAIN–B001

MIXINS1002

MIXINS2003

BYPASS004

L RL R L R L R L R

ISO1 ISO2

ISO 1005

ISO 2006

MAIN–A

Saturn audio processorSaturn video processor

Transmitter

Tally Device Opto Logical Output Tally

1 MCS_TLY 0 MAIN–A
2 MCS_TLY 1 MAIN–B
3 MCS_TLY 2 KEYINS1
4 MCS_TLY 3 KEYINS2
5 MCS_TLY 4 MIXINS1
6 MCS_TLY 5 MIXINS2
7 MCS_TLY 6 BYPASS
8 TALLY1 0 PROD1 TALLY1 /3
9 TALLY1 1 PROD2 TALLY1 /3

Tally Dependency

Production switcher

Switcher tally
relays

MI–3040/T
“TALLY1”

Relays

20 1 3

20 1 3 4

Opto–isolators

PROD1007

PROD2008

PROD1007

PROD2008

Video
router

 Tally light

Physical
Output

Output
Name

Figure 5–167. Example tally system with Jupiter–controlled router
(Venus), Saturn master control, production switcher, and direct feed
to transmitter. Equipment shown corresponds to table at left.
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Production Switcher Entries

These entries will allow the Jupiter system to find out which of the sources feeding the production switcher have been
switched to the switcher’s Program output. The number of entries will be the same as the number of inputs from the
routing switcher.

The Name is that of the MI 3040/T connected to the production switcher’s tally outputs. The source of this name is the
MPK Devices table (page 5–116). As a convention, a name such as “TALLY1” is used.

The Opto–isolator number entries are based on the corresponding router output names. In this example, when the pro-
duction switcher has switched “PROD1” to its program output, it will report this by energizing opto–isolator number
0 on “TALLY1.”

Note: Entry of the correct opto–isolator numbers will require an understanding of the production switcher’s
tally connections. Please refer to the installation manual supplied with the production switcher for more in-
formation.

The Switcher Outputs are the names of the router outputs leading the production switcher. The source of these output
names is the Switcher Output table (page 5–51).

In the Tally column, select the name of the MI 3040/T / relay number associated with the production switcher’s tally
light. The source of the Tally column data is the Tally Relay table (page 5–174).
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Indirect Connection to Transmitter

Please see Figure 5–168.

There are three types of entries on this table: an unqualified output entry; MCS_TLY entries; and production switcher entries.

Unqualified Output

This is the name (“XMIT”) of the routing switcher output leading to the transmitter (or the name of the output leading
to the primary program line). All sources switched to this output will be tallied. The rest of the row remains blank. There
can be more than one unqualified output if desired.

Saturn (“MCS_TLY”) Entries

Similar to those already described (page 5–186), except for the last column. Since the master control switcher is con-
nected indirectly to the transmitter (by re–entry through the routing switcher), each entry must include the name  of the
MI 3040/T and the relay number associated with the master control switcher’s tally light.

Production Switcher Entries

Similar to those already described (page 5–188).
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KEY 1 KEY 2BKGDA BKGDB BYPASS
BUS INPUTS
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Tally Device Opto Logical Output Tally

1 XMIT
2 MCS_TLY 0 MAIN–A TALLY1 /4
3 MCS_TLY 1 MAIN–B TALLY1 /4
4 MCS_TLY 2 KEYINS1 TALLY1 /4
5 MCS_TLY 3 KEYINS2 TALLY1 /4
6 MCS_TLY 4 MIXINS1 TALLY1 /4
7 MCS_TLY 5 MIXINS2 TALLY1 /4
8 MCS_TLY 6 BYPASS TALLY1 /4
9 TALLY1 0 PROD1 TALLY1 /3
10 TALLY1 1 PROD2 TALLY1 /3

Tally Dependency

Physical
Output

Output
Name

Figure 5–168. Example tally system with Jupiter–controlled router
(Venus), Saturn master control, production switcher, and indirect
feed to transmitter. Equipment shown corresponds to table at left.
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CONFIGURATION FOR SYSTEMS WITH NON–SATURN MASTER CONTROL SWITCHER

Figure 5–169. Tally dependencies table for systems with
non–Saturn master control switcher (Figure 5–170).

1

Tally Dependency

Tally Device Opto Logical Output

XMIT

Tally

2 TALLY1 2 MCS1 TALLY1 /4

3 TALLY1 3 MCS2 TALLY1 /4

4 TALLY1 4 MCS3 TALLY1 /4

5 TALLY1 5 MCS4 TALLY1 /4

6 TALLY1 6 MCS5 TALLY1 /4

7 TALLY1 0 PROD1 TALLY1 /3

8 TALLY1 1 PROD2 TALLY1 /3

The Tally Dependency table shown above (Figure 5–169) corresponds to the system shown in Figure 5–170.

This table is similar to that already described, except that it shows the required connections from the non–Saturn master con-
trol switcher to the MI 3040/T opto–isolators.

Note: in this discussion, “non–Saturn” also means “non–MCS 2000.”
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MI 3040/T
“TALLY1”

Relays

Transmitter

Video and audio

Jupiter Control lines

Routing
switcher

Production switcher

 Tally light

Non–Saturn
master control

switcher

20 1 3 4

Output names

XMIT

MCS1

MCS2

MCS3

MCS4

MCS5

PROD1

PROD2

20 1 3 4

Opto–isolators

5 6

Switcher tally
relays

Switcher tally relays

Figure 5–170. Example of tally system with non–Saturn
master control switcher. Equipment shown here corre-
sponds to table shown in Figure 5–169.
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EXAMPLE OF TALLY SYSTEM OPERATION

MI–3040/T
“TALLY1”

Relays

Transmitter

Video

Jupiter Control lines

Routing
switcher

Production switcher

 Tally light “on”

Master control switcher

VC02 VT01PRD MCSVC01

20 1 3 4

XMIT

MCSM1

MCSM2

MCSK1

MCSK2

MCSBP

PROD1

PROD2

0 1

Opto–isolators

Crosspoint “on”

Switcher tally
relays

Figure 5–171. Example of tally system operation.
Equipment shown here corresponds to tables and
discussion on next page.
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Figure 5–172. Tables for system shown in Figure 5–171.

Tally Device Opto Logical Output Tally

1 XMIT
2 MCS_TLY 0 MCSM1 TALLY1 /4
3 MCS_TLY 1 MCSM2 TALLY1 /4
4 MCS_TLY 2 MCSK1 TALLY1 /4
5 MCS_TLY 3 MCSK2 TALLY1 /4
6 MCS_TLY 6 MCSBP TALLY1 /4
7 TALLY1 0 PROD1 TALLY1 /3
8 TALLY1 1 PROD2 TALLY1 /3

Tally Dependency

Tally Device Relay Logical Input

1 TALLY1 0 VT01
2 TALLY1 1 VC02
3 TALLY1 2 VC01
4 TALLY1 3 PRD
5 TALLY1 4 MCS

Tally Relay

�

�
�

�

�

	







The following discussion refers to Figures 5–171 and 5–172 above. All references to “inputs” and “outputs” are from the
routing switcher point of view. Only video is shown in this example.

� System finds unqualified output “XMIT” on Tally Dependency table. All sources switched to this output will
be tallied. System checks routing switcher status tables and finds that input “MCS” (the master control
switcher) is switched to output “XMIT.”

� System locates “MCS” on Tally Relay Descriptions table, according to which relay no. 4 of MI 3040
“TALLY1” should be turned on. This turns on the tally light next to the MCS.

� Tally 1, relay 4  is located on the Tally Dependency table. There are five entries, one for each possible source
for the MCS. Each depends (is conditional) on relay 4 to be closed in order to point back to a tally light.

� The system checks the MCS (“MCS_TLY”) to determine which source has been selected; in this case it is
output “MCSM1.” The system looks at the routing switcher status table and finds that input “PRD” (the pro-
duction switcher) is switched to output “MCSM1.”

� The system locates “PRD” on the Tally Relay Descriptions table, according to which, relay 3 of Tally 1 should
be turned on. This relay turns on the tally light next to the production switcher.

	 Tally 1, relay 3 is located on the Tally Dependency table. There are two entries, one for each possible router
output to the production switcher.


 The system now checks opto–isolators 0 and 1 of Tally 1 to determine which source has been selected by the
production switcher. Opto–isolator 0 is energized, meaning that output “PROD1” is selected. (In other words,
relay 3 is ANDed with opto 0.) The system looks at the routing switcher status table and finds that input
“VT01” is switched to output “PROD1.”


 The system locates “VT01” on the Tally Relay Descriptions table, according to which relay 0 should be turned
on. This turns on the tally light next to the VTR.
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Sequential Path Finding

Figure 5–173. Path finding data table (example).

1

Sequential Path Finding

Source Switcher/Level

VIDEO (NEWSROUT)

Physical

10

Destination Switcher/Level Physical

43

Count

5

2 LEFT (NEWSROUT) 10 43 5

3 RIGHT (NEWSROUT 10 43 5

4 TC (NEWSROUT) 10 43 5

5 VIDEO (MAINROUT) 61 20 3

6 LEFT (MAINROUT) 61 20 3

7 RIGHT (MAINROUT) 61 20 3

8 TC (MAINROUT) 61 20 3

Output Input

VIDEO (MAINROUT)

LEFT (MAINROUT)

RIGHT (MAINROUT)

TC (MAINROUT)

VIDEO (NEWSROUT)

LEFT (NEWSROUT)

RIGHT (NEWSROUT

TC (NEWSROUT)

Path Finding
Group Name

VNEWMAIN

LNEWMAIN

RNEWMAIN

TNEWMAIN

VMAINNEW

LMAINNEW

RMAINNEW

TMAINNEW

Password 5–17

Network Description 5–22
Serial Protocol 5–25

Switcher Description 5–31
Switcher Input 5–44
Switcher Output 5–51

Control Panel Sets
Level set 5–55
Input set 5–58
Output set 5–76
Override set 5–98
Sequence set 5–101
Category set 5–103

MPK Devices 5–108

Machines 5–141
Protocol Dependent 5–144
Machine Control 5–148
Delegation Groups 5–161

TCS–1 Device Codes 5–168
Party Line 5–169

Status Display Header 5–172
VGA Status Display 5–173

Tally 5–174

Path Finding

Exclusion 5–210
Y Line 5–211

The path finding§ software option allows two or more TVS/TAS 2000, Venus, or later routing switchers to operate as a system,
where one switcher can access the other’s inputs through a number of tie lines. For example, Figure 5–174 shows a facility
with a large, central distribution switcher and a smaller switcher normally used only within the news department. By placing
both switchers under control of the Jupiter system, and by adding tie lines, the main router can access the news department’s
inputs. In this example, VT21 can be switched to output 55 of switcher “MAINROUT” with one command: the system will
first switch VT21 to one of the tie lines leading from “NEWSROUT” to “MAINROUT,” then it will switch that tie line signal
to output 55 of “MAINROUT.”

§ Some of the functions described in this section may be extra–cost options. For more information, see page 1–27.
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Path finding is not the same as three–stage switching. Path finding involves discrete switchers connected by a small number
of tie lines, the number of which strictly limits the inputs available at the downstream switcher. When these tie lines are all
busy, the path between the switchers is blocked and will remain so until one of the lines is released. A three–stage switcher,
on the other hand, operates as one unit and is carefully designed so that it cannot be blocked. (For more information about
three–stage switching, see Appendix H.)

Note 1: It is possible to combine path finding with three–stage switching. For example, either one or both of the
switchers shown in Figure 5–174 could be three–stage switchers. This would not affect entries to the path finding
tables as described below.

If all tie lines are busy and an attempt is made to switch to an additional upstream source, the control panel will indicate
“Blocked.” In order to release a tie line, a downstream output using a tie line must be switched to a local input. In this example,
“MainRout” output 55 could be switched to VT16, or some other source known to be a local input (such as black burst). In
some cases, it might be necessary to switch more than one downstream output to a local source, since the tie line could be
feeding more than one destination. Since it may be difficult to determine the overall usage of a given tie line, the operator
should switch away from the upstream switcher source when it is no longer needed.†

Following hardware installation (discussed on page 2–35), path finding requires entries to the Path Finding Data table  and
selection of Group Names numbers on the Switcher Input tables (Figure 5–173).

Note 2: If the tie lines are wired non–sequentially, please refer also to Non–sequential Path Finding on page 5–207.

PATH FINDING DATA TABLE

This table, shown in Figure 5–173, describes the tie lines between the two switchers. The first four rows show the lines from
“NEWSROUT” to “MAINROUT,” and the next four rows show the lines leading back to “NEWSROUT.” In this case, there
are tie lines for all four levels of both switchers. The columns are arranged in “from—to” order.

Row 1 describes lines from Input Switcher “NEWSROUT,” Video level, starting with Physical Output 10. The lines go to
Output Switcher “MAINROUT,” Video level, starting with Physical Input 43. Since there are five lines, and connections must
be consecutive, outputs 10 through 14 of “NEWSROUT” are connected to inputs 43 through 47 of “MAINROUT.”

Note 3: When a switcher input or output is used with a tie line (such as Physical Output 10 in the above example)
and entered in the Path Finding Data table, that input or output must not appear in the Switcher Input or Output
tables.

† With Jupiter version 4.0, the VM 3000 VGA Status Display can be made to display tie line status. See Appendix A.
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SWITCHER INPUT TABLES

Referring to Figure 5–175 and the Switcher Input table for “NEWSROUT,” the entries for VT21 and VT22 follow the normal
pattern. However, there are also entries for VT15 and VT16—machines that are normally sources for “MAINROUT.” In the
following columns, there are Group Name selections such as “VNEWMAIN,” “LNEWMAIN,” etc. If there is a request for
VT15 to be switched to a “NEWSROUT” output, then the system is referred to Groups VMAINNEW through TMAINNEW
on the Path Finding Data table. The VMAINNEW entry, for example, shows that for video there are three tie lines available
to make this switch. Assuming that one of these lines is available, the switch will be completed.

Note: All sources identified as available through path finding must also appear on the Switcher Input table for the
“home switcher.” In the example just given, VT15 appears on both tables.

17 18 19 20 21 22 23 24 25

6

7

8

9

10

11

12

13

14

38 39 40 41 42 43 44 45 46 47 48 55
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57
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59

60

61

62

63

64

Distribution
switcher

“NEWSROUT”

Distribution
switcher 

“MAINROUT”

65

VT16

VT15

VT22

VT21

Figure 5–174. Example of sequential path finding connec-
tions between video levels of two switchers. For correspond-
ing tables, see Figure 5–175.

In this example, this group of tie
lines is named “VNEWMAIN” (vid-
eo, NEWSROUT to MAINROUT).
Other naming schemes could use
“GROUP1,” or,  more elaborate
names like “V5N10M43,” meaning
“Video, 5 News lines starting at
output 10 to Main router starting
at input 43,” etc.)

In this example, this group of tie
lines is named “VMAINNEW.”
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Logical Input
Name VIDEO LEFT RIGHT TC

30 VT21 023 023 023 023
31 VT22 024 024 024 024

45 VT15 VMAINNEW LMAINNEW RMAINNEW TMAINNEW
46 VT16 VMAINNEW LMAINNEW RMAINNEW TMAINNEW

Switcher Input – NEWSROUT

Switcher Input
Name VIDEO LEFT RIGHT TC

23 VT15 038 038 038 038
24 VT16 039 039 039 039

45 VT21 VNEWMAIN LNEWMAIN RNEWMAIN TNEWMAIN
46 VT22 VNEWMAIN LNEWMAIN RNEWMAIN TNEWMAIN

Switcher Input – MAINROUT

Path Finding Physical Physical
Group Name Source Switcher/Level Output Destination Switcher/Level Input Count

1 VNEWMAIN VIDEO (NEWSROUT) 10 VIDEO (MAINROUT) 43 5
2 LNEWMAIN LEFT (NEWSROUT) 10 LEFT (MAINROUT) 43 5
3 RNEWMAIN RIGHT (NEWSROUT) 10 RIGHT (MAINROUT) 43 5
4 TNEWMAIN TC (NEWSROUT) 10 TC (MAINROUT) 43 5
5 VMAINNEW VIDEO (MAINROUT) 61 NEWSROUTVIDEO 20 3
6 LMAINNEW LEFT (MAINROUT) 61 NEWSROUTLEFT 20 3
7 RMAINNEW RIGHT (MAINROUT) 61 NEWSROUTRIGHT 20 3
8 TMAINNEW TC (MAINROUT) 61 NEWSROUTTC 20 3

Sequential Path Finding

Tie lines from 
“NEWSROUT”
to 
“MAINROUT”

Tie lines from 
“MAINROUT”
to 
“NEWSROUT”

Starting
with

number

Starting
with

number

Group
names

Group
names

Figure 5–175. Sequential Path finding and Switcher inputs
tables for system shown in Figure 5–174.
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PATH FINDING FOR THREE OR MORE SWITCHERS

Connecting three switchers for path finding purposes possible, with five as the recommended maximum. This is illustrated
in Figure 5–176. Notice that no tie lines directly connect switcher “A” and switcher “C.”

In the corresponding Path Finding Data table, there would be descriptions of the tie lines from “A” to “B,” from “B” to “A,”
from “B” to “C,” and from “C” to “B.”

Note: There may be situations where wiring would allow manual selection of alternate routes. In Figure 5–176,
this would be the case if video lines also existed between switcher “A” and switcher “C. ” However, the Jupiter
path finding software cannot take advantage of such alternate routes; in other words, it does not “switch around
busy areas.” Only one possible route between each pair of switchers can be described on the Path Finding Data
table when the system is configured.

There would also be Group entries in the Switcher Input tables of all three switchers:

— For the switcher “A” table, the names of sources available through path finding would all be referenced to the
tie lines from switcher “B” to “A.” This would include the sources wired directly to switcher “C.”

— For the switcher “B” table, the names of sources available through path finding would be referenced to the tie
lines from switcher “A” to “B,” or, from “C” to “B,” as appropriate.

— For the switcher “C” table, the names of sources available through path finding would all be referenced to the
tie lines from switcher “B” to “C.” This would include the sources wired directly to switcher “A.”

In general, path finding entries are needed only for switchers that are immediately adjacent. The system will use this informa-
tion to find paths involving one or more intermediate switchers.
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Distribution 
switcher “A”

Distribution 
switcher “B”

Distribution
switcher “C”

Tie lines

Video

Figure 5–176. Example of path
finding connections between
video levels of three switchers.
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PATH FINDING BETWEEN ANALOG AND DIGITAL EQUIPMENT

Automatic Conversion of Separate Analog Signals to Combined Digital Signals

The pathfinding table can be used with customer–supplied ADCs and DACs to provide automatic conversion between analog
equipment and digital equipment (such as VTRs). See Figure 5–177.

ANALOG
EQUIPMENT

ANALOG
ROUTER

DIGITAL
ROUTER

A TO D 
CONVERTER

D TO A
CONVERTER

DIGITAL
EQUIPMENT

DIGITAL ENVIRONMENTANALOG ENVIRONMENT

L

R

L

R

Figure 5–177.

For example, this technique can be used for conversion of analog audio signals, which are carried on two levels of an analog
routing switcher, to a single digital audio (AES) signal. The same concept can be applied in an embedded audio environment,
where a single digital video stream can be split into an analog video signal and up to four analog audio signals.

It is possible to arrange a system so that the conversion will take place whenever the operator selects a particular source and
switches it to a particular destination. For example, in the system shown in Figure 5–178, whenever the operator selects VTR1
as the source for VTR2, the analog audio signals will always pass through an A to D converter; when VTR2 is the source for
VTR1, the digital signal will pass through a D to A converter.
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0 1

16
17“MAINROUT

LEFT”

A TO D
CONVERTER

D TO A
CONVERTER

18 19

26
27“MAINROUT

AES”

“VTR1”
(ANALOG)

6
7

“MAINROUT
RIGHT”

4 5

“VTR2”
(DIGITAL)

TIE LINE GROUP 1

TIE LINE GROUP 3

TIE LINE GROUP 4

TIE LINE GROUP 2

Figure 5–178. Example of automatic conver-
sion system (video connections not shown). For
corresponding table entries, see Figure 5–179.

This system will require four tie lines, with a dedicated A to D converter connected to the first pair and a dedicated D to A
converter connected to the second pair. Each pair is “locked” together, meaning that selection of one result in selection of both.

The corresponding table entries are shown in Figure 5–179.

There are three rules governing this technique:

1. The pathfinding groups to be locked together MUST have identical digital Switcher Names, digital Level Names, and
digital Physical Input/Output entries. These groups must be on consecutive rows of the table. Please refer to Groups 1
and 2, as well as Groups 3 and 4, in the Pathfinding Data table.

2. In the Switcher Description table, the “MAINROUT LEFT” level and “MAINROUT RIGHT” level must be controlled
by the same VM 3000. The “MAINROUT AES” level may be controlled by another VM 3000.

3. Any levels “sourced” by, in this case, the MAINROUT LEFT and RIGHT levels may not break away. This must be
established by unchecking the “Breakaway” box in the CP Level Set.
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Logical Input
Name LEFT RIGHT AES

30 VTR1 001 005 GROUP1
31 VTR2 GROUP4 GROUP3 019

Switcher Input – MAINROUT

Sequential Path Finding

Group
name

“Locked” tie lines
through A to D
converter

“Locked” tie lines
through D to A
converter

DM 400
Switcher Level VI RV MC Board #In #Out PLvl Follow Level Driver 3 LI 3 LO Option Audio Off Time

1 MAINROUT LEFT VM1 64 64 2 Binary Left
2 MAINROUT RIGHT VM1 64 64 6 Binary Right
3 MAINROUT AES VM1 64 64 32 Binary None

Switcher Description

Group
names

      Logical Output Pass
Name Security S–T Word LEFT RIGHT AES

1 VTR1 017 007
2 VTR2 026

Switcher Output – MAINROUT

Figure 5–179. Table entries for
system shown in Figure 5–178
(video entries not shown).

Path Finding Physical Physical
Group Name Source Switcher/Level Output Destination Switcher/Level Input Count

1 GROUP1 LEFT (MAINROUT) 16 AES (MAINROUT) 18 1
2 GROUP2 RIGHT (MAINROUT)   6 AES (MAINROUT) 18 1
3 GROUP3 AES (MAINROUT) 27 LEFT (MAINROUT)   0 1
4 GROUP4 AES (MAINROUT) 27 RIGHT (MAINROUT)   4 1
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Non–Sequential Path Finding

Figure 5–180. Non–Sequential Path Finding data table (example).

1

Non–Sequential Path Finding

Path Finding

GROUP1

Line

3

Physical

83

Physical

87

2 GROUP1 4 84 88

3 GROUP2 3 83 87

4 GROUP2 4 84 88

5 GROUP3 3 83 87

6 GROUP3 4 84 88

7 GROUP4 3 83 87

8 GROUP4 4 84 88

9 GROUP5 2 82 20

10 GROUP6 2 82 20

11 GROUP7 2 82 20

12 GROUP8 2 82 20

Number Output InputGroup Name

Password 5–17

Network Description 5–22
Serial Protocol 5–25

Switcher Description 5–31
Switcher Input 5–44
Switcher Output 5–51

Control Panel Sets
Level set 5–55
Input set 5–58
Output set 5–76
Override set 5–98
Sequence set 5–101
Category set 5–103

MPK Devices 5–108

Machines 5–141
Protocol Dependent 5–144
Machine Control 5–148
Delegation Groups 5–161

TCS–1 Device Codes 5–168
Party Line 5–169

Status Display Header 5–172
VGA Status Display 5–173

Tally 5–174

Path Finding

Exclusion 5–210
Y Line 5–211

The path finding software option has already been described in detail, starting on page 5–196.

The Non–Sequential Path Finding table must be used if the tie lines joining the switchers are not wired sequentially, i.e., not
wired as blocks. Basically, the table is designed to enter “exceptions” to the Sequential table. For example, a new tie line that
falls outside the original sequence can be defined on the Non–sequential table; the only change then needed on the Sequential
table would be to increment the “Count” number for the group by 1. (Alternatively, you may prefer to use the Non–sequential
table to define all tie lines individually.)

An example system is shown on page 5–208, with corresponding tables shown on page 5–209. Notice that the Path Finding Data
table, and the Switcher Input tables, must still be used as described in the previous section.
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Note: Line
numbers start

at zero!

20 26 27

83

84

888745 46

61

62

Distribution
switcher

“NEWSROUT”

Distribution switcher 
“MAINROUT”

13

14

15

44

82

33 34

VT22

VT21

1 2

VT16

VT15

GROUP1
Non–sequential

tie lines

GROUP1
Sequential tie

lines
Line 0

Line 1

Line 2

Line 3

Line 4

GROUP5
tie lines

Note: Line
numbers start

at zero!

Figure 5–181. Example of non–sequen-
tial path finding connections between
video levels of two switchers. For corre-
sponding tables, see Figure 5–182.
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Sequential Path Finding

Tie lines from
“NewsRout” to
“MAINROUT”

Tie lines from
“MainRout” to
“NEWSROUT”

See note 1

Path Finding Line Physical Physical
Group Name Number Output Input

Non–Sequential Pathfinding

1 GROUP1 3 83 87
2 GROUP1 4 84 88
3 GROUP2 3 83 87
4 GROUP2 4 84 88
5 GROUP3 3 83 87
6 GROUP3 4 84 88
7 GROUP4 3 83 87
8 GROUP4 4 84 88
9 GROUP5 2 82 20
10 GROUP6 2 82 20
11 GROUP7 2 82 20
11 GROUP8 2 82 20

Note 1: You may wish to define each and every tie line on the Non–sequential table; however, it will
still be necessary to enter some number in the Physical Output and Physical Input columns to satisfy
the compiler.

GROUP1
Non–sequential

tie lines

Logical Input
Name VIDEO LEFT RIGHT TC

30 VT21 033 033 033 033
31 VT22 034 034 034 034

45 VT15 GROUP5 GROUP6 GROUP7 GROUP8
46 VT16 GROUP5 GROUP6 GROUP7 GROUP8

Switcher Input – NewsRout

Logical Input
Name VIDEO LEFT RIGHT TC

23 VT15 001 001 001 001
24 VT16 002 002 002 002

45 VT21 GROUP1 GROUP2 GROUP3 GROUP4
46 VT22 GROUP1 GROUP2 GROUP3 GROUP4

Switcher Input – MainRout

Group
nAME

See note 1

See note 2

Note 2: in this example, the same input/output numbers are used for
the tie lines on each level; however, different inputs/outputs can be
used, and entered on this table, if desired.

Path Finding Physical Physical
Group Name Source Switcher/Level Output Destination Switcher/Level Input Count

1 GROUP1 VIDEO (NEWSROUT) 13 VIDEO (MAINROUT) 44 5
2 GROUP2 LEFT (NEWSROUT) 13 LEFT (MAINROUT) 44 5
3 GROUP3 RIGHT (NEWSROUT) 13 VIDEO (MAINROUT) 44 5
4 GROUP4 TC (NEWSROUT) 13 TC (MAINROUT) 44 5
5 GROUP5 VIDEO (MAINROUT) 61 VIDEO (NEWSROUT) 26 3
6 GROUP6 LEFT (MAINROUT) 61 LEFT (NEWSROUT) 26 3
7 GROUP7 RIGHT (MAINROUT) 61 RIGHT (NEWSROUT) 26 3
6 GROUP8 TC (MAINROUT) 61 TC (NEWSROUT) 26 3

Figure 5–182. Path Finding and Switcher Inputs tables for system shown in Figure 5–181.
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Exclusion

Figure 5–183.  Exclusion data table (example).

1

Exclusion

Logical Input

MULTBRST

Logical Output

XMIT

2 SINESQ XMIT

Password 5–17

Network Description 5–22
Serial Protocol 5–25

Switcher Description 5–31
Switcher Input 5–44
Switcher Output 5–51

Control Panel Sets
Level set 5–55
Input set 5–58
Output set 5–76
Override set 5–98
Sequence set 5–101
Category set 5–103

MPK Devices 5–108

Machines 5–141
Protocol Dependent 5–144
Machine Control 5–148
Delegation Groups 5–161

TCS–1 Device Codes 5–168
Party Line 5–169

Status Display Header 5–172
VGA Status Display 5–173

Tally 5–174

Path Finding 5–196

Exclusion 
Y Line 5–211

This table can be used to prevent a particular input from being switched to a given output.

Note: No exclusions are allowed on data levels.
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Y Line Table (DM 400/400A)

Figure 5–184. Y Line table (example).

1

Y Line Table

Level

REV (DATA)

2

FOR (DATA)

Input

VR2–S

Output

VR2–M

VR2–M VR2–S3

REV (DATA)

4

FOR (DATA)

VR1–S VR1–M

VR1–M VR1–S

Logical Logical

Password 5–17

Network Description 5–22
Serial Protocol 5–25

Switcher Description 5–31
Switcher Input 5–44
Switcher Output 5–51

Control Panel Sets
Level set 5–55
Input set 5–58
Output set 5–76
Override set 5–98
Sequence set 5–101
Category set 5–103

MPK Devices 5–108

Machines 5–141
Protocol Dependent 5–144
Machine Control 5–148
Delegation Groups 5–161

TCS–1 Device Codes 5–168
Party Line 5–169

Status Display Header 5–172
VGA Status Display 5–173

Tally 5–174

Path Finding 5–196

Exclusion 5–210
Y Line

The Y Line table is used only with Venus data routers equipped with DM 400 or DM 400A Data Matrix boards in applications
where a VTR can be used as a controller (master) on some occasions and as a tributary (slave) on others.

Note: This table is not used with newer model Venus systems equipped with the DM 400B Data Matrix boards;
these boards have software–configurable rear–panel pinout functions and do not require Y–line cables.

Configuration of this table is described at the conclusion of Appendix L, “Special configuration requirements: Venus DM
400/400A data matrix switching.”
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Time Standard table

Video Reference Table

These tables are used only for configuration of the CM 4000 System Controller operating with the AccuSwitch application.
For more information, see the CM 4000 Installation and Operating Manual.


